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Welcome to the Lucity Administration Tool 2017.  This program enables administrators to: 

 set up Views of the agency's Lucity data; 

 design Forms for users and citizens to use to submit information; 

 configure several Lucity mapping applications; and  

 establish other settings for Lucity Desktop and Web. 

  

  

*File may be large 

WELCOME 
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Past Helpguide Versions 

 Version 2016r2 (see Lucity Admin - http://help.lucity.com/webhelp/v165/admin) 

 Version 2016 (see Lucity Admin - http://help.lucity.com/webhelp/v160/admin) 

 Version 2015r2 (see Lucity Admin - http://help.lucity.com/webhelp/v155/admin) 

 Version 2015 (see Lucity Admin - http://help.lucity.com/webhelp/v150/admin) 

 Version 2014r2 (see Lucity Admin - http://help.lucity.com/webhelp/v145/admin) 

 Version 2014 (http://help.lucity.com/webhelp/v140/admin/) 

 Version 7.60 (see Lucity Admin - http://help.lucity.com/webhelp/v760/admin) 

 Version 7.50 (see Lucity Admin - http://help.lucity.com/webhelp/v750/admin) 

 Version 7.40 (http://help.lucity.com/webhelp/v740/admin) 

  

  

 

 Help File Version 2017 
 

LOGIN 

1) Launch Lucity Administration for Web Apps . 

o This can be found under Start Menu > All Programs > Lucity. 

o C:\Program Files\Lucity\bin. 

2) Select an authentication method from the drop-down menu. 

o Application Authentication requires a user name and password. 

o Windows Authentication disables the User and Password fields and allows users to bypass the 
Login screen.  See the Users topics for information on setting up Windows authentication. 

3) If using application authentication, enter your Lucity User Name and Password to log into the 
interface.  These credentials are established in the Lucity.Security.exe program. 

http://help.lucity.com/webhelp/v165/admin
http://help.lucity.com/webhelp/v160/admin
http://help.lucity.com/webhelp/v155/admin
http://help.lucity.com/webhelp/v150/admin
http://help.lucity.com/webhelp/v145/admin
http://help.lucity.com/webhelp/v140/admin/
http://help.lucity.com/webhelp/v760/admin
http://help.lucity.com/webhelp/v750/admin
http://help.lucity.com/webhelp/v740/admin
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4) Click Login or press <Enter>. 

 

 

 
 

OTHER LUCITY ADMINISTRATION TOOLS 

The Lucity Administration Tool serves as the primary resource for controlling an agency's setup and 
options for Lucity Web and Desktop.  However, other Lucity tools can also be helpful to an 
administrator.  These tools are outlined below. 

Note: The Administration Tool is automatically installed on every machine.  Not all of the other 
tools are installed automatically. 

 

Client Maintenance 

Configures the Lucity Server, updates license files, maintains connections to the database, and performs 
database updates and linking.  Client Maintenance is automatically run during the Lucity Server 
upgrade.  Otherwise, it is usually only run when there are problems with Lucity connecting to the 
databases, when the databases are moved or restored from a backup, or when a new Licenses file is 
applied. 

o Requirements - Installation of Lucity Desktop. 

o File Location - In the Lucity Desktop installation, in the bin folder. 

o Shortcut Location - Windows Start Menu > All Programs > Lucity > Admin Tools > Client 
Maintenance 

Lucity Security 

Allows administrators to add or remove users from the Lucity system and to control users' permissions 
within the program. 

o Requirements - Installation of Lucity Desktop. 

o File Location - In the Lucity Desktop installation, in the bin folder. 

o Shortcut Location - Windows Start Menu > All Programs > Lucity > Admin Tools > Lucity 
Security 
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Data Quality Tool 

Allows administrators to run preconfigured SQL queries to verify data quality. 

o Requirements - Installation of Lucity Desktop. 

o File Location - In the Lucity Desktop installation, in the bin folder. 

Street Renaming Tool 

Allows administrators to bulk update street names throughout the Lucity System 

o Requirements - Installed with the Lucity Administration Tool 

o File Location - In the Lucity Desktop installation, in the bin folder. 

Lucity DSN Utility 

Maintains the desktop computer's connection to the Lucity Server and databases.  The utility updates 
the path to the Lucity Server Config folder and updates the DSNs based on that folder.  This enables an 
administrator to point Lucity Desktop to a different instance of Lucity Server when the server location has 
changed, the database location has changed, or a new product/database has been added to Lucity.  
Administrators can run the utility manually, or silently, using a script or command line. 

o Requirements - Installation of Lucity Desktop. 

o File Location - In the Lucity Desktop installation, in the bin folder. 

o Shortcut Location - Windows Start Menu > All Programs > Lucity > Utilities > Lucity DSN Utility. 
 

TYPES OF LICENSING 

Lucity provides a variety licensing options to accommodate client needs.  The most common options 
are explained below. 

Named-Product Licensing 

Under a Named-Product Licensing Agreement, users purchase a number of licenses (or "seats") for each 
part of the Lucity suite.  A license is considered to be in use when a user has a related module open; 
that license is released when the user closes the module.   

For example, an agency owns 10 seats of the Lucity Assets program and 20 seats of the Lucity Work 
program.  If a user has the Water Hydrant module open, the Water Pipe module open, and the 
Work Order module open, he is using just 1 seat of Assets (both Water modules fall within one Asset 
program) and 1 seat of Work.   

In this situation, although the agency might have 100 users, only 10 of them could use an Asset 
module at the same time. 
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Agencies purchase Named-Product licenses for on-premise use and can use them as long as they'd like. 
Software support is not tied to the license purchase; instead, the agency pays for it separately. 

On-Premise Use 

The agency hosts all of the system resources required to run Lucity. 

 Support - Purchased separately. 

 IT Maintenance - Not included. 

 Services - Purchased separately. 
 

 

Named-User Licensing  

Under a Named-User Licensing Agreement, agencies purchase the Lucity modules they want and a 
specific number of user licenses they want for the Lucity System.  Each license is registered to a 
particular, individual user and is considered to be always in use.  That is, if an agency has 20 user 
licenses, only 20 registered users can log into Lucity.  If other users try to log in, they will be denied 
access because they do not have a license.   

There are no restrictions on the number of users that can get into a given Lucity module; however, only 
those authorized (through a license) have the ability to access the Lucity system. 

 
Implementation Options and License Expiration 

Clients purchase named-user license/support packages annually for either on-premise use or 
software-as-a-service (SaaS) implementation.  At the end of one year, the license agreement expires, 
and the software cannot be used until the licensing agreement is renewed. 

Forty days before the license expires, Lucity begins to send daily renewal reminders via email to the 
agency's system administrator.  (Administrators can designate who should receive the email and when 
notification should begin in Lucity Web > Admin Portal > Settings > System Settings > General.) 

On-Premise Use 

The agency hosts all of the system resources required to run Lucity. 

 Support - Included. 

 IT Maintenance - Not included. 

 Services - Purchased separately. 

SaaS Implementation 

Lucity hosts the software, and the client accesses the software over the internet. 

 Support - Included. 
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 IT Maintenance - Included (only for the Lucity system). 

 Services - Purchased separately. 

 

THE ADMINISTRATION TOOL 
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This section discusses all of the screens, tools, and options available in the Administration Tool.  To 
learn how to perform any of the Administration Tool functions, click on the links below. 
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SYSTEM 

The System menu option enables administrators to: 

 set system settings,  

 manage web and public web site caches,  

 lock objects,  

 manage user licenses,  

 manage active users, or  

 exit the program.   

Note: Changes made here to the system settings are applied to all users.  Follow the links below 
for additional information.  
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SYSTEM SETTINGS 

The System Settings section allows administrators to control general system settings that affect Lucity 
Web, Citizen Portal, email services, GIS tools, etc. 

 

  

Settings Selection Enables users to change the list of settings displayed in the Settings grid using the drop-down list in the top 
left-corner. 

Settings Grid Displays a list of settings and their current state. 

Edit Enables an administrator to edit the setting selected in the grid. 

  

 

 



 

 

APPEARANCE 

The Appearance settings control the default colors of the Lucity Web dashboard; that is, the colors that users normally see when they log in to 
the application.  These colors are set by an administrator within the User Settings.  In that same location, each user can also customize the 
colors of his or her individual dashboard. 

 





 

 

CITIZEN 

Lucity's Citizen settings are used to configure the Citizen Portal application.  This application provides a citizen facing form for entering 
Requests. 

FIELD FUNCTION  
PERMISSIONS 
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Add new addresses from Citizen 
Web App to Customers if the 
Work Option "Update Customers 
from Requests?" is Yes 

Adds new addresses entered through the Citizen Portal into the Customer module if the Update 
Customer from Request option is enabled in the Work module. 

Se
ar
ch 
fo
r 
C
us
to
m
er
s 
by 
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h
o
ne 
N
u
m
be
r? 
 

Searches 
the 
Customer 
module 
for 
Contact 
and 
Address 
data 
associate
d with the 
phone 
number 
the user 
entered.  
The 
informati
on 
produced 
by the 
search is 
used to 
complete 
fields on 
the Work 
Order 
Request 
module's 
Customer 
tab.  
This 
feature 
helps 
speed 
data 
entry.   

If this 
function 
is 
disabled: 

 The 
Requ
est 
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Allow advanced searches on 
Citizen Website 

Enables citizens to search for existing requests on the Request List page by email address, phone 
number, or Request Number. 

App Admin 

Citizen Checkbox label for 
copying requesters address 

Specifies the caption to be displayed next to the Use Requester's Address checkbox on Request forms. App Admin 

Citizen Checkbox label for 
remembering requesters 
information 

Specifies the caption to be displayed next to the Remember Me checkbox on Request forms. App Admin 

Citizen Email - Include link to 
request lookup 

Provides a link to the TEXT version of the email that is sent to requesters after they enter a Request in 
Citizen Portal. 

App Admin 

Citizen Request Lookup Page Indicates the filename of the page that displays information about a specific request to the citizen who 
submitted that request.   
 
The default value, RequestLookup.aspx, includes comments.  Use the alternative value, 
RequestLookupNoComments.aspx, to exclude comments from the page. 

App Admin 

Citizen Thank You page - Caption 
of button 

Specifies the caption to be displayed on the button on the Thank You page.  The default value is "Add 
Another." 

App Admin 

Citizen Thank You Page - Caption 
of Send Copy Email Label 

Specifies the language to be used on the Thank You page to enable a user to request an email copy of 
their Citizen Portal request. 

App Admin 

Citizen Thank You page - URL 
button redirects to 

Controls the behavior of the button on the Thank You page.  This setting accepts three types of 
values: 

 If left empty, clicking the button will return the citizen to the Request Submittal page. 

 If a URL is provided (such as http://www.yoursite.com/), clicking the button will take the citizen to 
that web page. 

 If the word "CLOSE" is entered, clicking the button will close the browser window.* 

App Admin 

Error to display if a file upload 
fails in the Citizen app 

Indicates the error message displayed when a document fails to upload. App Admin 
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Instruction label for additional 
emails 

Controls the text that appears in the Additional Emails section of the Citizen Portal form. App Admin 

Login ID used for Citizen Website Indicates the Lucity Login ID for the Citizen Portal site.  This Login ID is created during the installation 
process.  The default ID is "PublicWebUser". 

The chosen citizen Login ID must belong to the PublicWebGroup in Lucity Security.  This group has 
the following permissions to use the public forms: Run - Work, Run - Work Requests, General Add - 
Work Requests, and Run - General Modules.   

App Admin 

Request Feedback Question What question to pose for users in the request feedback survey that is sent when a request is 
completed. 

App Admin 

Request Feedback Responses Multiple choice answers for the Request Feedback Question question. App Admin 

Show Customer Lookup and 
Request Lookup buttons on 
Request forms 

Controls whether the Customer and Request Lookup buttons appear on Request forms. App Admin 

*If using the "CLOSE" option, citizens will likely receive a browser message stating, "The user is attempting to close the browser, do you want to 
let them continue?" Therefore, if the setting is set to "CLOSE," Lucity recommends an agency also use a bit of JavaScript to open the Citizen 
Request form in a separate window.  For example, to open the submittal form, the URL might be: 

<a href="http://localhost:2296/Default.aspx?FUI=CleanGraffiti" target="_blank" 
onclick="window.open('http://localhost:2296/Default.aspx?FUI=CleanGraffiti','_blank','left=0,top=0,resizable=yes,scrollbars=yes,toolbar=no,
menubar=no,location=no,directories=no, status=yes'); return false;">Click here to submit a graffiti cleaning request.</a> 

If the window.open JavaScript is used and the system setting is set to "CLOSE," the Request Submittal window closes and returns the user 
back to your site. 

Note:  In addition to customizing the text of the Citizen Request email, administrators can also customize the format of the Citizen Request 
email (see "Customizing the Citizen Request Email" on page 495). 

 



 

 

CRYSTAL ENTERPRISE 

Enables admins to configure using Crystal Reports Enterprise to run Crystal Reports for Lucity Web 

FIELD FUNCTION  
PERMISSIONS 

Admin Port Port used for Administrative and API access to Crystal Enterprise. IT Admin 

Display Port Port used to Display reports using the Open Document Method. IT Admin 

Display Server DNS or Server name used for displaying reports using the Open Document Method. IT Admin 

Failure - Failover notifications Switch to determine if an email notification should be sent if a report fails to run when configured as 
an enterprise report. 

 

How reports are selected to run 
in Enterprise 

Option can be set to Auto,Manual, or Empty. Setting is used to determine if Lucity reports are 
manually configured for Crystal Enterprise or done automatically. Manual mode allows users to control 
each reports run from location, while the Auto mode assumes reports to be run from Enterprise 
regardless of the setting on the report. 

IT Admin 

Is Crystal Reports Enterprise 
Integration Running 

Switch determines if installation is using Crystal Enterprise. Can be turned off and system uses native 
Lucity Reports. 

IT Admin 

Logon Port Port for Login/Authentication on Crystal Enterprise. IT Admin 

Open Document Path URL path defined by Crystal Enterprise to Open a document which can change between versions of 
Business Intelligence. Value is case sensitive. 

IT Admin 

Report Folder ID Report Folder ID found in Crystal Enterprise that holds Lucity Reports for this client. IT Admin 

Server Option contains the name of the server hosting Crystal Enterprise. Used for logging into Crystal 
Enterprise CMC. 

IT Admin 

Server is TLS Crystal Enterprise Server configuration set to use TLS (Secure - https). IT Admin 

Use Guest Account Switch determines if installation allows use of the Guest Account found on Crystal Enterprise. If false, 
Active Directory needs to be implemented on the Crystal Report Server, or users will be forced to login 
to see reports. The Guest account is also used to do dynamic lookups for CUID (Report IDs) in Business 
Intelligence when the CUID is NOT specified in Lucity. 

IT Admin 
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DESIGNER AUTOMATION 

The Designer Automation settings let administrators change the default appearance of specific web form components.  They can change the 
width, height and margins of forms.  (All measurements are in pixels.) 

 All settings on this tab require the App Admin permission. 

 





 

 

DOCUMENTS 

The Documents settings are used to control how the document-upload feature works within Lucity Web, Mobile, and Citizen Portal. 

FIELD FUNCTION  
PERMISSIONS 

Always Delete file when 
document references are deleted 
if no other items reference file * 

This setting controls whether deleting a document from Lucity automatically removes the underlying 
file from the file share.  This will happen regardless of whether the user has permission via Active 
Directory file permissions.  Users without the Documents - Delete File permission will still be asked if 
they want to delete the file but the file will not be deleted. 

IT Admin 

Documents with file size greater 
than given size, are opened 
using file path.   

Default size is 500MB 

Limits the size of documents pushed to the client using the Lucity document server.  If a document is 
larger than the specified maximum, the system instead provides the path to the file, which the user 
can copy/paste into Windows Explorer.  Limiting file size reduces the load on the server. 

IT Admin 

Enable External Document 
Integration 

Integrates Lucity with external documentation programs.  When this setting is enabled, a new button 
appears on every grid in Lucity Web.  The button can be configured to link to an external document 
system. 

App Admin 

List of document types that are 
allowed to be added to records 

(whitelist) ** 

Specifies the file types that users may attach to records in the Lucity Web or Mobile programs.  Enter 
a comma-delimited list of file extensions. 

App Admin 

List of document types that are 
allowed to be uploaded by 
citizens * 

Specifies the file types that users may attach to records in the Citizen Portal program.  Enter a 
comma-delimited list of file extensions. 

App Admin 

List of document types that are 
not allowed to be added to 

records (blacklist) ** 

Indicates which file types users should not be allowed to attach to records in the Lucity Web or Mobile 
programs.  Enter a comma-delimited list of file extensions. 

Note: To allow users to upload videos, do not include mp4 in this list. 

Default List: exe, com, dll, ocx, bat, reg, tmp, dat, scr, bak, acl, acm, cpl, ax, php, ps1, cmd, inf, inx, isu, 

job, lnk, msp, pif, sct, vbs 

App Admin 

Maximum size for uploaded 
document in mb (Citizen) * 

Limits the size of documents that can be attached to a Citizen Portal request. 

 Requires a restart of the affected applications to take effect. 

IT Admin 
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Maximum size for uploaded 

document in mb (Internal) ** 

Limits the size of documents that can be attached to a record in Lucity Web or when using the REST 
API. 

 Requires a restart of the affected applications to take effect. 

IT Admin 

Path where uploaded documents 
are stored (Citizen)(Citizen 
Document Hive) * 

Establishes a network path for the location in which the uploaded documents from Citizen Portal will 
be stored. 

IT Admin 

Path where uploaded documents 
are stored (Internal)(Document 

Hive) ** 

Establishes a network path  for the location in which the uploaded documents from Lucity Web and 
Mobile will be stored. 

IT Admin 

Path where uploaded Sign 

Library images are stored ** 

Establishes a network path for the location in which the uploaded pictures for the Sign Library are 
stored. 

IT Admin 

URL to Document Server *** Designates the URL for the Lucity Document Server application, which is installed with the Lucity Web 
and Citizen Portal programs. 

IT Admin 

* Applies to Lucity Web. 

* Applies to Lucity REST API, Lucity Mobile Server. 

* Applies to Citizen Portal. 

 



 

 

EMAIL 

The Email settings are used to configure the content, recipients and behavior of automatic messages generated by the Lucity system. 

FIELD FUNCTION  
PERMISSIONS 

Button text for send email button 
* 

Controls the text that appears on the Send Email button on the Citizen Portal form. App Admin 

Footer line in email **** Controls the footer that is included on all emails sent by the system. App Admin 

From Email Address Sets the default email address that is listed as the sender on most email notifications. App Admin 

Header line in email **** Controls the header that is included on all emails sent by the system. App Admin 

Include a hyperlink to the web 
application in emails sent from 
the desktop software * 

Adds a hyperlink back to the related Lucity Web Work Order/Request to any email notifications 
generated by Lucity Desktop. 

App Admin 

Include Client name on the 
subject of every email 

Adds the name of the Lucity client to the subject line of every email except those generated by the 
Citizen Portal.  This feature enables administrators to easily determine whether a message originates 
from a test or production system. 

App Admin 

List of email addresses for 
system health notifications 

Controls which email addresses receive various system-health emails, including: 

 daily messages that indicate whether the nightly processes succeeded; 

 the weekly email that identifies documents on the document server that are not attached to a 
Lucity record; 

 alerts indicating that admin permissions (Lucity App Admin, Lucity IT Admin, or Security Admin) 
have been granted, revoked, or denied; and 

 alerts indicating that parts reconciliations errors exist (which should be reported to Lucity 
Support). 

Enter a comma-delimited list of email addresses.  

IT Admin 

Reprocess Email Timeout 

Default 10 min 

Time in minutes to reset emails pending emails to be processed again.  This helps to capture and 
send emails that failed to send due to the services failing. 

IT Admin 
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Request Generator allows replies 
to response email * 

Controls whether requesters can respond to the automatic message they receive in reply to their 
original Request.   

If this option is enabled, the responses are added to the original Request.  If this option is disabled, 
responses generate new Requests. 

App Admin 

Request Generator reply email 
body * 

Establishes the body of the email that is automatically sent to requesters when they update a Request 
by replying to the original email. 

App Admin 

Request Generator reply email 
subject * 

Controls the subject of the email automatically sent to requesters when they update a Request by 
replying to the original email. 

App Admin 

Request Generator reply to be 
sent when Request not found * 

Outlines the automatic response sent to customers who send an email in reference to a Request that 
doesn't exist. 

App Admin 

Request Generator response 
email subject * 

Controls the subject of the email that is automatically sent to requesters when they send an email that 
generates a new Request. 

App Admin 

Request Generator response 
email text * 

Establishes the body of the email automatically sent to requesters when they send an email that 
generates a new Request. 

App Admin 

Send daily email when nightly 
services processes finish 

Sends an email when the nightly processes complete to all users identified in the List of email 
addresses for system health notifications setting.  If these users do not receive an email, the 
processes most likely failed. 

App Admin 

SMTP Server *** Identifies the agency's SMTP server.  Use this field to configure the SMTP server if you are connecting 
through Port 25.  If you are not connecting through that port, use the email configuration that is 
installed with the services (http://help.lucity.com/webhelp/v170/services/#33988.htm). 

IT Admin 

Text to include above the 
hyperlink in the email * 

Specifies the text that should appear in the line above the hyperlink. (Tied to the "Include a 
hyperlink...." option.) 

App Admin 

The first line of the body of the 
email sent to citizens * 

Adds a line of text to the beginning of all automated client emails. App Admin 

The last line of the body of the 
email sent to citizens * 

Adds a line of text to the end of all automated client emails. App Admin 

* Applies to Lucity Desktop and Web. 

http://help.lucity.com/webhelp/v170/services/#33988.htm
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* Applies to Lucity REST API, Lucity Mobile Server. 

* Applies to Citizen Portal. 

* Applies to the Email to Request Generator. 

Note: Changes made to Lucity's email settings do not require a server restart. 

 





 

 

GENERAL 

The General settings provide controls regarding data storage, default file locations and basic Lucity services.  

FIELD FUNCTION  
PERMISSIONS 

Allow All Users Access to All 
Views 

Removes the requirement that users be in a group assigned to a view in order to access the view.  
This gives all users access to all views in any module they have security permission to. 

App Admin 

Comma delimited list of user 
names that should not be 
tracked in AuditLogons Table 

Enter Lucity usernames here to bypass tracking the successful logon of those users in the AuditLogons 
table. 

 Intended for applications developed by clients, particularly REST applications, that may log in 
frequently (several times per second). 

IT Admin 

Date format for Notifications 

Default: Short 

Indicates which date format should be used when creating web notifications. 

Example 

 Short = 01/01/2015 

 Long = Monday, January 1st, 2015 

App Admin 

Days to keep data in login 
auditing table (0 to maintain all 
history) 

Indicates the number of days of login history for the Desktop or Web application that the system 
should retain in the AUDITLOGONS table in the User database. 

IT Admin 

Days to keep data in the event 
track table (0 to maintain all 
history) 

Controls how many days records are stored in the Event Track table.  The Event Track table is used in 
third-party integrations to determine when records have been edited in specific Work modules. 

App Admin 

ELA email to send expiration 
warning emails 

Specifies the email address that should receive warning emails when an ELA license is about to expire. App Admin 

ELA number of days before 
expiration when warnings begin 

Indicates the number of days before an ELA license expires that the system should start sending out 
warning emails. 

App Admin 

Enable Lucity Spatial When enabled, tells the Lucity Spatial Updater Service (part of the Lucity Services) to update the Work 
Order and Request tables with spatial information. 

App Admin 
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Flags to Alter Application 
Behavior for Rare Cases.  Lucity 
Support will let you know if any 
may apply for your installation 

Custom flags which direct Lucity code to apply a special behavior. Do not change the value in this 
setting except under direction from Lucity support or implementation. 

IT Admin 

How Many Days of Records 
Should be Kept in Audit Log 

Default: 365 

Controls how many days of records are left in the audit log. The audit log contains events such as 
record deletes, feature splits and merges, and other limited functions. 

App Admin 

Inactive User Licenses Expiration 
in Minutes (recommended 
value=60) 

The Web application limits the number of active users to the number of product licenses.  This setting 
releases a user's licenses if the product has been idle for the time indicated.  60 minutes is the 
recommended time frame. 

IT Admin 

Location of the Lucity Help files 
for this system 

Identifies the URL where the Lucity help files are stored. 

This option defaults to the Lucity help site but can be modified by agencies that cannot give users 
access to the Internet.  These agencies can request a copy of the Lucity Web help files and host them 
over their local network.  An administrator must then enter the location of the root folder storing the 
help files so that all of the help links continue to work. 

IT Admin 

Max amount of days to process 
spatial history 

Tells the Lucity Spatial Updater Service how many days back from the current date that it should check 
for Work Orders and Requests that need spatial information. 

Note: The service can only update data back to Lucity version 7.40. 

App Admin 

Maximum number of records 
which may be updated using 
global edit using the Business 
Rules option 

The most records during a global update query that can be updated at 1 time using the Business Rules 
option.  If a child record is being updated the parent record is counted against this maximum. 

App Admin 

Maximum number of records 
which may be updated using 
global edit using the Direct SQL 
option 

The most records during a global update query that can be updated at 1 time using the Direct SQL 
option.  If a child record is being updated the parent record is counted against this maximum. 

App Admin 
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Send an email to the system 
health email if a global update 
exceeds this row count 

If a user executes a global update and the update affects more than the number of rows specified, an 
email will be sent to the system health email address(es). 

App Admin 

Send Data Statistics to Lucity Allows the Lucity system to automatically send monthly data statistics to Lucity.  This provides us 
with information about how the software is being used.  The statistics are sent on the first of each 
month. 

IT Admin 

Send weekly emails of orphaned 
documents and report files 

Sends an email once a week to the users listed in the List of email addresses for system health 
notifications setting on the Email tab (see "Email" on page 25). 

App Admin 

Should detailed audit logging 
write to the audit log table 

Should Lucity log events such as global updates, or record deletions that have been performed by a 
user to the AuditLog table? This table is not automatically truncated or cleaned up because most if not 
all of the data in this table is not truncated or cleaned up automatically. While this logging is not 
excessive, it can cause a large table which may need to be periodically managed. 

App Admin 

System of Measure for 
calculations (Metric or U.S.) 

Specifies the measurement system to be used for several street pavement calculations like Area. The 
U.S. system will convert feet to Square Yards. The Metric system will convert meters to Square Meters. 

App Admin 

 

 

 





 

 

GIS 3RD PARTY INTEGRATIONS 

The GIS 3rd Party Integrations settings allow agencies to replace the default Lucity Web Map with their own web map.   

Note: This option is available only in the Lucity Web application.  It does not change any of the settings for the Desktop application. 

 

FIELD FUNCTION  
PERMISSIONS 

Alternate URL for Show in Web 
Map for Asset List 

Designates the URL of the alternate web map product.  (Details below.) App Admin 

Use 3rd Party GIS Web Map Tells the program to use a product other than the Lucity Web Map.  Note: This option must be set to 

TRUE to use a different map. 

App Admin 

URL Details 

The system performs a search-and-replace on the URL to replace the following variables: 

o %%SHOWINMAPACTION%% 

o %%SHOWINMAPPARAMS%% 

The following are examples of how the URL might appear: 

o http://server/page?Action=%%SHOWINMAPACTION%%&Parameters=%%SHOWINMAPPARAMS%% 

o http://myserver/mapstuff.mvc/%%SHOWINMAPACTION%%/%%SHOWINMAPPARAMS%% 
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SHOWINMAPACTION SHOWINMAPPARAMS 

ShowInMapAssetList JSON (JavaScript Object Notation) list of asset inventory types and asset IDs: 

[{catinv:2,id:123},{catinv:6,id:456}] 

ShowInMapLocation JSON (JavaScript Object Notation) list of addresses and x/y coordinates: 

[{building:"500",street1:"Main street",street2:"",zip:",x:null,y:null}] 

ShowInMapModuleList JSON (JavaScript Object Notation) list of module IDs and record IDs (not asset IDs): 

[{moduleid:48,id:789}] 

 

 



 

 

GIS DESKTOP 

The GIS Desktop settings enable administrators to set options for Lucity's Sewer, Storm, Street, and Water editing tools in ArcMap.  

Note:  ArcMap must be restarted after making changes to these settings. 

 

FIELD FUNCTION  
PERMISSIONS 

Add sewer service address to 
customer address module 

Set this option to true to have the Sewer Service Address added to the Customer Address module. App Admin 

Add street name records to the 
Street Name List that don't exist 

Set this option to true to have the Street Name Records that do not exist added to the Street Name 
List. 

App Admin 

Add water service address to 
customer address module 

Set this option to true to have the Water Service Address added to the Customer Address module. App Admin 

Automatically insert a sewer 
structure for each new sewer 
pump station 

Set this option to true to have a Sewer Structure added for each new Sewer Pump Station. App Admin 

Automatically insert a storm 
structure for each new storm 
detention basin 

Set this option to true to have a Storm Structure added for each new Storm Detention Basin. App Admin 

Automatically insert storm 
structure for each new storm 
pump station 

Set this option to true to have a new Storm Structure added for each new Storm Pump Station. App Admin 

Default location for map exports Enter a network path for the location to which map images should be saved when creating a new Work 
Order, Request, etc., with attached map. 

IT Admin 

Format for map exports Select one file type to be used for the map exports and indicate the extension (PDF, EPS, AI, BMP, TIFF, 
SVG, PNG, GIF, EMF, or JPEG). 

App Admin 

Log Lucity edit session to 
GBAComm.GBAELOG 

Set this option to true to save edit session logs to GBAComm,GBAELOG. App Admin 
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Number of days to keep items in 
GBAComm.GBAELOG 

Indicate the amount of time log entries should remain in the log. App Admin 

 

 



 

 

GIS EDIT INTEGRATION 

The GIS Edit Integration settings enable administrators to control various GIS options.  To make changes to a setting, click in its Value field and 
begin typing.  Click Save when finished. 

OPTION FUNCTION  
PERMISSIONS 

GIS/Lucity Edit Integration - 
Allow unversioned geodatabase 
edits to enterprise geodatabase: 

Allows edits to be made to unversioned geodatabases.  App Admin 

GIS/Lucity Edit Integration - 
Disable all updates to the 
geodatabase from Lucity 

Prevents edits made in Lucity Desktop and Web from being saved to the geodatabase.  IT Admin 

GIS/Lucity Edit Integration - 
Make fields shared with the 
geodatabase always read only 

Makes any field shared with the geodatabase read-only in Lucity Desktop and Web. App Admin 

GIS/Lucity Edit Integration - 
Make Lucity fields integrated 
with the geodatabase read only 
if the geodatabase cannot be 
updated 

Changes any field integrated with the geodatabase to read-only if the connection to the geodatabase 
fails when a form is loaded. 

App Admin 

GIS/Lucity Edit Integration- 
Prevent saving Lucity record if 

GIS update fails *  

Prevents the system from saving edits to Lucity records when the geodatabase update fails. App Admin 

List of emails for notifications 
regarding failures to update the 
GIS database 

Designates which Email addresses should receive emails when the Lucity Data Update SOE fails to 
update the geodatabase.  Enter a comma delimited list of email addresses.   

App Admin 

Send an email if no feature is 
found in GIS to update 

Sends an email message when the Lucity Data Update SOE cannot find a feature in the geodatabase to 
update.  The alert is sent to the addresses identified in the List of emails for notifications regarding 
failures... setting. 

App Admin 

Use Feature Service instead of 
Lucity SOE 

Tells the Lucity GIS Integration to use a feature service to push updates to the geodatabase. rather 
than a map service with the Lucity SOE. 

App Admin 
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* Affects only Lucity Web or is related to the Web application alone. 

 

 

 



 

 

GIS WEB 

The GIS Web settings control how the Lucity Web Map operates. 

OPTION FUNCTION  
PERMISSIONS 

Automatically save redlining 
edits 

Automatically saves all changes made using the redlining tools. App Admin 

Comma separated criteria to use 
for a where clause if parcel layer 
is to be queried.  Keywords are 
{BUILDING},{STREETNAME},{STR
EETNAME2},{ZIP} 

Provides a template for the application to use when querying a parcel layer for information.  This 
template should specify actual field names. 
 

Example: The following criteria indicate the building number is stored in the feature class in a field 

called ADDRESS and the street name is stored in a field called STRNAME. 

ADDRESS={BUILDING} AND STRNAME='{STREETNAME}' 

There are four available keywords: 

{BUILDING} 

{STREETNAME} 

{STREETNAME2} 

{ZIP} 

App Admin 
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Force the GIS Web Map to 
always open to the default 
extent 

Controls how the webmap opens. 

If this option is TRUE: 

 If any services in the web map were flagged as the Default Extent (this is set on the Map Edit 
form)- the full extent of that service will be used. 

 Unless the system default extent was set (this is set on the Map Setup form)- that extent will be 
used 

 Otherwise the initial extent is the full extent of all layers in the map. 

If this option is FALSE: 

 If there is an extent saved from the previous web map session it will use that. 

 Otherwise the initial extent is the full extent of all layers in the map. 

App Admin 

Operational Data Spatial 
Reference WKID 

Specifies the WKID (Well-Known Spatial ID) for the operational data layer in the Web Map.  Lucity 
uses this spatial reference to record xy coordinates and any other spatial data. 

App Admin 

Preload GIS caches to speed 
initial map load 

Pre-loads expensive queries such as the GIS Map Service metadata queries to speed up first load of the 
map for web and mobile.  

IT Admin 

Separator to use for Geocoding 
Intersections 

Enables agencies to specify which character their geocoding service uses as a separator.  By default, 
this field is set to the | character. 

App Admin 

Street Address Geocoding Field Indicates the field name on which the geocoder is based. App Admin 

URL to address layer in map 
service 

Specifies the URL for a parcel service used to find addresses. To switch between this and a geocoding 
service, check the setting "Use an address layer for ..." 

Note: REST/ must precede the word service in the URL. 

Note: If using a parcel service, be sure to enter the URL for the map service and add the layer number 

to the end. For example, if the parcel layer is the 10th layer in the service, the end of the URL would 
look something like: ...rest/services/baselayers/MapServer/10 

App Admin 
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Use an address layer for address 
queries instead of geocoding 
service 

Enables users to use a parcel layer instead of a geocoding layer. App Admin 

Use GIS Viewer instead of GIS 
Web for Show in Map 

Forces the Web Show in Map tool to launch the Lucity GIS Viewer instead of the Lucity Web Map. App Admin 

 

 





 

 

IDENTITY SERVER 

The Identity Server settings affect how the server operates.  The identity server gives users a token that helps to identify them wherever they 
are logged into the system. 

OPTION FUNCTION  
PERMISSIONS 

Number of Minutes before 
re-validating a token against 
Identity Server 

Specifies the number of minutes that a user’s token is held in cache by the REST API.  Caching the 
token improves system performance by reducing the number of times the token is verified against the 
identity server. 

IT Admin 

Number of Minutes until a 
token expires for Mobile Apps 

Controls how long a Lucity Mobile user's login token can be used before it expires.  The default 
setting is 600 minutes (10 hours).   

This is a safety feature that ensures that, if a token is stolen, it is good only for a limited amount of 
time.  Increasing this number increases the risk that forged or stolen tokens can be used maliciously.  
Decreasing this number makes it more likely that a valid user will time out while they are working. 

IT Admin 

Number of Minutes until a 
token expires for the Internal 
Web App 

Controls how long a Lucity Web user's login token can be used before it expires. The default setting is 
600 minutes (10 hours).   

This is a safety feature that ensures that, if a token is stolen, it is good only for a limited amount of 
time.  Increasing this number increases the risk that forged or stolen tokens can be used maliciously.  
Decreasing this number makes it more likely that a valid user will time out while they are working. 

IT Admin 

Public URL to the Identity Server 
for the Internal Web App 

An alternate url which is accessible outside the Lucity Web server to be used for client applications 
such as the ArcGIS Pro addIn for authenticating to Lucity. Do not put data in this setting unless the 
Lucity Web server process must use a different url than consuming client processes. It is not necessary 
to match the scheme of this url with the "Use TLS for Internal Web App Security" setting. 

IT Admin 

Public URL to the Identity Server 
or the Mobile Apps 

An alternate url which is accessible outside the Lucity Mobile server to be used for client applications 
such as the iOS and Android tablet applications for authenticating to Lucity. Do not put data in this 
setting unless the Lucity Mobile server process must use a different url than consuming client 
processes. It is not necessary to match the scheme of this url with the "Use TLS for Mobile Security" 
setting. 

 

IT Admin 
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Secret value internal web apps 
need to authenticate users 

Acts as a password salt to control whether a token can be used to access the Lucity REST API.  Use a 
unique value.  It should not be the same as the Secret value mobile apps need to authenticate users. 

IT Admin 

Secret value mobile apps need 
to authenticate users 

Acts as a password salt to control whether a token can be used to access the Lucity REST API.  Use a 
unique value.  It should not be the same as the Secret value web apps need to authenticate users. 

IT Admin 

The name of the certificate used 
for cookie protection on the 
internal Identity Server 

The Lucity installer will configure a certificate for protecting cookies used by Lucity Identity Server on 
the web server where the application is installed. The Lucity installer will write the name of this 
certificate automatically. 

IT Admin 

The name of the certificate used 
for cookie protection on the 
mobile Identity Server 

The Lucity installer will configure a certificate for protecting cookies used by Lucity Identity Server on 
the mobile REST API where the application is installed. The Lucity installer will write the name of this 
certificate automatically. 

IT Admin 

The name of the certificate used 
for signing tokens on the 
internal Identity Server 

See the Installation Guide (http://help.lucity.com/webhelp/v170/install/#37228.htm). IT Admin 

The name of the certificate used 
for signing tokens on the mobile 
Identity Server 

See the Installation Guide (http://help.lucity.com/webhelp/v170/install/#37228.htm). IT Admin 

URL to the Identity Server for 
the Internal Web App 

The URL to the Identity Server for the Internal Web App. The Lucity Web application must be able to 
resolve this url from the web server where Lucity Web is installed with no certificate errors. The Lucity 
installer writes this value. If Lucity Mobile and Lucity Web are installed on the same server, it may be 
necessary to manually configure this value. It is necessary to match the scheme of this url with the 
"Use TLS for Internal Web App Security" setting. 

IT Admin 

URL to the Identity Server for 
the Mobile Apps 

The URL to the Identity Server for the Mobile App. The Lucity Mobile application must be able to 
resolve this url from the web server where mobile is installed with no certificate errors. If Lucity 
Mobile and Lucity Web are installed on the same server, it may be necessary to manually configure this 
value. It is necessary to match the scheme of this url with the "Use TLS for Mobile App Security" 
setting. 

IT Admin 

Use TLS for Internal Web App 
Security 

Indicates that Lucity Web must run over transport layer security (TLS).  If an agency exposes Lucity 
Web to the Internet, this option should be set to TRUE. 

IT Admin 

http://help.lucity.com/webhelp/v170/install/#37228.htm
http://help.lucity.com/webhelp/v170/install/#37228.htm
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Use TLS for Mobile App Security Indicates that Lucity Mobile must run over transport layer security (TLS). This option should always be 
set to TRUE unless an agency's mobile devices only communicate over a secure VPN. 

IT Admin 

 

 





 

 

MOBILE 

The Mobile settings provide controls for the Lucity Mobile application for Android devices. 

FIELD FUNCTION  
PERMISSIONS 

Combine Composite Fields such 
as Street Name and Address in 
Mobile Grids 

Causes the street name fields and the address fields to be combined on mobile views. This may affect 
sorting and filtering capabilities. 

App Admin 

Log Device latitude and longitude Instructs Lucity Mobile to keep a log of each device's location.  This log is stored in the UDEVICELOC 
table. 

 This feature enables tracking for all users on all devices. 

 Tracking can be disabled for a user on a device.  This is done within the device's settings. 

App Admin 

Max Columns Returned Specifies the number of columns of data to display in a View in Lucity Mobile. App Admin 

Maximum number of days to 
store device location history 

Not currently used. App Admin 

Maximum records to return per 
request for mobile 

Limits the number of records returned per request in Lucity Mobile to protect the server from being 
over-burdened by unusually large requests. 

App Admin 

Update the offline Android cache 
nightly 

Directs the mobile server to generate offline caches for Android tablets every night.  If set to FALSE, 
the cache will not generate. 

App Admin 

Update the offline iOS cache 
nightly 

Directs the mobile server to generate offline caches for iOS tablets every night.  If set to FALSE, the 
cache will not generate. 

App Admin 

Url for the Lucity Mobile Server 
Virtual Directory 

Specifies the externally accessible URL for Lucity Mobile Server.  This address is used to connect a 
tablet to Lucity Mobile when the device is connecting outside the network firewall. 

IT Admin 

 

 





 

 

REPORTING 

The Reporting settings let administrators control how reports are displayed and where they are stored within Lucity Web. 

 

Close reports immediately to 
avoid max processing limit errors 
(may slow report generation) 

Description: This setting causes report connections to be immediately closed after a report page has 
generated. Crystal Reports limits how many concurrent reports may be open and this will allow more 
reports open at once. However, it will cause higher CPU utilization and slightly slower report 
performance because the report must be regenerated for each page. By default, a user's report 
connections are closed when a user runs a new report and an older report has been open for more 
than 5 minutes or when the user's web session ends. Reports may also close when the user closes the 
window displaying the report but this may be unreliable. 

IT Admin 

Create Bookmarks From Group 
Tree 

Enables bookmarks in Basic View reports. IT Admin 

Get Custom Crystal Reports on 
Web App Startup 

Directs Lucity Web to get new copies of custom Crystal Reports from the document server whenever 
Lucity Web is restarted. 

IT Admin 

Path where Reports are stored 
(Reports Hive) * 

Establishes a network path for the location in which uploaded reports are stored. IT Admin 

Suppress Subtitles on Dashboard 
Reports 

Eliminates the prompt for subtitles on reports that have a subtitle parameter, causing the report to 
load faster. 

App Admin 

Suppress Subtitles on View 
Reports 

Eliminates the prompt for subtitles on reports that have a subtitle parameter, causing the report to 
load faster. 

App Admin 

 

 





 

 

REST API 

The REST API settings let administrators configure the REST APIs. 

FIELD FUNCTION  
PERMISSIONS 

Allow RequestNumber and Email 
queries to the Citizen Portal REST 
API without providing both 
parameters 

Controls how the Citizen Portal REST API works.  Enable this option to allow the API to search for a 
Request using either the Request Number or Email address without having to have both parameters. 

App Admin 

Automatically push invalid 
request addresses to the general 
location field 

Allows third-party application developers to instruct the REST API to automatically move an invalid 
address made on a citizen Request to the general location field (if empty).  This feature is helpful 
when citizens can enter an address which may not validate.  It only applies to the Citizen Portal REST 
API. 

App Admin 

Default Public REST WKID Specifies the WKID (well-known ID) for the coordinate system used by the external GIS service, if: 

 the external GIS service's WKID is different than the Operational Data Spatial Reference WKID 
found on the GIS Web tab (see "GIS Web" on page 39); 

and  

 the external service is NOT using a Mercator projection. 

App Admin 

Expose a service directory for 
Lucity Citizen Portal REST API 

Determines whether a help page (directory) is included for the Lucity Citizen Portal REST API opening 
page. It is recommended that this setting be turned off in production environments because it exposes 
unnecessary information about the endpoints and access points available. 

IT Admin 

Expose a service directory for 
Lucity REST API 

Determines whether a help page (directory) is included for the Lucity REST API opening page. It is 
recommended that this setting be turned off in production environments because it exposes 
unnecessary information about the endpoints and access points available. 

IT Admin 

Logon to use for anonymous 
REST API Access 

Allows anonymous users to gain access to Lucity. App Admin 

Maximum records to return per 
request for rest api 

Limits the amount of records in a filtered set.  The higher the number, the more likely it is that web 
server performance will be affected. 

IT Admin 
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Send Stack Traces to Client Apps 
on Errors from REST APIs 

Provides detailed information through the REST API.   

WARNING: THIS OPTION SHOULD ONLY BE SET TO TRUE FOR DEBUGGING PURPOSES, AS IT MAY 
REVEAL INFORMATION THAT HACKERS COULD USE TO ATTACK THE SYSTEM. 

IT Admin 

Url for Citizen Portal REST API 
(optional, rarely required) 

Used by clients that have the Citizen Portal REST API installed behind a load-balancer that uses 
transport layer security (TLS), while the services behind the balancer use HTTP. 

Alternately, this setting may also be used by clients whose URL differs from the standard 
http://servername.alias/LucityCitizenRestAPI. 

IT Admin 

URL for Internal REST API 
(required for internal web app) 

The URL for the Internal REST API used by Lucity Web.  This URL is required to run the application. IT Admin 

Url for REST API (optional, rarely 
required) 

Used by clients that have the REST API installed behind a load-balancer that uses transport layer 
security (TLS), while the services behind the balancer use HTTP. 

Alternately, this setting could also be used by clients whose URL differs from the standard 
http://servername.alias/LucityRestAPI. 

IT Admin 

Use an alternate coord system as 
the Default Coordinate System 
for Public REST calls 

When enabled and the Default Public REST WKID is blank, the system assumes the incoming 
geographic information is using a Mercator projection.  If the Default Public REST WKID is filled out, 
the system uses the specified WKID's projection. 

If this option is set to FALSE, the system assumes that any incoming geographic information uses the 
Operational Data Spatial Reference WKID found on the GIS Web tab. 

App Admin 

Use Extensionless URL's (only 
supported in IIS7+) 

Allows administrators to choose to omit the extension in the REST API URLs.    

 For example, if the URL is http://restapi.gbams.net/Public/Work/Requests.svc/57481, setting 
this option to  TRUE  would allow users to use the following URL instead: 
http://restapi.gbams.net/Public/Work/Requests/57481.  Note that the second URL does not 
include the ".svc" extension. 

IT Admin 

 

 



 

 

SAAS 

The SaaS settings provide information about the program's configuration when it runs as "Software as a Service."  None of these settings may 
be edited. 

FIELD FUNCTION  
PERMISSIONS 

Software as a Service Indicates whether the program is being run as Software as a Service.  This setting is based on the 
Lucity License Codes.  When this setting is True, several other settings are available (see below). 

IT Admin 

 

The following settings appear only when the Software as a Service setting is marked True.  Some of these settings are specific to this setting 
category (SaaS); others are carried over from other categories. 

FIELD FUNCTION SETTING 
MOVED FROM 

Comma Delimited List of servers 
running WebCitizen 

Lists the URLs of servers running the Lucity Citizen Portal.   

This setting should include the URL to the Citizen Portal application (e.g., 
http://127.0.0.1:2295/gbamswebcitizen).  If there is more than one web server for Citizen Portal, 
enter each URL, separated by commas. 

Website 

Default Location for map exports Specifies the network path to the location in which Map images should be saved when creating a new 
Work Order, Request, etc., with an attached map. 

GIS Desktop 

Enable S3 integration for 
document storage 

Allows the Lucity Document Server to store documents to the Amazon Cloud.  

Favor configuration over 
performance for business rules 

Directs the system to push changes that users make to field properties in Lucity Desktop to Lucity Web 
when the web cache is cleared. 

Normally, when changes are made to field properties (such as mask, required, editable) in the Desktop, 
IIS must be reset in order for those changes to be pushed into Lucity Web.  Enabling this rule allows 
these changes to be pushed into Lucity Web by clearing the web cache, despite the fact that this may 
cause a significant drop in performance (15-20%). 

Web 
Performance 
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GIS/Lucity Edit Integration - 
Disable all updates to the 
geodatabase from Lucity 

Prevents the geodatabase from being updated with edits made in Lucity Desktop and Web. GIS Edit 
Integration 

Internal Website Specifies the path to Lucity Web.  The paths for the internal web sites should almost never be 
changed.  ONLY edit these fields if there are multiple web servers and one needs to be designated to 
support the Lucity Administration for Web Apps Previews. 

Website 

Name of Bucket where S3 
documents are stored 

Specifies the name of the Amazon Cloud S3 bucket that the Lucity Document Server should use if 
storing documents. 

 

Path where uploaded documents 
are stored (Citizen) 

Indicates the network path for the location in which documents from Citizen Portal will be stored.  
(Applies to Citizen Portal.) 

Documents 

Path where uploaded documents 
are stored (Internal) 

Indicates the network path for the location in which documents from Lucity Web and Mobile will be 
stored.  (Applies to Lucity Web.) 

Documents 

Region endpoint where S3 bucket 
resides 

Specifies the S3 endpoint that stores the bucket in which the Lucity Document Server will store 
documents. 

 

URL for Lucity Custom Web 
Integrations 

Specifies the URL for a custom integration purchased to look up customers.  This information is 
provided by Lucity during the implementation of the custom product. 

Website 

Url for the Lucity Mobile Server 
Virtual directory (Externally 
accessible version) 

Specifies the externally accessible URL for Lucity Mobile Server, which is used to connect to Lucity 
Mobile from outside the network firewall. 

Mobile 

Url for the Lucity Mobile Server 
Virtual Directory (Internally 
accessible version) 

Specifies the internally accessible URL for the Lucity Mobile Server, which is used to download data to 
users' tablets using local Wi-Fi before users go offline. 

Mobile 

Windows Authentication Website Specifies a path to Lucity Web that first accesses a launcher page that attempts to log the person 
currently logged into the computer into Lucity.  The paths for the internal websites should almost 
never be changed. 

Website 

 

 



 

 

SECURITY 

The Security settings control aspects of Lucity designed to protect an agency's data. 

FIELD FUNCTION  
PERMISSIONS 

Add X-FRAME-OPTIONS to ALL 
Response Headers 
(recommended value is to leave 
this blank) 

Adds x-frame-options to every HTTP response headers generated by the Lucity REST API and Lucity 
Web to avoid false-positive reports from penetration-testing tools. 

Background: 

Some penetration testing tools may flag any response from a web server as a clickjacking risk if the 
response does not contain the X-FRAME-OPTIONS header.  However, clickjacking can only occur on 
web pages, not through image files and responses from REST API calls.   

If a penetration test reports that an agency's Lucity software is at risk because every response does not 
include X-FRAME-OPTIONS, change this setting to DENY.    

Lucity will then add 'X-FRAME-OPTIONS=DENY' to every HTTP response in every Lucity REST API and 
Lucity Web site.   

Lucity recommends that agencies leave this setting blank for better performance. Only web pages can 
be clickjacked, and other Lucity settings can be used to control real clickjacking risks.  (See "How To 
Handle Frames for Internal Web Pages," below.)   

IT Admin 

Allows access to GIS web services 
with certificate errors 

Directs Lucity to ignore certificate errors for transport layer security (TLS) connections.  Agencies that 
use self-signed certificates with ArcGIS Server use this setting for testing purposes. 

IT Admin 

Block SQL for the Lucity Citizen 
Portal REST API 

Reduces the risk of SQL-injection attacks from the Citizen Portal site by preventing third-party 
applications that use the Lucity Citizen Portal REST API from providing direct SQL for querying records.  
Before setting this option to TRUE, make sure third-party applications do not require querying 
capabilities. 

IT Admin 

Block SQL for the Lucity REST API Reduces the risk of SQL-injection attacks through the REST API by preventing third-party applications 
that use the Lucity REST API from providing direct SQL for querying records.  Before setting this 
option to TRUE, make sure third-party applications do not require querying capabilities. 

IT Admin 

Can Users Change Password 
from Mobile 

Lets users change their password from the Lucity Mobile app for iOS and Android. 

Default value is FALSE. 
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Disable DOS protection Turns off protection against denial-of-service attacks. IT Admin 

Enable Aggressive Javascript 
Injection Detection 

Causes Lucity code to interrogate all data input for possible JavaScript-injection attempts.  This 
setting should only be set to FALSE if the process causes problems with performance or if it falsely 
identifies normal inputs as possible hacking attempts. 

 

Enable diag.html Server 
Information for debugging (set to 
FALSE if Internal Web App is 
exposed to Internet) 

Allows the LucityWeb diagnostic page to display information about the server.  This setting should be 
set to FALSE if Lucity Web is installed on a server exposed to the internet. 

IT Admin 

How to Handle Frames for Citizen 
Web Pages 

Controls whether Citizen Portal pages can be displayed in a frame.  When enabled (DENY), this 
setting helps protect against the relatively minor risk of clickjacking.  This setting accepts three 
values: 

 Blank - Site pages can be displayed inside frames.  Small risk of clickjacking exists. 

 DENY - Site pages cannot be displayed inside frames.  No risk of clickjacking. 

 SAMEORIGIN - The website can be displayed in a frame, but only if the frame and the page that 
displays the frame come from the same source.  

IT Admin 

How to Handle Frames for 
Internal Web Pages 

Controls whether Lucity Web pages can be displayed in a frame. When enabled (DENY), this setting 
helps protect against the relatively minor risk of clickjacking.  This setting accepts three values: 

 Blank - Site pages can be displayed inside frames.  Small risk of clickjacking exists. 

 DENY - Site pages cannot be displayed inside frames.  No risk of clickjacking. 

 SAMEORIGIN - The website can be displayed in a frame, but only if the frame and the page that 
displays the frame come from the same source.  

IT Admin 
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List of values that are not 
allowed in search filters to 
reduce risk of getting hacked 

Reduces the risk of SQL-injection attacks through the REST API by blocking certain words in queries.   

When enabled, any queries from the REST APIs and Lucity Web that include a word that is listed in this 
field are blocked.  Administrators are strongly encouraged to talk to Lucity Support before making 
changes to this setting.   

 Default Value: ( insert | update | delete | truncate | reconfigure | union 
|sysobjects|waitfor|xp_cmdshell|;|--) 

IT Admin 

Regex for range of unicode 
characters allowed in SQL 

Reduces the risk of SQL-injection attacks by prohibiting characters from other symbol sets and other 
languages. 

 Default Value: [\u0000-\u007F] 

IT Admin 

 

 





 

 

SECURITY - PASSWORDS 

The Security - Passwords settings control what constitutes an acceptable Lucity password and when passwords expire. 

FIELD FUNCTION  
PERMISSIONS 

Allow easily guessed passwords Prohibits users from using overly simple passwords.  When enabled, this setting blocks passwords 
that: 

o consist of repeated values - 1111111, AAAAAA; 

o consist of a common sequence - 1234567, ABCDEFG; 

o supply user information  - logon, first name, last name, email address; or 

o include one of these easily guessed passwords - password, qwerty, abc123, iloveyou, 
admin, letmein, qwertyio, football, baseball, welcome, 1qaz2wsx, dragon, master, 
monkey, login, princess, qwertyiop, passw0rd, p@ssword, p@ssw0rd, starwars, 
lucity, gba. 

 

IT Admin 

Days before password expiration 
to warn user 

Indicates how many days before a user's password expires that he or she should receive an 
in-application warning.   

Does not affect users that login via Windows Authentication. 

IT Admin 

Days before password expiration 
to warn user with Email. 

Indicates how many days before a user's password expires that he or she should receive an email 
warning. 

App Admin 
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Enforce Password history Enforce password history sets how frequently old passwords can be reused. This policy can be used to 
discourage users from changing back and forth between a set of common passwords. Lucity can store 
up to 24 passwords for each user in the password history. 

 0 - Setting Disabled 

 1 - Stops them from reusing their last password.  This password can be reused again next time 
they have to come up with a new password. 

 2 - Stops them from reusing their last 2 passwords. 

 etc.. 

IT Admin 

Maximum password age Minimum password age determines how long users must keep a password before they can change it. 
This field can be set to prevent users from cheating the password system by entering a new password 
and then changing it right back to the old one. 

IT Admin 

Minimum Length For Passwords 
(Must be 1 or greater) 

Establishes the minimum number of characters allowed for a Lucity password. IT Admin 

Minimum Password Age Establishes the number of days that must pass before an old password can be reused. IT Admin 

Password must meet complexity 
requirements 

Indicates whether a user's passwords must meet a set of requirements for complexity.   

If this setting is enabled, a user's Lucity password must contain three of these four elements: 

Upper case letter 

Lower case letter 

Number 

Special character 

IT Admin 

Send an email to the user when 
their password changes 

Sends an email to the email address associated with a Lucity login when the password is changed. App Admin 

 

 



 

 

SETTINGS WITH CUSTOM INTERFACE 

The Settings with Custom Interface feature is informational and read-only.  It displays sometimes needed settings within the system that are set 
elsewhere, either by client maintenance or some setup process. 

FIELD FUNCTION 

Alternate Zone - Field Name The name of the field that contains the alternate zone ID in the alternate zone layer. 

Alternate Zone - Layer Index or 
Alias Name 

The name used for the alternate zone in the map service. 

Alternate Zone - Service Name The name of the map service that contains the alternate zone layer. This must match the name defined 
in map services. 

Client Name Name of the client currently logged into. 

Client Number The above client's identification number. 

Configuration Directory The path to the Lucity Server config folder. 

Customer Identifier The name of the license being used by the client. 

Date of Last Data Collector 
Export 

Date of the last time the usage statistics were sent to Lucity.  Used to prevent accidental excessive 
data transmissions. 

Default Basemap Name Specifies the name of the map service that should be used for the default base map. This name comes 
from the Name column of the GIS > Map Services screen. The map service referenced here must be 
marked as a base map. 

Default Geocoding Service Name Specifies the name of the geocoding service that should be used as the system default 

Default Map Extent: 

 xmin,ymin,xmax,ymax,wkid 

Indicates the default extent for the webmaps.  Enter the desired extent using the following format: 

Xmin, Ymin, Xmax, Ymax, wkid  

Default Map for Users The name of the web map that will open by default for users that don't have a group assigned default 
web map. 

Default Map for Users- Mobile The name of the mobile map that will open by default for users that don't have a group assigned 
default mobile map. 
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Default Mobile Base Map Name Specifies the name of the map service that should be used for the default base map in Mobile. This 
name comes from the Name column of the GIS > Map Services screen. The map service referenced 
here must be marked as a mobile base map. 

Default Vehicle Start Address for 
Work Routing 

Indicates the address that the Routing tool should use as the start location. If no address is supplied, 
the first Work Order is used. 

License Code An encrypted copy of the license file. 

Location of the directory 
containing images for 
SignLibrary 

Sub-hive within the document server hive where custom sign library images are stored. 

Login ID used for background 
tasks. 

Lucity Login used to run scheduled tasks. 

Maintenance Zone- Field Name The name of the field that contains the alternate zone ID in the maintenance zone layer. 

Maintenance Zone- Layer Index 
or Alias Name 

The name used for the maintenance zone in the map service. 

Maintenance Zone- Service 
Name 

The name of the map service that contains the maintenance zone layer. This must match the name 
defined in map services. 

Name of bucket where S3 custom 
code is stored 

For use by Lucity for client using SaaS. 

Name of bucket where S3 
documents are stored 

For use by Lucity for client using SaaS. 

Name of bucket where S3 
temporary files are stored 

For use by Lucity for client using SaaS. 

Never overwrite maintenance or 
alternate zone 

When TRUE, prevents the system from overwriting the existing Maintenance Zone or Alternate Zone 
values when these fields are entered on a Request or Work Order. 

Region endpoint where S3 bucket 
resides 

For use by Lucity for client using SaaS. 
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Request Generator POP3 Port The port that the Request Generator uses to access the mail server. 

Request Generator POP3 Server The name of the mail server the Request Generator accesses. 

Request Generator Use TLS Indicates whether the Request Generator uses TLS. 

SMTP Encrypted Password An encrypted copy of the password that Lucity uses to access the SMTP server.  Configured using the 
Lucity Email Setup (http://help.lucity.com/webhelp/v170/services/#33990.htm). 

SMTP Mail Send over TLS Indicates whether Lucity is sending email information over TLS.  Configured using the Lucity Email 
Setup (http://help.lucity.com/webhelp/v170/services/#33990.htm). 

SMTP Port The port through which Lucity connects to the SMTP server.  Configured using the Lucity Email Setup 
(http://help.lucity.com/webhelp/v170/services/#33990.htm). 

SMTP User The user through whom Lucity accesses the SMTP server.  Configured using the Lucity Email Setup 
(http://help.lucity.com/webhelp/v170/services/#33990.htm). 

The Customer Account the 
Installation is Associated with 

A Lucity assigned account identifier. This is written by Client Maintenance. 

The License Identifier the 
installation is associated with 

The license code to which the above client is linked. 

Type of Client License The kind of license the used by the client. 

 

 

http://help.lucity.com/webhelp/v170/services/#33990.htm
http://help.lucity.com/webhelp/v170/services/#33990.htm
http://help.lucity.com/webhelp/v170/services/#33990.htm
http://help.lucity.com/webhelp/v170/services/#33990.htm




 

 

WEB PERFORMANCE 

The Web Performance feature allows users to adjust system settings for better web performance. 

FIELD FUNCTION  
PERMISSIONS 

Allow Animations to run inside of 
the website 

When False, animations are disabled in Lucity Web.  This may be helpful for some presentations or 
for users running apps through remote desktop or webex. 

App Admin 

Exclude Desktop Records in Add 
Mode (When TRUE, queries will 
be slower) 

When enabled, Lucity Web runs special queries so that grids do not display records that are in the 
process of being added to Lucity Desktop.  When disabled, such records appear in Web grids as blank 
records.  Disabling this option improves performance. 

App Admin 

Favor configuration over 
performance for business rules 

When an administrator changes field properties in the Desktop (such as masking fields, requiring fields, 
or making fields editable), the administrator must reset IIS to push the changes to Lucity Web.  
Enabling this setting allows an admin to push these changes to Lucity Web by simply clearing the web 
cache.  Note, however, that this process may cause a [temporary, but] significant drop (15-20%) in 
performance. 

IT Admin 

Max # of Pages on PDF Crystal 
Reports (to reduce performance 
impact on server) 

Controls the maximum number of pages a pdf web report will generate.  The higher the more load is 
placed on the server. 

IT Admin 

Persist changes to page size in 
ListView 

Allows users to save their current page size as a personal customization.  This setting does not apply 
to the WebCitizen system. 

App Admin 

The number of minutes until a 
dashboard report should be 
refreshed 

Establishes the number of minutes between Dashboard report refreshes.  (Default value = 240 
minutes) 

Reports that appear on the dashboard are not updated every time the user refreshes the dashboard.  
Once a report file is generated the dashboard will continue to show the same file every time the 
dashboard is refreshed until the file is older than the number of minutes set in this setting.  Once the 
time limit is reached the report file will be re-generated with new data.  This limitation saves 5 to 10 
seconds of response time.   

Note:  Users can always use the option located below the Dashboard PDF reports to immediately 

refresh a report on demand. 

IT Admin 
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WEBSITE 

The Website settings are used to indicate the web pages to which the forms are routed and the login ID for the Citizen Web application. 

FIELD FUNCTION  
PERMISSIONS 

Allows SignalIR to use the 
database to communicate 
between web farm instances 

 IT Admin 

Internal Website Specifies the path to Lucity Web.  This default path should almost never be changed.  Edit this field 
ONLY if multiple web servers exist and one must be designated to support Lucity Administration for 
Web Apps Previews. 

IT Admin 

URL for Lucity Custom Web 
Integrations 

Used to integrate a custom customer-lookup product, if an agency has purchased one.  In such cases, 
Lucity provides the URL when it implements the custom product. 

IT Admin 

Use a custom customer lookup 
for requests 

Indicates whether the Customer Lookup tools use the built-in Lucity functionality or a custom lookup 
tool. (Related to previous setting.) 

App Admin 

Windows Authentication Website Indicates the path to the launcher pages that tries to log the user into Lucity Web using windows 
authentication. This path should almost never be changed. 

IT Admin 

 

 





 

 

WORK 

The Work settings control the functionality of Lucity Web's Work module. 

FIELD FUNCTION  
PERMISSIONS 

Do Work Flow Popup Lists Filter 
using StartsWith or Contains 

Controls how the filters function in fields used to select Work Flow Setup items.  The filters match 
what the user types in the field to records in the list, based on whether the records' IDs start with OR 
contain what the user typed.   

Enter StartsWith or Contains in this field to dictate how the system filters. 

App Admin 

Name of the RPT file to use as 

the default timesheet report * 

Specifies the last part of the path to and name of the RPT file used as the default timesheet report for 
all users.  The system path will automatically look in the root of the Lucity Web install. 

Example: Reports\Work\TIMESHEETREPORT.rpt 

App Admin 

Send a nightly alert if parts 
counts are inaccurate 

Sends an email message to specified users whenever the nightly processes identify a mismatch 
between Part counts.  The message is sent to users named in the List of email addresses for system 
health notifications on the Email tab. 

App Admin 

Show Customer Lookup button 
for Work Order billing 

Controls whether the Customer Lookup button appears for Work Order Billing Info. App Admin 

Show user a popup of choices to 
open Work Orders with 

Lets users choose which Work Order view they would like to open in Lucity Web.  The pop-up prompt 
appears when a user performs an action that opens a Work Order view and: 

 This option is enabled. 

 The user has permission to open more than one Work Order view. 

If this option is disabled, Lucity Web opens with the user's default view. 

App Admin 

Note: The System Settings dialog does not provide a way to upload reports. Reports must be posted to the web server in order to be 
available online. Usually, the files are stored within one of the subdirectories of the Reports folder (e.g., \Equip and \Work). The Timesheet 
report is usually placed in the \Work subdirectory. 
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CLEAR ALL CACHES 

The Clear all Caches tool gives users a quick way to perform cache maintenance on all of their Lucity Web applications. 
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BUTTONS 

Clear all Caches Clears all web caches for all instances of Lucity Web, Citizen Portal, and Mobile 
Server on all web servers.  Also clears the cache for connected Identity Servers. 

Restart Internal Web 
Apps 

Restart Citizen Web 
App 

Restart Mobile Web 
Apps 

Restart the respective Lucity Web applications on all servers.  Also restarts 
connected Identity Servers. 

Refresh Custom 
Reports 

Forces the web server to re-download all custom reports from the Document 
Server. 

Refresh Offline Cache Recreates the offline cache for the Lucity Mobile Server. 

 

How To Clear Caches 

Basic Cache Clearing: Most caches can be cleared using the following methods.  Users are not kicked off of the Lucity system and will not lose 
work.  Basic cache-clearing is necessary for some configuration changes. 

 Open the Tasks screen and click the Clear All Caches button.  (This clears all caches for all web-based applications.) 

Web App Reset: The following actions clear every cache; however, they also kick all Lucity users out of the system, causing them to lose any 
unsaved work.  A few caches are only cleared using a web application reset. 

 Open the Tasks screen and click the appropriate Restart .... button. 

 Log onto the web server and, in IIS, manually restart the Lucity Web app pool. 

 Log onto the web server and restart IIS. 
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All caches also reset at 2 a.m. daily, when the web app automatically restarts. 

Note:  Clearing the caches may temporarily reduce performance until the caches are repopulated. 

Note: These functions also clear the cache for the connected Identity Server. 

Note: The application checks for pending user-triggered background tasks like this every 6 seconds. 

When To Clear the Cache 

The cache must be cleared whenever a change is made to the configuration of a web component.  Typically, when an action requires a cache to 
be cleared before it takes effect, the system automatically clears the cache.   

In most cases, clearing the cache is sufficient to affect the changes in Lucity Web.  Note, however, that the following changes require further 
action beyond clearing the cache: 

 View/Grid/Form changes - If a user is viewing any of these elements when the cache is cleared, the user must close the Lucity view/grid/form 
and reopen it to see the changes. 

 Code/Type Pick-list value changes - If a user is viewing a Lucity form when a pick-list for field on that form is changed, the user must close and 
reopen the form to see such changes. 

 Permissions changes - The user must log out and log back into the application. 

 Dashboard changes - The user must log out and log back into the application. 

 Available Work Order Resource changes - If changes have been made regarding which Work Order Resources can be used in a Work Order, 
users must log out and log back in to the application. 

 Lucity Web > Admin Portal > System Settings changes - Users must log out and log back into the application. 

 Module Option changes - Users must log out and log back into the application. 

 Field Properties 

o Changing the Global - Required permission for a field requires a web app reset. 
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o Changing the Mask for a field requires a web app reset. 

o Changing the Min/Max values for a field requires a web app reset. 

 
 

OBJECT LOCK MANAGER 

Object locks are used to prevent two Lucity Administration users from editing the same form at the same time.   

If a user obtained a lock on an object and did not close the program correctly (due to a power outage, network problem, etc.), then the lock 
should clear on its own at the end of the expiration period defined in the Object Locking Dialog.  Failing that, the administrator can clear object 
locks in the Object Lock Manager. 
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FIELDS 

Release Allows the administrator to select which locks to clear. 

Lock ID Specifies the unique ID assigned to the lock when it was obtained. 

User Login Identifies the Lucity User Name of the person who obtained the lock. 

Entity ID Identifies the Type of object locked by the user (e.g., Work Order, Submit Process, 
etc.). 

Record ID Indicates the system-generated, unique ID of the record. 

Lock Date Displays the date and time the lock was initially obtained. 

Expiration Displays the date and time the lock is scheduled to expire. 

Machine Identifies the name of the computer used to lock the object. 

Intention Describes the reason the lock was generated.  If a record is being deleted, a 
Delete lock is obtained.  If a record is being edited, an Update lock is obtained.  

BUTTONS 

Refresh Refreshes the data in the Object Lock Manager.  A refresh is necessary to see 
any changes. 

Release Locks Releases any currently selected locks. 

Note: Locks that are shaded in gray cannot be cleared from this grid.  Locks may 

be grayed-out for the following reasons: 

 Delete locks are always grayed-out.  They are cleared by the system when 
the scheduled nightly tasks run. 

 Locks that have been obtained within the last five minutes are grayed-out.  
They are assumed to be still in use. 
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FILTER RECOMPOSITION 

The Filter Recomposition tool converts certain filters saved in Lucity modules from Advanced Filters to Basic Filters.   

To create a Basic Filter, users employ a Build-A-Filter function to generate a SQL script.  Advanced filters, which are more complicated, are 
written directly in SQL.   

The Filter Recomposition tool identifies Advanced Filters that could have been written using the Build-a-Filter function, but were not.  
Converting Advanced Filters back to Basic ones allows users to modify them with the Build-a-Filter function in the appropriate Lucity module. 

 

 

How To Recompose Filters 

1) In the Lucity Administration tool, select System > Filter Recomposition. 

2) When the tool opens, click the Start button. 
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3) The tool scans all filters, enhancing those that fit the recomposition criteria.  When the process is complete, the system notifies the user of 
the number of Advanced Filters it was able to convert back to Basic Filters for each module. 

Example: The tool found two Advanced Filters in the Facility Buildings module and was able to convert both of them back to Basic Filters. 
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BACKGROUND TASKS 

The Background Tasks Manager provides a list of all background tasks that users have initiated.  These tasks are managed by the Lucity Task 
Runner (http://help.lucity.com/webhelp/v170/services/index.htm#34443.htm) and are generally tasks that require more processing power or 
may run on several machines simultaneously.  Background tasks that need more processing power are offloaded from the Web server to the 
Services server.   

Types of background tasks include: 

 running a Street model, 

 sending rolling logs, 

 clearing all caches, 

 restarting the Lucity Web application, and 

 uploading custom Crystal Reports to the Web server. 

 

 

http://help.lucity.com/webhelp/v170/services/index.htm#34443.htm
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FIELDS 

ID Indicates the ID of the task. 

Name Identifies the task that the user initiated. 

Parameters States any parameters that the task needed to run. 

Created By Identifies the user who initiated the task. 

Creation Date Displays the date the task was initiated. 

Status Indicates the task's current status (Queued, Finished, or Failed). 

Status Date Shows the date that the status was last changed. 

Description Describes the nature of the task. 

Complete Indicates whether or not the task is complete. 

Email Identifies the email address that is alerted when the task is complete. 

BUTTONS 

Refresh Refreshes data in the User Invoked Tasks Manager.  A refresh is 
necessary to see any changes. 

Delete Deletes the record currently selected in the grid, which cancels an 
uncompleted task. 

Close Closes the window. 
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ACTIVE USER MANAGER 

The Active User Manager lets administrators identify which individuals are actively logged into Lucity and track them.  The tool provides a list of 
active users (those who have engaged product licenses, as well as those who are merely viewing application components), as well as several key 
pieces of data. 
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FIELDS 

User Identifies the Lucity Login for the individual currently using a Lucity 
program. 

Application Specifies which Lucity application the user is accessing. 

Activation Date/Time Indicates when the user logged into the application. 

IP Address Displays the IP address through which the user is accessing the 
application. 

BUTTONS 

Refresh Refreshes the data in the Active User Manager.  A refresh is necessary to 
see any changes. 

Delete Deletes the currently selected record, as well as any licenses actively 
engaged by the user, from the corresponding User License Manager. 

Note: This function is used when someone is logged in and gets kicked 
out/ locked out of the system (e.g., during a power outage). 

Close Closes the window. 
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ACTIVATIONS MANAGER 

Lucity uses activations to track licensing for several programs, including the Lucity Mobile applications. 

The Activation Manager lets administrators see information about current activations. 
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FIELDS 

Name Displays the device's name (i.e., the phone number). 

Activated On Identifies the date this device was last activated. 

License Indicates the type of license this device uses. 

BUTTONS 

Deactivate license Deactivates the selected record and removes it from the Active list. 

View Log  Shows each time the selected device has been activated or deactivated. 

 
 

DASHBOARD EXPORT/IMPORT 

The Dashboard Export/Import tools allow users to export Dashboards, Shared Tabs, and Shared Tab Groups from one Lucity environment and 
import them into another Lucity environment.  The desired dashboard elements are exported as a .json file, which can then be loaded into 
another system. 

Note: Both systems must use the same version of Lucity. 
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EXPORT SHARED TABS 

The Export Shared Tabs tool enables an administrator to export one or more Shared Tabs. 

 



 

85 

 

 

 

SHARED TAB LIST 

Select All Selects all of the Shared Tabs in the list. 

 
Locate Enables the user to search for a specific Shared Tab. 

NAMING 

New Tab Name Enables the user to change the name of the exported tab.  (Available if only one 
tab is selected in the list.) 

Dashboard tabs must have unique names.  This feature helps to avoid naming 
conflicts between exported tabs and tabs that already exist in the destination 
system. 

Tab Suffix Enables the user to avoid duplicate tab names by adding a prefix to the name of 
an exported tab.  This feature is useful when exporting multiple tabs. 

Dashboard tabs must have unique names.  This feature helps to avoid naming 
conflicts between exported tabs and tabs that already exist in the destination 
system. 

Description Enables users to enter an optional description of the import.  This text will 
appear when the file is imported. 

Export Associated Views Exports module views that are explicitly linked to plug-ins on the selected 
Dashboard Tab(s). 

Export Associated Users Exports the list of users associated with the selected shared dashboard tab(s).  

Export Exports the selected Dashboard Tab(s). 

 

How to export Shared Tabs 
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1) Select System > Dashboard Export/Import > Export Shared Tabs.  The Shared Tab Export windows appear. 

2) Select the tabs you would like to export. 

3) If desired, enter a new Name, Suffix, or Description. 

4) Choose whether to Export Associated Views and/or Export Associated Users. 

5) Click the Export button.  The following pop-up appears, asking the user to confirm the export settings: 
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6) Click OK.  The following pop-up appears: 

 

7) Navigate to the location where you would like to save the Export file. 

8) In the File Name field, provide a name for the Export file. 
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9) Click Save.  A pop-up appears with the results of the process. 

 

10) Click OK to close the pop-up. 
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EXPORT SHARED TAB GROUPS 

The Export Shared Tab Groups tool enables administrators to export one or more Shared Tab Groups. 
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SHARED TAB GROUP LIST 

Select All Selects all of the Shared Tab Groups in the list. 

 
Locate Enables users to search for a specific Shared Tab Group. 

NAMING 

New Group Name Enables the user to change the name of the exported tab group.  (Available if 
only one tab group is selected in the list.) 

Shared Tab Groups must have unique names.  This feature helps to avoid 
naming conflicts between exported tab groups and tab groups that already exist 
in the destination system. 

Group(s) Suffix Enables the user to avoid duplicate tab group names by adding a prefix to the 
name(s) of an exported tab group(s).  This feature is useful when exporting 
multiple tab groups. 

Shared Tab Groups must have unique names.  This feature helps to avoid 
naming conflicts between exported tabs and tabs that already exist in the 
destination system. 

Description Enables users to enter an optional description of the import.  This text will 
appear when the file is imported. 

Export Associated Views Exports module views that are explicitly linked to plug-ins on the selected Shared 
Tab Group(s). 

Export Associated Users Exports the list of users associated with the Shared Tabs that are part of the 
selected Shared Tab Group(s). 

Export Exports the selected Shared Tab Group(s). 
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How to export Shared Tab Groups 

1) Select System > Dashboard Export/Import > Export Shared Tab Groups.  The Shared Tab Group Export window appears. 

2) Select the tab groups you would like to export. 

3) If desired, enter a new Name, Suffix, or Description. 

4) Choose whether to Export Associated Views and/or Export Associated Users. 

5) Click the Export button.  The following pop-up appears, asking you to confirm the export settings: 
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6) Click OK.  The following pop-up appears: 

 

7) Navigate to the location where you would like to save the Export file. 

8) In the File Name field, provide a name for the Export file. 
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9) Click Save.   A pop-up appears with the results of the process. 

 

10) Click OK to close the pop-up. 
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EXPORT USER DASHBOARDS 

The Export User Dashboards tool enables administrators to export specific users' dashboard tabs. 
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USER DASHBOARDS LIST 

Select All Selects all of the user Dashboards in the list. 

Note: Only configured Dashboards (marked in white) can be selected.   

 
Locate Enables users to search for a specific Dashboard. 

NAMING 

Description Enables users to enter an optional description of the import.  This text will 
appear when the file is imported. 

Export Associated Views Exports module views that are explicitly linked to plug-ins on the tabs that are 
included in the selected user Dashboard(s). 

Export Associated Links Exports the links associated with the selected user Dashboard(s). 

Export Exports the selected user Dashboard(s). 

 

How to export User Dashboards 

1) Select System > Dashboard Export/Import > Export User Dashboards.  The User Dashboard Export window appears. 

2) Select the Dashboards you would like to export. 

o You can only select Dashboards that have been configured, which appear in white.   

o Dashboards that have not been configured appear in gray. 

3) If desired, enter a Description (optional). 

4) Choose whether to Export the Associated Views and/or Export the Associated Links. 
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5) Click the Export button.  The following pop-up appears, asking you to confirm the export settings: 

 

6) Click OK.  The following pop-up appears: 
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7) Navigate to the location where you would like to save the Export file. 

8) Modify the name of the Export file if desired. 

9) Click Save.  A pop-up appears with the results of the process. 

 

10) Click OK to close the pop-up. 

 
 

IMPORT 

The Import tool enables administrators to import Shared Dashboard Tabs, Shared Tab Groups, and User Dashboards that have been exported 
from one Lucity system into another Lucity system. 
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How to import a Dashboard element 

1) Select System > Dashboard Export/Import > Export User Dashboards.  The Import window appears. 

2) Click the Select File... button.  The following pop-up appears: 

 

3) Select the .json file that you want to import. 
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4) Click the Open button.  A pop-up describes the expected results of the import. 

 

5) Click OK to begin the import process.  A message will indicate whether the process was successful or produced errors.  [What if there are errors or 

warnings?] 

 

6) Click OK to close the window. 
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VIEW EMAIL REQUEST LOG 

The View Email Request Log provides a list of emails that the system received and turned into Requests.   

 

 

FIELDS 

MessageID The ID of the email. 

Request Number The Lucity-generated ID for the Request. 

From Address The address from which the email originated. 

To Address The address that received the email. 

Subject The text of the message's subject line. 

Body The text of the body of the message. 

Received Date The date the email was received. 

Processed Date The date the email was processed and the Request was created. 
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CLIENT MAINTENANCE 

Client Maintenance is an administrative tool used to manage database and client information related to the installation.  It is an integral part of 
the installation and maintenance processes because it ensures proper connectivity and licensing. 

The tool: 

 Launches database processes to ensure that Lucity database(s) matches the current version of the software. 

 Creates DSNs and DSN configuration files that provide connectivity with Lucity Desktop and other add-on tools. 

 Creates/verifies login credentials on database servers (SQL Server and Oracle) to permit connections to Lucity applications. 

 Manages product licensing to ensure that all purchased applications are available to the user. 

 Manages connection information pertaining to the location of the Lucity database(s). 

Before running Client Maintenance, SQL Server and Oracle users must have their Lucity databases installed for all clients they intend to activate.  
More information >>   

Client Maintenance as a Stand-Alone Tool 

Lucity automatically launches Client Maintenance during a server installation/upgrade; however, Client Maintenance is also accessible as a Lucity 
Admin tool for maintaining the current installation. 

Administrators can launch the tool from the Start menu:  Programs > Lucity > Admin Tools > Client Maintenance, or from the Lucity 
Administration Tool. 

An administrator might run Client Maintenance outside of an install/upgrade for any of the following reasons: 

 License Updates - If a user purchases or removes an existing product, Lucity gives the client a new license file.  Running Client Maintenance 
is necessary to update the product information indicated in the license file. 

 Lucity Server or Database migration - When databases are moved from their original location, an administrator must run Client Maintenance.  
(Additional actions may also be required in such cases.) 
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 Change Database Login Credentials - If a user wishes to change login credentials for the Lucity database, the credentials should be changed in 
Client Maintenance.  The tool will then update the database platform (e.g., SQL Server Management) and the Lucity configuration at the 
same time. 
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LOGIN SCREEN 

When launching Client Maintenance, users must provide credentials to show they have permission to make administrative changes to the 
database.  On the login screen, the user must supply the locations of the Lucity Config folder and the agency's license file, as well as some 
database system administrator credentials. 

How To Log into Client Maintenance 

1) When the installer launches Client Maintenance or a user launches it as a stand-alone product, the following window appears: 

 

2) In the Config Folder field, specify the path to the Lucity Config folder. 

3) In the License File field, specify the path to the provided license file. 
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4) Enter the the Admin DB Login ID and the Admin DB Password.  If multiple SQL Server/Oracle installations exist, with different credentials for 
each, enter the credentials for one of the installations.  The system will prompt for the others later.   

5) Check the Use Windows NT Integrated Security checkbox if you wish to connect to the database servers via Windows Authentication and the 
database servers have already been properly configured. 

6) Click Next.  The utility begins updating the Lucity configuration information. 
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REMAP LICENSES TO CLIENTS 

During multi-client installations, if the Client Maintenance tool is unable to determine which licenses are associated with which clients, the 
following screen will appear immediately after login: 

 

This screen allows users to associate existing client installations to the appropriate license in the agency's License file.   
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How to Map Licenses to Clients 

1) To determine which license should be associated with the currently installed client, highlight a License in the list in the middle of the screen.  
The License Information grid on the right will indicate which products will be enabled by the selected license. 

2) To associate a client with a license, select a Client from the first list and a License from the second list.   

3) Click the Associate button. 

Note:  Any clients not associated with a license will be removed from the configuration. (The associated database will not be removed; however but it will be inaccessible via Lucity.) 

Note:  Licenses are designated either as Production (PRD) or Non-Production (NPR). 

4) Once all installed clients have been associated with the appropriate licenses, click Next >. 
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INSTALLED LICENSES TAB 

The Installed Licenses tab lists all of an agency's installed clients.  Highlight a Client on the left to display the corresponding License Information 
on the right-hand side of the screen, along with tabs for each of that client's databases. 
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Installed Clients Lists all clients installed using a license from the license file.  Select a client in 
this list to display related configuration information in the section on the right. 

Uninstall Removes the configuration for the selected client.  The license that was used for 
that client reappears on the Available Licenses tab. 

Default Client Indicates which client various Lucity applications will open by default. 

License Information tab Displays details about the licenses tied to the selected client, including the 
number of seats available for each product contained within the license file. 

Database Information tab 
(on page 109) 

Provides configuration information about the database.  The information on this 
tab must be filled out correctly to connect to the database.  It will also vary 
depending on the type of database used.  

< Back Abandons configuration changes and returns the user to the Login screen. 

Next > Confirms the configuration and launches the Database Update process. 

 

Export Menu - This menu enables users to export the current configuration information, which can be useful when resolving an issue with Lucity 
Support.  The user may: 1) export the information, 2) export it and email it to Lucity Support, or 3) export and email it to Support along with the 
Client Maintenance logs. 

Note:  The exported configuration information will not contain any password information. 
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DATABASE INFORMATION TAB 

The Database Information tab, which contains configuration information about the Lucity database, is found on the Installed Licenses tab. 
 

  

The following information must be filled out correctly on the Database Information tab in order to connect to the database.  The information 
will vary will vary depending on the type of database used. 
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Application Information Identifies the version of Lucity being installed. 

Database Information Specifies the location of the database.  Only the items listed below can be 
modified.  The other items are listed for convenience. 

 Database Name Identifies the name of the database to which to connect.  This will most 
likely be Lucity. 

 Instance Name* Identifies the name of the SQL Server or Oracle Server instance. Host 
Name and Port are also required.  These fields apply only to SQL Server or 
Oracle databases. 

Desktop Gateway Login 
Information 

Governs how sensitive configuration information is stored and sent across the 
network. Learn more >> (see "Database Connection Encryption Options" on page 
124, http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm) 

 Active Directory Group for 

Gateway ** 

Specifies the active directory group to be used for the Gateway 
connection.  If there is no login for this group on the database Instance, 
the system creates one and grants the necessary permissions.  All Lucity 
users must log into Windows using a Windows account that is part of this 
group.  (This field appears only when the Integrated Security for Desktop 
Gateway option is set to True.)  

 Centrally Manage 

Desktop Gateway ** 

Indicates whether the unencrypted Gateway connection information 
should be stored in the Config folder of the Lucity share so that it can be 
accessed by all Lucity Desktop users.  If this field is set to False, the 
Gateway information must be manually set up on either the workstation 
or in the Config folder to allow Desktop users to connect to the database.  
Note that this is a global setting that affects all clients installed in a 
multi-client environment. 

http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm
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 Integrated Security for 

Desktop Gateway ** 

Indicates whether the Gateway Login should use integrated security (i.e., 
the Windows login of the current user).  When enabled, the Gateway 
uses Windows security settings to encrypt the data that it sends to SQL 
Server.  This fields defaults to True for SQL Server databases and False for 
Oracle databases, because Oracle requires the user's IT department to 
perform additional steps to set up integrated security.  

If the Centrally Manage Desktop Gateway field is set to True, Lucity 
recommends using integrated security because the connection 
information is stored in an unencrypted file.   

General Login Information Specifies the Login IDs/Passwords that various parts of the Lucity program should 
use to access the database. 

 .NET Login ID * Indicates the Login ID to use when applications that were developed using 
Microsoft .NET attempt to connect to the database .  This login 
information is retrieved via the Gateway Login account. 

 .NET Login Password * Indicates the Login Password  to use when applications that were 
developed using Microsoft .NET attempt to connect to the database .  
This login information is retrieved via the Gateway Login account. 

 Legacy Login Indicates the Login ID  to use when applications that were developed 
prior to Microsoft .NET attempt to connect to the database. 

 Legacy Login Password Indicates the Login Password to use when applications that were 
developed prior to Microsoft .NET attempt to connect to the database. 

Options Control other settings that are specific to the client. 

 Send Data Statistics to 
Lucity 

Indicates whether or not an agency wants its data statistics sent to Lucity. 
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Technical Information Provides technical data about the state of the database.  This information is 
read-only and provided for the the administrator's convenience. 

Technical Information - 
Custom Objects 

Lists the custom objects in each database; that is, those that are not part of 
Lucity's standard database.  These items also appear in the Custom Objects 
report used to prepare for the Database Unification process. 

Web Gateway Login 
Information 

Specifies the login/password that Lucity Web uses to access the database. 

 Gateway Login ID * Identifies the Login ID used to connect to the Lucity database.  If the 
Integrated Security for Desktop Gateway option is set to False, both the 
Lucity Web and Lucity Desktop applications will use this account. 

 Gateway Login Password 

* 

Indicates the Login Password to use to connect to the Lucity database.  If 
the Integrated Security for Desktop Gateway option is set to False, both 
the Lucity Web and Lucity Desktop applications will use this account. 

* These fields only appear on the User tab.   

* More information about Desktop Gateway settings >> (see "Database Connection Encryption Options" on page 124, 
http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm) 
 

http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm
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AVAILABLE LICENSES TAB 

The Available Licenses tab displays all unused licenses, allowing users to view license specifications and install licenses.  Select a license on the 
left to view relevant details on the right.  Licenses can also be installed from this screen. 

How To Install a License 

1) After Client Maintenance loads click the Available Licenses tab at the top of the screen. 
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2) On the left is a list of licenses that are available (stored in LicensesCodes.xml), but not currently installed.  Select a license on the left to 
view its properties in the window on the right. 

Note: Licenses marked PRD are for Production use.  Licenses marked NPR are meant to establish Test or Development environments. 

3) To install a license, highlight it in the window on the left and click the Install button.  The following window appears: 
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4) Provide a user-friendly name for the license and click Ok.  (For example, you could use the name of the agency or department that will use 
this license).    
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5) In the form that appears, enter connection information for the database. 

o Database Information - Specifies the location of the database(s). 

 Database Name - Enter the actual name of the database to connect to. 

 Database Platform - The system automatically completes this field based on the selected license file.  If the platform is incorrect, contact 
Lucity Support. 

 Instance Name -  Enter the name of the SQL Server or Oracle Server instance. 

o Desktop Gateway Login Information.  Settings that control how login information is passed to the database.  More information about 
Desktop Gateway settings >> (see "Database Connection Encryption Options" on page 124, 
http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm) 

o General Login Information - Indicate the login credentials the Lucity programs should use to connect to the database. 

 .NET Login ID - Enter the Login ID that any Lucity application developed with Microsoft.NET should use to connect to the database.  This 
login information is retrieved via the Gateway Login account.  

 .NET Login Password - Enter the Login Password that any Lucity application developed with Microsoft.NET should use to connect to the 
database.  This login information is retrieved via the Gateway Login account. 

Note:  The .NET credentials are persisted to the Lucity database.  

 Legacy Login - Enter the Login ID that any Lucity application not using .NET (older) should use to connect to the database. 

 Legacy Login Password - Enter the Login Password that any Lucity application not using .NET (older) should use to connect to the database. 

Note:  The Legacy credentials are persisted to GBALogin.mdb in the central CONFIG directory. 

o Web Gateway Login Information - Required for all clients, regardless of whether they use the Lucity Web applications.  Client 
Maintenance uses the information provided to generate a new SQL Server or Oracle account and assign permissions for it.  Changing 
the data in these fields (e.g., entering a new password) will update the information in SQL Server.  Clients who use the any of Lucity web 
applications, however, must also go to each of their virtual directories and make such changes there (or re-install the Web apps). 

http://help.lucity.com/webhelp/v170/install/index.htm#25355.htm
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 Gateway Login ID - Enter the Login ID required to connect to the GBAUser database to retrieve connection information for the Lucity 
databases.  If the Integrated Security for Desktop Gateway option is set to False, both Lucity Web and Lucity Desktop applications will use 
this account. 

 Gateway Login Password - Enter the Login Password required to connect to the GBAUser database to retrieve connection information for the 
Lucity databases.  If the Integrated Security for Desktop Gateway option is set to False, both Lucity Web and Lucity Desktop applications will 
use this account. 

Note:  The Gateway Login Password should be at least 8 characters in length. 

6) When all fields have been completed, click Next >.  

7) Click the Installed Licenses tab at the top of the tool. 

8) You should see your newly installed client in the list. 
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DATABASE UPDATE 

The Database Update screen shows a list of all the databases that are configured to work with Lucity clients.  Select a database in the list to 
view information about the database on the right. 

 



 

121 

 

 

 

< Back Returns to the previous screen. 

Update Runs the Database Update, which examines each client's database to 
ensure that it is on the latest version and service pack. 

Stop Stops an update that is currently in progress.  Note that this action does 
not stall the process on the current database; instead, it keeps the process 
from continuing to the next database. 

Finish >>| Closes Client Maintenance and saves all configuration settings. 

Email Errors to Lucity Emails any error messages that occurred during a Database Update 
directly to Lucity Support. 

 

How to run a database update 

The Database Update process is used to evaluate each database and perform any updates necessary to ensure that the software is current.  

Note:  This process is critical.  Please read the Database Update screen carefully. 
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1) Review the information displayed.  As a database is selected in the table, related information is displayed in the box on the right.   

o If the information appears to be correct, click Update, and the Database Update process will begin.   

o If the information is incorrect, click the < Back button.  The program will return to the Client Configuration screen, where the user may 
modify the setup. 
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2) If your database has not been backed up within the last 8 hours you will receive the following prompt.  If you have not backed up your 
database you should do so now. 

 

o Click Yes when you are ready to proceed with the update. 

3) As each database is processed, several status screens appear.  You'll also notice that the navigation buttons are disabled, and the Stop 
button is enabled.  Clicking Stop does not terminate processing of the current database; rather, it prevents any additional database 
processing after the current database is complete. 

The Database Status changes to OK when a database is processed without error.  If an error does occur: 

o an error message dialog appears,  

o the error is recorded in the Error Message column of the grid, and 

o an error log file is generated.   

When the Database Update process is complete, users can click the Email Errors to Lucity option to create an email message with the error 
and configuration information attached.  Be assured that no password information is stored in the configuration information sent to Lucity. 

4) Click the Finish >>| button when the entire Update process is complete to save the configuration information and exit Client Maintenance. 

Note:  If you click the Finish >>| button before clicking Update, the system will skip all database processing.  This is not recommended. 

5) The rest of the Server/Database installation will be completed. 
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DATABASE CONNECTION ENCRYPTION OPTIONS 

When Lucity programs connect to a SQL Server or Oracle database, they have to send login credentials.  Because these credentials are usually 
sent out over a network, there is a possibility they could be intercepted.   

Lucity provides several different options for managing and securing configuration information. 

Managing Database Connection Encryption 

The connection encryption can be managed using: 

 A centrally managed desktop gateway - Enables an administrator to make changes in a single location and automatically download those 
changes to each workstation.  (This is the default setting.) 

 Manual configuration - Requires an administrator to visit each machine to make changes to the database connection configuration.  This 
option can be more secure than using a centrally managed desktop gateway. 

 

Database Connection Encryption 

Once an agency has decided how to manage encryption, it can choose one of three methods for encrypting the connection credentials: 

1) Integrated security - Uses Windows authentication (through an active directory group) to encrypt and send connection credentials to the 
database. 

2) Unencrypted credentials - Give users access to a very limited set of stored procedures, rather than the entire database. 

3) Encrypted credentials - Requires an agency to set up encryption manually.  (This is the most secure method.) 

 

Management + Encryption Options 

The following matrix outlines each of the database types and the options for managing the deployment of these configurations: 

 Centrally Managed Manual Configuration 
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Integrated Security           X           X 

Unencrypted Configuration           X           X 

Encrypted Configuration            X 

Defaults 

 SQL Server - Centrally Managed, Integrated Security 

 Oracle - Centrally Managed, Unencrypted Configuration 

 

How to set up centrally managed integrated security 

1) While installing the client or reviewing the settings, look at the GBAUser database settings.   
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2) Make sure the Centrally Managed Desktop Gateway setting is set to True. 

3) Make sure the Integrated Security for Desktop Gateway setting is set to True. 

4) In the Active Directory Group for Gateway setting, enter an Active Directory group or click ... for a list of groups. 

5) Provide the Web Gateway login credentials in the Gateway Login ID and Gateway Login Password fields.  (This is used to generate the 
Gateway account; it is NOT saved in the Config folder.) 
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How to set up centrally managed unencrypted security 

1) While Installing the client or reviewing the settings, look at the GBAUser database settings. 
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2) Make sure the Centrally Managed Desktop Gateway setting is set to True. 

3) Make sure the Integrated Security for Desktop Gateway setting is set to False. 

4) Enter the Web Gateway login credentials in the Gateway Login ID and Gateway Login Password fields.  (This information is used to generate 
the Gateway account, which is then saved (unencrypted) in the Config folder.) 
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How to set up manually encrypted security 

1) While Installing the client or reviewing the settings, look at the GBAUser database settings. 
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2) Make sure the Centrally Managed Desktop Gateway setting is set to False. 

3) Make sure the Integrated Security for Desktop Gateway setting is set to False. 

4) Enter the Web Gateway login credentials in the Gateway Login ID and Gateway Login Password fields.  (This information is used to generate 
the Gateway account; it is NOT saved to the Config folder.) 

5) Configure each desktop manually using the Encryption tool provided.  Learn more >> (see "Encryption Tool" on page 134) 
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ENCRYPTION TOOL 

The Encryption tool is installed in the bin directory (\Lucity\bin\Lucity.EncryptConfigurations.exe) of any machine on which the Admin Tools 
were installed during the Lucity Desktop installation.  The Encryption tool is not deployed to all workstations by default.  To use the tool on 
other machines, Lucity recommends that an administrator:  

 copy the executable file locally to each workstation's bin folder; 

 use the program to configure and encrypt the connection strings; and  

 delete the program from the workstation when you are done using it. 

The primary purpose of the Encryption tool is to enable administrators to change the encrypted passwords in the configuration files of the Lucity 
web applications.  To use it there, copy the Lucity.EncryptConfigurations.exe and Lucity.EncryptConfigurations.exe.Config files to the root of the 
web application folder (the same folder that holds the connections.config file). Then run the tool from that folder.  

When running Lucity.EncryptConfigurations.exe for a Lucity web application, the contents of the Lucity.EncryptConfigurations.exe.config file 
should be:  

<?xml version="1.0"?> 
<configuration > 
<connectionStrings configSource="connections.config" /> 
</configuration> 
 

How To Use the Tool 
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1) Click Add New to add a connection string for a new client. (Each client will have only one connection string.) 
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o Indicate the Database Platform (SQL Server or Oracle), the Connection String, Instance, and Database Name. 

o Choose whether to use Login/Password or Integrated Security. 

2) Click Edit Selected to edit a Connection String for an existing client. 

o The Instance and Database Name are now editable. 

o Choose whether to use Login/Password or Integrated Security. 

3) Click Delete to remove a Connection String from an existing client. 

4) Click Test to validate the selected Connection String. 

5) Save any changes, electing to Save using no encryption or to Save using Machine Encryption. 
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NAVIGATION 

The Navigation section of the Lucity Administration tool enables administrators to create a set of menus in the Web application, giving users 
quick access to the Views and Forms they use regularly.   

Menus consist of Menu Groups that contain Views or Forms.  They appear under the Menu tab in Lucity Web.   

Note:  Users are only able to see particular menu items if they are in a group to which the View or Form is assigned (see "Assign Groups to 
Views/Forms" on page 317). 

Note:  Only Forms that have the Allow on Menu/Favorites Form Option (see "Form Options" on page 207) enabled can be added to a Menu. 
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TOOLS 

Menus Displays all Menus currently established within Lucity Web. 

Module Selection 
Drop-downs 

Enables the user to select a Program, a Module, and one of its Components to 
control which Views/Forms are displayed in the grid. 

Show All Views/Forms Overrides the module selection drop-downs and displays all unassigned Views 
and Forms for all modules. 

Show Program 
Views/Forms 

Displays all the View/Forms for all Modules and Components below the selected 
Program in the first drop-down. 

Views/Forms not assigned 
to menus 

Lists any Views and Forms that are not currently assigned to a Menu. 

Note: This list only shows Forms that have the Allow on Menu/Favorites form 

option (see "Form Options" on page 207) enabled. 

Refresh List Refreshes the Views/Forms not assigned to menus grid. 

  
Allows the user to move a View/Form back and forth between the Menus and 
Views/Forms not assigned to menus grids. 

  
Allows the user to move a View/Form up and down in the Menus grid. 

Delete Menu Group Deletes the selected Menu Group from the Menus grid. 

Create New Menu 
Group 

Creates a new Menu Group in the Menus grid.  After creating the Menu, click on 
it in the grid to rename it. 

Start Edit Enables users to modify the Menu. 

Save Saves all edits to the Menus and exits Edit mode. 

Cancel Cancels any edits and exits Edit mode. 
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How to add a new Menu Group 

1) At the bottom of the Menu Manger screen, click the Start Edit button (center). 

2) Click the Create New Menu Group button at the bottom of the screen.  A "New Group" listing appears in the left-hand grid. 

3) Right-click on the "New Group" listing and type a new name.  This is the name that will appear in Lucity Web's Menus grid. 

4) Use the up or down arrows to rearrange the Menu groups, if necessary.  The system moves any Views/Forms contained within those menu 
groups along with them. 

5) Click Save when finished. 

Note:  To delete a menu group, click the Start Edit button.  Then, highlight a group listing and select the Delete Menu Group button.  All 
Views/Forms within that menu group are removed from the menu and added to the Views/Forms not assigned to menus grid. 

How to add Views/Forms to a Menu 

The Forms appear on the right-hand side of the Menu Manager dialog. 

1) Click the Start Edit button. 

2) To add a View or Form to the Menu, highlight a menu group in the left-hand Menus grid. 

3) Then, highlight the View/Form to add to the Menu in the right-hand Views/Forms not assigned to menus grid. 

o Names in red are disabled.  These items can be assigned to Menus, but they will not appear on the web site until they have been 
enabled using Form Options (on page 207). 

o If a Form name does not appear in the list of available forms, it may need to be "allowed" on the menu.  This option must be turned on 
for Forms using the Form Options (on page 207).  

4) Use the left-arrow button to move the View/Form to the Menus grid. 
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5) To rearrange the Forms in the Menu, use the up or down arrows. 

6) To remove a form from a menu listing, use the right arrow button. 

7) Click Save when changes are complete. 

Note:  Templates cannot be added to Menus.  All Templates must be copied before they can be used.  For additional information on 
working with Templates, see the Form Templates topics. 
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SAMPLE MENU 

Below is a sample of a menu as it would appear on Lucity Web.  The Menu appears on the Open a View screen when you click the  button 
on.   
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FORMS 

The Lucity Web system allows administrators to create custom Views and Forms to be used online.  All Web modules are made up of three main 
components: Views, Grids, and Forms.  These components are described briefly below.   
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View Views control how data is structured or displayed on screen.  A View can either 
show all of the records in a single module or a limited set of records for a module, 
based on a preset filter.  Views can be launched from the Modules tab, the 
Menu tab, or from a Dashboard plugin. 

Each View contains one or more grids. 

Forms may be attached to Views to allow users to open individual records for 
more detailed information. 

Grids Grids display a list of records from the module for which the view has 
been built.  Each record displays a set of general information 
(customized by system administrators).  If a record contains child 
records, the record can be expanded to display the grid of related child 
records.  Attached to each grid is a toolbar that enables users to perform 
different operations. 

Example: A parent Work Order grid may contain child Resources, Tasks, and 

Tracking grids. 

Forms Forms display individual records and can be customized (by system 
administrators) to let users see record details or to edit a record.  Forms 
can be launched from a grid or a menu, depending on system settings.  
Forms are always launched in a separate pop-up window. 

The following sections display how to import new Views, Grids, and Forms, how to modify them, and how set them up for use. 

Remember:  Each component can be fully customized; the screenshots included in this help guide are only examples. 
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VIEW/FORM MANAGER 

The Form Manager allows administrators to create, edit, and delete views (see "View Builder" on page 161) and forms (see "Form Editor" on 
page 168), as well as perform certain other functions.   
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DISPLAY CONTROLS 

Module Selection 
Drop-downs 

Enables the user to select a Program, a Module, and one of its Components.  
Used to control which Views/Forms are displayed in the grid.  List of available 
Modules 

Show forms in preview 
mode checkbox 

Displays Forms that are currently in Preview Mode, allowing an administrator to 
delete any duplicates. 

While a form is being edited, the system saves it in Preview Mode.  Occasionally, 
duplicate forms are created if the program closes unexpectedly while a user is 
editing.  In these instances, administrators can clear the duplicate forms by: 

 Checking the Show forms in preview mode box. 

 After confirming that no other user is working on the duplicate form, 

selecting it and clicking Delete. 

Forms checkbox Displays Forms in the grid. 

Views checkbox Displays Views in the grid. 

FIELDS 

Name The name of the View or Form. 

Type Indicates whether the item is a View or Form. 

Enabled Indicates that the Form has been enabled (see "Form Options" on page 207).  
Only forms that have been enabled can be assigned to menus. 

Is Default View Indicates which View serves as the default or preferred View.  (There is only one 
default per module.) 

Assigned to Group Indicates that the View or Form has been assigned to a Group (see "Assign 
Groups to Views/Forms" on page 317). 
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Assigned to Menu Indicates that the View or Form has been assigned to a Menu (see "Navigation" 
on page 137). 

Public Form ID Shows the ID assigned when a Form is used as a Citizen Portal form. 

Alt. Menu Name Indicates the alternate name that is displayed when the View or Form is used on a 
Menu. 

Modified By, Last 
Modified Date 

Identifies the last user to modify a View/Form  and the date on which it was 
modified. 

Is Preview States whether the Form is currently saved in Preview Mode. 

Lucity Version Identifies the version of Lucity for which the View/Form was created. 

TOOLS 

New Creates a new View or Form record. 

Edit Opens the selected record in Edit Mode. 

Copy Duplicates the selected record. 

Delete Erases the selected record. 

Rename Allows the user to provide a new name for the selected record. 

Assign Group Opens up the Assigns Groups to Forms (see "Assign Groups to Views/Forms" on 
page 317) window. 

Import Templates... Enables users to import Template Views and Forms (see "Import Template 
Views/Forms" on page 239).  Users can also import templates from the Form 
menu. 

Enable Exporting Disables all of the previous tools (except for Assign Group) and enables the 

Export button. 

Export Exports (see "Exporting Views/Forms" on page 157) the currently selected record 
as an xml file, which can then be imported. 
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Note: Lucity provides pre-built forms that agencies can import (see "Import Template Views/Forms" on page 239). 

 

How To Add a View 

1) Use the Module Selection drop-downs at the top of the View/Form Manager to locate the module to which to add the View. 

2) Click the New button.  The following dialog appears: 

 

3) Select View. 
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4) Enter a Name for the view and click OK.  The View Builder (on page 161) opens: 

 

5) Modify the View as desired and Save. 

How To Add a Form 

1) Use the Module Selection drop-downs at the top of the View/Form Manager to find the module to which to add the Form. 
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2) Click the New button.  The following dialog appears: 

 

3) Select Form. 
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4) Enter a Name for the Form and click OK.  The Form Editor (on page 168) opens: 

 

5) Modify the Form as desired and Save. 
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How To Edit a View 

1) Use the Module Selection drop-downs at the top of the View/Form Manager to find the module with the View in need of editing. 

2) Select a View and click Edit.  The View Builder (on page 161) opens: 

 

3) Modify the View as desired and Save. 

 

How To Edit a Form 

1) Use the Module Selection drop-downs at the top of the View/Form Manager to find the module with the Form in need of editing. 
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2) Select a form record and click Edit.  The Form Editor (on page 168) opens: 

 

3) Modify the Form as desired and click Save. 
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How To Copy a Form 

1) Use the Module Selection drop-downs at the top of the View/Form Manager to find the module with the Form you would like to copy. 

2) Select a form and click Copy.  The following pop-up appears: 

 

3) Enter a name for the copied Form in the field provided. 

o Click Cancel Copy to cancel. 

o Click Edit Now to open the copy in the Form Editor (on page 168). 

o Click Save for Later to save the copy without editing it. 

How To Rename a View or Form 

How To Assign a Group 

1) Select a record in the grid in the View/Form Manager. 

2) Click Assign Group. 
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3) The Assign Groups to Views/Forms window opens with the View or Form selected. 

 

4) Select a Group on the left and click Assign Groups. 

5) Close the Assign Groups for Views/Forms window. 
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UNSUPPORTED MODULES 

The following modules are not yet supported by Lucity Web and must be accessed using Lucity Desktop.  Any module not listed here is 
supported in Lucity Web. 

Work 

 Work Asset Setup 

Sewer 

 Sewer Rehab 

o Rehab Projects 

o Model 

o Pipe Analysis Details 

o Rehab Work Tasks and Costs 

o Default Rehab Work Tasks 

o Material Types 

o Surface Types 

o Accessibility 
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EXPORTING VIEWS/FORMS 

Often users want to create Views and Forms in their test environment and then load them into their production environment.  At the 
bottom-right of the View/Form Manager there is an Enable Exporting checkbox and an Export button.  These functions let users export Views 
and Forms created in one Lucity client and import them to another. 
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How To Export Views/Forms 

1) Check the Enable Exporting box at the bottom right-hand corner of the screen.  Doing so will disable most other buttons. 

2) Choose one or more Views/Forms to export and select Export. The following window appears: 

 

3) Browse to the location to which to save the export. 
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4) Name the export file, and select Save.  One .xml file will be saved at that location.  That file will contain all of the Views/Forms that were 
selected in the View/Form Manager. 

Note: See the Import from XML (see "Import Template Views/Forms" on page 239) topic to learn how to import a Grid or View. 

Note: If another View is attached to the View being exported, only the name of the attached View will be carried over when the original 
View is imported.  To include everything that is attached to the View you are exporting, export the attached Views first, then export the 
original View. When the attached Views are imported, they will be linked to the original export because of their shared name. 
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VIEW BUILDER 

Views are used to create the structure for modules within Lucity Web.  A View controls which records are displayed for a module and then 
displays them in the module's related grid.   

When a record in a grid has child records, the children are displayed in child grids.  Because Views control what data are displayed, they also 
control which child grids are displayed. 

The View Builder is used to: 

 set up a View,  

 assign which levels of data are displayed, and  

 determine which Grid or Form is used to display each level of data.  
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View name Describes the data that the View displays or its purpose.  Lucity Web displays 
this name unless an Alternate View Name is provided. 

Alternate View Name Serves as an alias for the view.  When a name is provided in this field, it is 
displayed as the View name in Lucity Web. 

Step 1: Select a Grid Type Enables administrators to choose which child grid types are displayed in the View 
and the order in which they should appear.  Check a box to make that grid type 
appear in the View.  Select a grid type to change the related grid and Form. 

Step 2: Select a Grid Enables the user to choose a Grid from the Grid Manager to use for the Grid Type 
selected on the left. 

 New Grid Creates a Grid in the Grid Builder (on page 229). 

 Edit Grid Opens related grid in the Grid Builder (on page 229) for editing. 

Step 3: Select a Form to 
Grid (optional) 

Enables the user to choose a Form from the View/Form Manager to use for the 
Grid Type selected on the left. 

 New Form Opens the New Form dialog. 

 Edit Form Opens the Form in the Form Editor. 

 Preview Displays the selected form as it will appear online. 
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Offline Mobile Indicates that this View should be available to mobile users when they are offline.   

o Views will automatically be considered offline if they are linked to 
a dashboard plugin that is in a dashbaord frame marked as offline. 

This is the default view for 
.... 

Indicates that the current view should serve as the default view for the module.  
Any time a tool within Lucity Web accesses a module, it opens that module using 
the default View (unless otherwise specified). 

Note: There can only be one Default View for a module, and every module must 

have a Default View. 

Save Saves all changes made to the View. 

Cancel Cancels edits to the View. 

 
 

SELECTING GRID TYPES TO DISPLAY 

The first step in creating a View is to select which child record grids will appear as part of the view.  These child records are will determine what 
grids and forms need to be created. 

1) Under Step 1: Select a Grid Type, review the tree of child record grids available for the current module. This list is determined by the type of 
View selected in the View/Form Manager (on page 145). 

2) Mark the checkboxes for each child record grid you wish to add to the View.  These selected grid types establish the overall structure of the 
Web View.   
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Example: The example below shows a Work Order Entry Form.  It includes the main parent grid for the Work Order module, as well as child 
grids for Work Order Locations, Work Order Tasks, and Work Order Assets.  The Task grid has children, as well: Employees, Materials, and 
Fluids. 

 

3) To change the order in which the child record grid types appear, select a child record grid type and then use the up and down arrows on the 
left side of the screen to change its position in the list. 

Note: The View cannot be saved until Step 2: Select a Grid is completed for each Grid Type checked. 
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SELECTING GRIDS 

The second step in creating a View is to decide which Grid each Grid Type will display. 

1) Before a View can be saved, the user must select a Grid for each Grid Type selected in Step 1: Select a Grid Type. 
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2) Highlight a selected Grid Type on the left (under Step 1: Select a Grid Type). 

3) Under Step 2: Select a Grid, use the drop-down box to select an existing Grid from the Grid Manager. 

OR 

4) Click the New Grid button to create a new Grid.  More Information about creating new Grids (see "Grid Manager" on page 220) 

5) Repeat steps 2 and 3 above for every Grid Type checked on the left. 

6) Save the View. 
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ADDING FORMS TO GRIDS 

The final (optional) step in creating a View is to decide whether to associate a Form with the Grid.  A Form enables users to see more detailed 
information about the records in the View or to edit the records in the View.   

Again, this is an optional step.  However, if it is not completed, users cannot open individual records. 

1) Highlight a Grid Type on the left (under Step 1: Select a Grid Type). 

 

2) Under Step 3: Select a Form for Grid (optional) use the drop-down box to select an existing Form from the View/Form Manager. 

OR 

3) Click the New Form button to create a new Form.  More Information about creating Forms (see "Form Editor" on page 168) 

4) Save the View. 
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FORM EDITOR 

The Form Editor lets administrators control exactly which fields appear on a Form, where those fields are placed, and how those fields act.  This 
is a WYSIWYG (What You See Is What You Get) editor; that is, the preview displayed here shows how the form will be displayed when viewed 
through Lucity Web. 
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Toolbar Contains tools for adding different Form components and for controlling 
certain aspects of the Form's behavior. 

Form Details Lists all Form components.  Also controls the properties of Form fields 
(e.g., read-only, editable). 

Form Preview Shows how the Form will appear in Lucity Web and enables users to move 
around Form components. 

 

How to change the View 

How to save a Form 

 Select Form > Save to save all modifications to the Form and continue working. 

OR 

 Select Form > Save and Close to save all modifications to the form and close the Detailed Form Editor. 

OR 

 Click the button on the toolbar. 

OR 
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 Click the  in the corner of the Form Editor.  The following pop-up appears: 

 

 Click Save Changes.  This action will save all modifications to the Form and close the Editor. 

  

Note:  Once the Form is saved using one of the options above, it appears in the Form Manager (see "View/Form Manager" on page 145).  
The Form can then be edited as needed. 

  

Important:  Saving a form clears the web cache.  This ensures that any changes made to existing forms will be immediately available to end users; 
however, if a form is actively in use when it is saved, users will receive an error message and the changes they are making will be lost.  Users will need to 
close their browsers and restart Lucity Web in order to access the newly saved form.  We recommend that existing forms not be changed at a time when 
they may be in use. 

 

How to abandon changes and close 

 Select Form > Close from the Detailed Form Editor menu, 

OR 
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 Click the  in the corner of the Form Editor.  The following dialog appears: 

 

 Select Abandon Changes, and the Form will close without being saved. 

 
 

FORM EDITOR TOOLBAR 
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The Form Editor Toolbar provides all of the tools necessary to customize a Form.   

More information on how to use these tools (see "How To" on page 210) 

BUTTO
N 

NAME DESCRIPTION 

 Show/Hide Form Details Displays/hides the list of fields and components currently on the Form as 
well as the properties for the selected field or component. 

 Save Saves the Form. 

 Add Fields Displays a list of fields to choose from, then adds the selected field to the 
Form.  Fields display attribute data from the module. 

 Insert Label Adds a Label component to the form, which provides a means for directly 
adding text or notes to the Form.  Labels also give users the ability to 
embed hyperlinks into the Form. 

 Add Divider Adds a horizontal line that visually divides the Form. 

 Insert Frame Adds a a boxed section to the Form.  Frames are used to group similar 
fields.  When a frame is moved, all of its components move with it. 

 Insert Behavior Adds a Behavior component to the form, which can be used to add a 
Remember Me or Use Requestor's Address checkbox. 

Note:  This option is only available on Request submittal forms. 

 Tab Order Changes the order in which Form fields are selected when users press the 
keyboard's Tab button. 

 File Upload Lets the Form designer upload dialog boxes to a Citizen Request Form.  
Dialog boxes allow citizens to attach a file to the record and upload it to 
the server. 

 Remove Removes the selected component from the Form. 

 Refresh Refreshes the form display, applying any changes made since the last 



 

174 

 

 

refresh.  If the AutoRefresh feature is turned on (found under the View 
menu), the Form refreshes automatically each time a change is made. 

 Carry Over Toggles the Carry Over buttons on in the Form Editor.  This function 

simply shows where they are so that the Form designer can adjust the 
fields accordingly. 
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FORM DETAILS 

The Form Details window has two parts: The top lists all components (fields, etc.) currently employed on the Form; the bottom displays the 
properties of the the selected components and allows users to edit them. 
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Top Pane 

The top half of the Details window lists all fields and components currently included on the form in the order in which they appear.   

 As the location of components change in the Form Preview the list order changes automatically. 

 Selecting a component in the list also selects it in the Form Preview.  Likewise, when a user selects an item in the Preview, the same item is selected in the 
list. 

 Selected components are highlighted in bright green (in the Preview). 

Bottom Pane 

As components are selected, the Properties grid at the bottom of the screen displays the current component's properties.  Within this grid, users can make 
fields read-only or required, insert a default value, re-label components, set sizes, etc. (Definitions are provided for all available properties (see "Component 
Property Definitions" on page 177).)   

Consider the following when making changes: 

o Default Values - If a default value is designated in the Desktop application, it will NOT appear in the properties dialog; however, if no 
default value is entered here, the default value from the Desktop application appears on the web form when it is run.  Any default 
values entered here do not affect the Desktop application. 

o Required Fields - If a field is required on a Web form, it does not affect the Desktop application; however, if a field is required in the 
Desktop application, the Lucity Administration for Web Apps tool will add it to the Web form as a required field.  Required fields are 
identified with an asterisk (*) and a different background color.  An error message appears if users attempt to submit a form without 
data in a required field. 

o Pick Lists - When a pick-list field is included on the Form, administrators must use the Control Type property to indicate the type of data 
the field will accept.  These include a Dropdown, Dual Dropdown, or Code field that can be typed in with a lookup button. 

Note: Changes made to each component's properties appear automatically in the Form Preview.  
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COMPONENT PROPERTY DEFINITIONS 

When you click on each component's property, a description of that property appears below the grid as a quick reference.  The table below 
describes the various field properties available. 

COMPONENT PROPERTY DEFINITION 

Behavior Item Establishes the default behavior for the component, which is limited to two 
options: 

 Save Requestor Cookie - Adds a Remember Me checkbox to the form, which, 
when enabled, saves the requester's name, address, and contact information 
for future use. 

 Use Requestor Address - Adds a Use Requester Address checkbox to the 
form, which, when enabled, carries the requester address over to the 
Location Address fields on the form. 

Note:  The Behavior feature is only available on Request Submittal forms. 

Caption for Asset Identifies the descriptive text that appears above the field when the Asset is 
selected on-screen. 

Caption for Type Identifies the the descriptive text that appears above the field when the Asset 
Type is selected on the screen. 

Component Height Controls the height of the field (in pixels) as it appears on the screen. 

Component Type Indicates the type of component in the field (for informational purposes only). 

Component Width Controls the width of the field (in pixels) as it appears on the screen. 
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Control Type Defines how code-description fields are displayed on-screen.  Components can 
be displayed as one of the following:  

 Combo box - A series of boxes used to select Assets.  Sewer pipes and storm 
conduits have dual combo boxes. 

 Drop-Down List - Lets users select text in the description field. 

 Dual Drop-Down List - Lets users select the code or description field. 

 Dual Textbox - Lets users manually enter a code or select the code/type from 
a pop-up list. 

 Textbox Control - Lets users manually enter data, which the system then 
validates when the user exits the field. 

Note:  The type of component in the field determines which Control Types are 

available; however, for almost every type of component, at least one option 
displays both the codes and types field information so that the user can select a 
specific item when the type information is the same for two different codes.  
The single drop-down items are intended for use if you do not have duplicate 
items in your list.  If you do have duplicate items, such as two problems with the 
same type but different codes, then you should select the control type that will 
display both the code and the type. 

Carry Over Enables/disables the green Carry Over button for the selected field.  To 

prevent users from seeing Carry Over buttons throughout the entire form, the 

grid the form is attached to must be edited to hide the Display Carry Over 
Buttons button.  More details (see "Managing Buttons" on page 234) 

Note: Fields marked as read-only never display the Carry Over button in Lucity 

Web, even if this option is enabled. 

Default Asset Determines which Asset will automatically appear in this field when a new record 
is created.  Unless the field is marked as read-only, the user can overwrite the 
default before submitting the form. 
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Default or Default Value Determines what value will automatically appear in this field when a new record 
is created.  Unless the field is marked as read-only, the user can overwrite the 
default before submitting the form. 

Default Date Time Establishes a date or time to be used when a new record is created.  Unless the 
field is marked as read-only, the user can overwrite the default before submitting 
the form. 

Default Now When enabled, uses the current date or time as the default when a new record is 
created.  Unless the field is marked as read-only, the user can overwrite the 
default before submitting the form. 

Default Location Identifies the initial placement of the frame (for reference only). 

Default Type Indicates which Asset Type automatically appears when a new record is created.  
Unless the field is marked as read-only, the user can overwrite the default before 
submitting the form. 

Facility Option Determines how a control that selects asset records from various modules 
displays Facility Asset Types on-screen: 

 Standard List: Makes no change to what Facility assets the user can select. 

o After the user has selected the type of asset they are given a list of 
all assets of that type. 

 Building-Driven List:  Controls what Facility assets the user can select 
filtered down by Building. 

o If the user selects Roof, Room, Furnishing, Floor, or Door as the 
Asset Type, then the user is required to select a Building.   

o The user is then given a list of assets of the selected type that are 
related to the selected building. 

 Site-Driven List:  Controls what Facility assets the user can select filtered 
down by Site and Building. 
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o If the user selects Building as the Asset Type, then the user is 
required to select a Site and then select an associated Building. 

o   If the user selects Roof, Room, Furnishing, Floor, or Door as the 
Asset Type, then the user is required to select a Site, then select a 
Building. 

o The user is then given a list of assets of the selected type that are 
related to the selected building and/or site. 
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Fields Table ID Displays the Field ID from the *FIELDS table (for informational purposes only). 

Force Association Work Flow pop-ups, such as those used to identify the Problem and Cause, are 
"force-associated" with Categories.  Therefore, only the Problems (or Causes, 
etc.) that are associated with the Category may be selected by the user.  

However, if a Show All function is available, users can choose Problems or 

Causes that are not associated with the Category. 

 If Force Association is set to True, the Show All option will not be available; 

only the forced association categories will appear. 

 If Force Association is set to False, the Show All option will be available only 

to users with the "Show All Enabled" permission in Security.exe. 

Note:  The Show All option is available only if the ControlType is set to "Dual 

Textbox." 

Caution:  If a Category does not have Problems, Causes, etc. associated with it, 
or, if a Problem identifies a default Supervisor who is not also associated with the 
Category, users without "Show Enabled" permissions will be unable to complete 
the web form if the Problem, Cause, or Supervisor field is required.   

These associations and defaults are established in the Lucity Desktop application, 
under Work Flow Setup.  We recommend thoroughly testing all forms before 
implementing their use.  

Hidden Indicates whether the field is hidden. 

Hidden Asset Hides the drop-down list for selecting specific Assets. 

Hidden Type Hides the drop-down list for a Code Type field. 

Label Specifies the text that appears above a field (other than Asset or Asset Type 
fields). 

Label for Asset Specifies the text that appears above the field used to select an Asset. 

Label for Type Specifies the text that appears above the field used to select an Asset Type. 



 

182 

 

 

Limit List Limits a pick list to the items specified. When set to True, a button appears on the 
form, allowing you to select the items to make available to users.  

More information on using the Limit List (see "Using the Limit List" on page 191) 

Limit Type Allows only certain asset types to be entered on the form. 

Location Indicates the location of the component on the screen.  This value is 
automatically updated as the user drags and drops components in the WYSIWYG 
editor. 

Max Value Sets a limit for the largest value a user may enter in this field.  Leave this field 
blank to provide for no upper limit. 

Min Value Sets a limit for the smallest value a user may enter in this field.  Leave this field 
blank to provide for no lower limit. 

Park Option Determines how a control that selects asset records from various modules 
displays Park Asset Types on-screen: 

 Standard List: Makes no change to what Park assets the user can select. 

o After the user has selected the type of asset they are given a list of 
all assets of that type. 

 Park Driven List:  Controls what Park assets the user can select filtered 
down by Park. 

o If the user selects Park Furniture, Court, Field, Structure, 
Playground Equipment, Parking Lot, Path, Landscape Area, 
Irrigation Controller, or Irrigation Valve as the Asset Type, then 
the user is required to select a Park.   

o The user is then given a list of assets of the selected type that are 
related to the selected park. 

Property Name Identifies the property associated with this field.  This relationship helps 
third-party developers correlate form data with the properties available in the 
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back-end. 

Read Only Designates the field as read-only, which prevents the user from entering data. 

Required Forces the user to enter information in this field in order to submit the form. 

Note:  The Required property for the Category field is "True" by default.  For 

all other fields, the Required property is "False" by default.   

Shaded Indicates whether a frame appears shaded on-screen. 

 
 

PICK-LIST FIELDS 

Pick-lists allow users to select a value from a predefined list.  Lucity pick-lists often consist of two fields: One contains a Code and the other a 
Description or Type.  Sometimes the available values are carried over from another module (e.g., assets lists, resource options, locations, etc.). 

Example 
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Codes 

 Numeric - These pick-lists only allow a number in the Code field. 

 Alphanumeric - These pick-lists allow a mix of numbers and letters in the Code field. 

Selectable Values 

The values users can select in pick-lists come from one of two sources: 

 User-defined pick-list - These pick-lists often track an attribute.  The values available in these pick-lists are established by the agency using 
Lucity. 

 Module-defined pick-list - These pick-lists are used to select a record from another module in the Lucity system.  The values available in 
these pick-lists are automatically populated using data from the related module. 

Pick-list Appearance 

 Single drop-down boxes - A single box that shows both the Code and Description together. 

 

 Dual drop-down boxes - Separate boxes for the Code and Description.  When the user makes a selection in one field, the system 
automatically completes the other field. 

 

 Text control boxes - An empty text box for the Code and a pick-list button for the Description.  Enter the Code and exit the field to 
automatically populate the Description field, or, click the pop-up button. 
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If a user enters invalid data into a pick-list field, an error message appears.  

How to use a pop-up pick-list 

 

1) Click on the Pick List button  to the right of the field.  The following pop-up appears: 

 

2) To filter for specific data in the pick lists, type the filter criteria in the blank fields at the top of the screen, then click the Filter button.  The 
system narrows down the available selections by the criteria entered.   

o The filter searches for data that either starts with or contains the value entered (depending on system settings).  For example, if the 
user enters "Main" in the Street Name column, the filter finds the first Street record that starts with "Main."   

o Enter "%[criteria]" to search a field for that criteria anywhere in the field.   

3) Click on the First, Previous, Next or Last buttons to move through multiple pages of options. 
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4) Highlight a Street listing and click Select.  The highlighted street is added to the pick list field on the form. 

 

How to edit a pick-list 

Click in a picklist field. 

1) Press Shift + F9. 

o If the picklist can be edited, a message appears in the bottom-left-hand corner of the screen. 

2) The following dialog box appears: 

 

3) Sort the columns by clicking on the Code or Type headings. 

4) Click in either the Code or Type field and enter the desired value. 
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Note: Picklist options listed in gray are hard-coded and cannot be edited. 

Note: Codes have to be unique; Types do not. 

5) Click Complete to leave the dialog or Select to use the selected option to fill out the form field and leave the dialog. 

 Requires the Popup Lists - Edit permission for the related module. 

How to add a pick-list item 

1) Click in a pick list field. 

2) Press Shift + F9.  The following dialog appears: 

o If the pick list can be edited, a message will appear in the bottom-left-hand corner of the screen. 
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3) Click the Add button.  The following pop-up appears: 

 

4) Enter the desired value. 

Note: Codes must be unique; Types do not. 

5) Mark the Keep add dialog open box to continue to add pick list options. 

6) Click Ok to close the Add dialog. 

7) Click Complete to leave the Add pick list dialog or Select to use the selected option to fill out the form field and leave the dialog. 

 Requires the Popup Lists - Edit and Popup Lists - Add permissions for the related module. 

 

How to delete a pick-list item 

1) Click in a pick list field. 
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2) Press Shift + F9.  The following dialog appears: 

o If the pick list can be edited, a message appears in the bottom-left-hand corner of the screen. 

3)  

 

4) Click on the words Code or Type to sort the columns. 

5) Select a pick list item. 
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6) Click the Delete button.  The following pop-up appears: 

 

7) Mark the Dont show this again box to hide this prompt for future deletions.  Marking this box will hide this prompt for all pick lists on the 
form. 

8) Click Yes to complete the deletion. 

Note: Picklist options listed in gray are hard-coded and cannot be deleted. 

9) Click Complete to leave the dialog or Select to use the selected option to fill out the form field and leave the dialog. 
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 Requires the Popup Lists - Edit and Popup Lists - Delete permissions for the related module. 

 

USING THE LIMIT LIST 

The Limit List feature allows users to limit the options available in a pick list on a specific Form.  This list is limited to certain items.   

Within Lucity, there are two types of pick lists: the standard pick list, which is based on a set list of options; and the asset-selection pick list, 
which requires the user to first select a Module from which to display Assets.   

The process of creating Limit Lists for each type of pick list differs slightly: 

How to limit a standard pick list  

1) Add a field that can be limited to the Form.  This includes Problem, Category, Affected Asset, etc. 
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2) In the Properties grid, click on the LimitList property and select True.  The Limit List button is now enabled.  

 

3) Click on the Limit List button to access the Limit List Form.  The Limit List Collection grid displays the code and description for each item 
available.   
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4) Highlight one or more selections in the left-hand grid and add them to the right-hand grid.  The items in the Limit List will be the only ones 
accessible to users of the Web Form. 

 

5) After making selections, click Save. 



 

194 

 

 

How to limit an asset-selection pick list  

Asset selection pick-lists only appear on the Work Order Assets form.  Therefore, this type of Limit List is useful to create a Form in which only 
one type of Asset can be selected. 

1) Add the Asset Rec # field to the Form. 

2) In the Properties grid, click in the Default Type property and choose the Module from which users will be able to select Assets. 

3) Then, click on the LimitAsset property and select True.  The Limit List button is enabled. 

 

4) Click on the Limit List button to access the Limit List form.  The Limit List Collection grid displays the code for each Asset in the selected 
Module.   
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5) Highlight one or more selections from the left-hand grid and add them to the right-hand grid.  The items added to the Limit List will be the 
only ones accessible to users of the Web Form. 

 

6) After making selections, click Save. 
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FORM PREVIEW 

The Form Preview is where most Form editing takes place.  Within this window, users can select components to edit properties, move 
components, change labels, and test field functionality (in a limited manner). 
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198 

 

 

FORM COMPONENTS 

Fields Displays the list of available fields to choose from, then adds the selected field to 
the form.  Fields display attribute data from the module. 

Label Adds a label component to the form.  Labels are a way to add text or notes 
within the form itself. 

Divider Adds a horizontal line that visually breaks up the form. 

Frame Adds a a boxed section to the form.  Frames are used to group similar fields.  
When a designer moves a frame, its components move with it. 

Behavior Adds a behavior component to the form.  A "Remember Me" checkbox or a "Use 
Requestor's Address" checkbox are examples of behavior components. 

Note:  This option is available only on Request submittal forms. 

File Upload Allows the designer to include upload dialog boxes in the form.  Upload boxes 
let users attach a file to the record and upload it to the server. 

Spacial Function Field Indicates that special functions are available for a field.  These buttons are 
automatically added.  Click on the button to see the functionality available.  
Examples of special functions (see "Special Field functions" on page 199) 

 

EDITING TOOLS 

Component Handle Enables users to control the position of a component in the Form Preview.  
Appear as solid dark circles at the corner of the component.  Click the control 
and drag it to move the field, label, etc. to the desired location. 

Selected Field Indicates that a field or other component is selected.  The field appears 
highlighted in bright green. 
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SPECIAL FIELD FUNCTIONS 

Task Dates 

If the Enforce Task Start Date = End Date option is enabled in the Work module, only one Date field will appear on the Task forms. 

 

 Knowledge Base button 

Depending on an agency's Work Flow Setup in Lucity Desktop, some Problems found on Request submittal forms may be associated with 
Knowledge Base entries.  When a user selects one of these Problems on the form, the Knowledge Base window appears.  Click OK to close the 

Knowledge Base dialog.  To view this information again, simply click the  button on the form. 
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 Scripts button 

Depending on an agency's Work Flow Setup in Lucity Desktop, some Problems found on Request submittal forms may have an associated Script.  
When users select one of these Problems on the form, the Scripts window appears.  This window allows users to enter a response to each Script 

in a large text box.  Click OK to close the Scripts dialog.  To view this information again, simply click the  button on the form.   

 

 

Parts Integration 

Depending on an agency's Lucity Desktop settings, the Warehouse Parts Inventory module can be integrated with the Work module to provide 
optimal inventory management.  This integration enables an agency to disperse parts from warehouse locations for use on Work Orders.  To 
use this feature, an agency must complete the Parts Inventory Integration Setup in the Desktop application.   

The basic steps are listed briefly below.  Please see the Lucity Help guide for complete details on the Parts Integration Options and dispersal process. 

1) Include a Work Material or Fluid code for each inventory Part to be used on Work Orders (in the Desktop's Parts Inventory module). 

2) Set the "Integrate Work and Parts Inventory" Parts Integration Option to Yes (in the desktop, Administration>>Work Options module).  
Set the other integration options relating to mobile warehouses and default locations as desired. 
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3) In Lucity Administration for Web Apps, clear the web cache.  Doing so will apply the changes made in the Integration Setup to the web 
forms.   

4) On the Web Work Order forms, select a Part from inventory. 

5) Indicate the number of units to be used on the Work Order. 

6) Save the Web Work Order form.  If a mobile warehouse is attached to the work order, the parts will be dispersed from that location.  
Alternatively, if no mobile warehouse exists, but a default warehouse location has been assigned in the Parts Inventory, the parts will be 
dispersed from the default warehouse.  If there is neither an attached mobile warehouse nor a default warehouse location, the dialog box 
below will appear.  This screen allows the user to select where the inventory items are pulled from. 

 

7) The dialog indicates the number of units needed to complete the Work Order.  Enter the part quantity selected from each available 
warehouse.  The total quantity selected will appear in the Supplied field.  The value in the Supplied field must match that in the Needed 
field before the OK button will be enabled. 

8) Click OK.  The parts will automatically be dispersed from inventory. 
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Partial Defaulting Example 

Using the Financial Integration options available in Lucity Desktop, an agency can enable partial defaulting for Account Numbers and Project 
Numbers on Lucity Web forms. 

The basic steps are listed briefly below.  Please see the the Lucity Help guide for complete details on Partial Defaulting and Work Flow Setup. 

1) In Lucity Desktop's Administration>>Work Options module, turn on the options for Use Partial Defaulting for Accounts and Use Partial 
Defaulting for Project Numbers. 

Note:  These options can be used with or without Eden Financial integration. 

2) In the Desktop's Work Flow Setup modules for Categories and Tasks, enter the applicable Account Numbers and/or Project Number - Account. 

3) In the Lucity Administration for Web Apps, clear the web cache.  Doing so will apply the changes made in the Work Options to the web 
forms. 

Then, when the Category or Task is selected on the Web form, the system will automatically carry over the corresponding numbers with no other 
input from the user (example below). 
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Financial Integration Example 

If your Lucity Desktop application is integrated with Eden Financial systems, you can select Eden account numbers on the Work Order forms. 

The basic steps required in the Lucity Administration for Web Apps are listed briefly below.  Complete instructions for applying the Eden InForum Gold 
Integration to the Desktop application are found in the Lucity Help Guide.  The web cache must be cleared before any changes to the integration setup will 
take effect in the Web forms.   

1) In Lucity Administration for Web Apps, add the Account Number and Project Number component types to the Work Order forms. 
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2) Eden account and project numbers are comprised of multiple levels or segments.  Lucity Web users will be able to click the button  
beside the fields to access the Segment selection dialogs. 

 

3) Users can then click on the Segment 1, Segment 2, and Segment 3 buttons to select from lists of pre-existing Account and Project Numbers. 
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Work Order Location Fields 

The Work Order form has a special set of location fields (Address, Street Name, Street Name 2).  These fields let users add location data to a 
Work Order without going to the Location grid to add a Location record.  When the user fills these fields and and saves the record, the system 
creates a record in the Location grid using these values.  If the Work Order form is edited and these location fields are changed, the original 
location is retained, and the new address is added as another record in the Work Order Location grid. 

 

Note: The location fields always display information for the first location listed on the Work Order, even if the user added several locations. 

 

File Uploads 

When the File Upload control is added to a Citizen Request form, citizens can click the Choose File button (example below) to browse to a file of 
their choice. 
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Sign Images 

A Picture File field can be added to Sign Inventory and Sign Library forms to display images of a sign on the form. 

Note: Before this field will work the sign images must be copied from the ...\Pict\SignLib folder that is installed during the Lucity Server 
install(in the Lucity share) to the web server in the inetpub/wwwroot/LucityWeb\images\signlib folder. 

 

Intersection Images 

A Diagram field can be added to the Intersection Inventory form to show what the intersection looks like. 
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FORM OPTIONS 

The Form Options dialog provides administrators with some general form controls.  Each of the available form options are defined in the table 
below.   

OPTION USE/PURPOSE 

Alternate Menu Name Indicates that an alternate name or alias should be used as the Form's title at the 
top of the form, in the menu and on the Web site.  

Enable Form Makes the Form accessible to users in the Lucity Web application.   

Note:  All forms, whether they are associated with parent or child records, 

must be enabled to be used on the Web application. 

Captcha enabled Adds a Captcha code similar to the one below to the Request web form.  
Users must type the code as it appears to submit their request. 

 

Using Captcha codes can reduce some of the spam requests that might otherwise 
be submitted through a Web form.  

Show Submit Button Controls whether the Submit button appears on a Citizen Portal form.  This 

option should be enabled in most cases. 

Show Create Work Order 
Button 

Adds a Create Work Order button to internal Request forms, which enables 

users to quickly enter a Request, save it, and create a related Work Order . 

Show Additional Emails 
Textbox 

Adds extra Email Address fields to Citizen Portal forms so that a requester can 
send the Create Request Email to more than one address. 
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Use Information From 
Employee 

Uses information from the employee's Lucity Employee record (Work > Work 
Flow Setup > Employees) to populate fields when the employee is completing an 
internal Request..   

Citizen ID Makes a form accessible to the Citizen Portal product.  This field is used to link 
an external site to a form.   

This feature can also be implemented on intranet site to accommodate agency 
users that do not have a Lucity login ID. 

 Enter a unique, alphanumeric ID using uppercase letters and numbers only 
(e.g., XYZ123, CITIZEN1).  Do not use any symbols (*, #, %. etc.).  This ID is 
used as part of the URL for the Citizen Portal form.  More information on 
setting up Citizen Portal (see "Create Request Forms" on page 478). 

Note:  In order for citizens to use public web forms, several security permissions 

must be enabled.  See the Group Assignment topic for additional information.   

Note: To make public web forms available to internal users, mark the Allow on 

Menu checkbox.  Administrators can then add the form to menus and assign 
groups (see "Assign Groups to Views/Forms" on page 317) to it.  To make a 
form only accessible to public citizens, do not check Allow to Menu. 

Client Version Number Indicates the version number that the client is currently using. 

How To Access and Use the Form Options 

1) In a Form, select Form > Options from the menu at the top of the Form Editor.  The following dialog box appears: 
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2) Enable/disable options as desired. 

3) Click OK to save the changes. 
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HOW TO 

This section explains how to accomplish common tasks when editing a form. 

How to show/hide the Form Details 

 To toggle between showing and hiding the Form Details, click the  button on the toolbar. 

How to add a field 

1) Click the  button on the toolbar.  The list of available fields appears.   

o The fields available depend on which program, module, and component was selected in the Form Manager.   

o If the default field names have been changed in the Desktop, the custom names appear in this list.   

2) Select one or more fields in the list. 

o Each field can be added to a form only once; any field already added to the form will not appear in this list. 

o When a field is highlighted, a brief description appears at the bottom of the dialog.  The description displays the field Name, Component 
Type, and default Lucity Caption. 

o Note: Click the FieldNames or Captions button to toggle how fields are identified in the list. 
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3) Click the OK button to close the list of fields and add the selected fields to the Form Preview. 

 
The system places the fields on the form in the order in which they were selected.   

Note:  If secured fields have been added to a form (e.g., Employee's hourly rates), only users with rights to view secured fields will see 
them.  These rights are granted in the Security.exe.  
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Note:  Fields that are required in the Desktop application (such as Category on Work Orders) will be forced onto the Web form by the 
Lucity Administration for Web Apps.  Such fields cannot be removed; however, they can be hidden using the Component Property (see 
"Component Property Definitions" on page 177) settings. 

Several types of fields have additional special functions (knowledge base, scripts, etc.).  These fields are described in the following topics.  

How to insert a label/hyperlink 

1) Click the  button.  A component called Change My Text appears in the Form Preview.  

 

2) Double-click on Change My Text to access a text box. 

Note: There are no limitations on the number of labels that can be added to a Form. 

3) Add the desired text and click outside the box to add the text to the form? 
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Hyperlinked Labels 

To make the label a hyperlink, use the following syntax as the text: 

<a href="website url" target="_blank">Your Label</a> 

 The part marked as Your Label will be displayed on the form, and the address used as the website url will open when the user clicks the 
label. 

Example 

<a href="http://blog.lucity.com" target="_blank">Lucity Blog</a> 

How to add a divider 

1) Click the  button.  A dividing line appears at the bottom of the Form Preview. 
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2) Use the component anchor (the blue sphere at its top left corner) to move the divider to its desired location. 

Note: The length of the line cannot be changed. 

Note: There are no limitations to the number of divider lines that can be added to the form. 
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How to insert a frame 

Click the frame button .  An empty, rectangular frame is added to bottom of the the Form Preview. 

 

Changing the Frame Size 

o Click and drag the triangle  at the lower-right corner of the frame to resize it. 

Grouping Fields with a Frame 

o Place fields inside the frame by using a field's handle  to drag and drop it inside the frame's borders.   

o The fields will be attached to the frame that surrounds them.  Therefore, when the frame is moved, all attached fields will move with it. 
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How to add a file upload 

1) Click the  button on the toolbar. 

2) A File Upload field appears at the bottom of the Form Preview. 

 

Note: More than one upload field can be added to a Form. 

More information about setting up a File Upload 

How to move components 

 Place the mouse pointer over the handle  at the component's top left corner.  Click, drag, and drop the component to a new location. 

OR 

 Select the component and change the values in its Location properties. 

Note: Fields can be placed anywhere on the form; the form size automatically adjusts to accommodate field placement. 
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How to rename components 

 To change the text of a field's Label, simply click on the label.  A text box appears, allowing you to type directly in the Form Preview. 

 

OR 
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 Select the field and change the value in the Label property. 

How to edit tab order 

1) Click the  button on the toolbar.  The following dialog box appears, listing all fields currently included on the Form. 

 

2) Select the Enable Manual Tab Order checkbox. 

3) Highlight individual fields in the list and click the Move Up or Move Down to change the tab order. 
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4) Click OK when the changes are complete. 

Note: The default tab order for fields in Forms is assigned by the system in a left-to-right, top-to-bottom manner.  The system takes into 
consideration the placement of fields within frames, meaning that users can tab through all of the fields in one frame before the tab order 
shifts to a second frame. 

How to remove the selected item 

1) Select the item to remove.  The currently selected item appears highlighted in bright green. 

2) Click the  button to remove it. [Can the action be undone?] 

Note: Fields that are required in the Desktop application cannot be removed.  The Remove button is disabled when such a field is selected.  
However, such a field can be hidden. 

How to hide Lookup buttons 

There are several special lookup buttons found on Work Orders and Request forms. 

To hide the lookup buttons: 

1) Go to System > Settings > Work tab. 

2) Disable the Show Customer Lookup and Request Lookup buttons on Request forms and the Show Customer Lookup button for Work Order 
Billing options. 
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GRID MANAGER 

The Grid Manager enables administrators to create, edit, and delete grids, among other actions. 
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DISPLAY CONTROLS 

Module Selection 
Drop-downs 

Enables the user to select a program, a module, and one of its components to 
control which Views/Forms are displayed in the grid.  List of available modules 

FIELDS 

Grid Name Specifies the title of the grid. 

Description Provides the user-defined description of the grid's purpose. 

Modified By, Last 
Modified On 

Indicates the last user to modify a grid and the date the grid was last modified. 

TOOLS 

New Creates a new Grid record. 

Edit Opens the selected record in the Grid Builder. 

Delete Deletes the selected record. 

Copy Copies the selected record. 

Rename Renames the selected record 

Enable Exporting Disables all of the previous tools and enables the Export button. 

Export Exports (see "Exporting Views/Forms" on page 157) the currently selected record 
as an xml file, which can then be imported. 

Note: Lucity provides pre-built grids that can be imported (see "Import Template Views/Forms" on page 239). 

 

How to add a Grid 
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1) Use the Module Selection Drop-downs at the top of the Grid Manager to find the correct module. 

2) Click the New button.  The Grid Builder (on page 229) appears: 

 

3) Enter a Grid Name. 

4) Modify and Save the grid. 

How to edit a Grid 

1) Use the Module Selection Drop-downs at the top of the Grid Manager to find the correct module. 



 

223 

 

 

2) Select the desired Grid and click Edit.  The Grid Builder (on page 229) appears: 

 

3) Modify and Save the grid. 

 

How to copy a Grid 

1) Select a Grid record. 

2) Click the Copy button.  
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o The Grid Builder opens a copy of the Grid with a Grid Name that begins: "Copy of..." 

o The copy contains all columns and properties found in the original grid.  Any changes made to the new grid will not affect the original 
grid.  

 

3) Modify the Name and any other fields, as desired. 

4) Save the Grid. 

How to rename a Grid 

 
 

UNSUPPORTED MODULES 

The following modules are not yet supported by Lucity Web and must be accessed using Lucity Desktop.  Any module not listed here is 
supported in Lucity Web. 

Work 

 Work Asset Setup 

Sewer 

 Sewer Rehab 

o Rehab Projects 

o Model 

o Pipe Analysis Details 
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o Rehab Work Tasks and Costs 

o Default Rehab Work Tasks 

o Material Types 

o Surface Types 

o Accessibility 
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EXPORTING GRIDS 

Often users want to set up grids in a test environment before loading them into production.  In the bottom-right corner of the Grid Manager, 
there is an Enable Exporting checkbox and an Export button.  These tools allow users to export grids they have created in one Lucity client and 
import them into another. 

 

How To Export Grids 

1) Check the Enable Exporting box at the bottom-right corner of the screen.  This action will disable most other buttons. 
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2) Choose one or more grids to export and select Export. The following window appears: 

 

3) Browse to the location you wish to save the export. 

4) Give the export a name. 

5) Select Save.  One .xml file will be saved at that location.  The file will contain all of the grids that were selected in the Grid Manager. 
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Note: See the Import from XML (see "Import Template Views/Forms" on page 239) topic for instructions for importing a grid. 
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GRID BUILDER 

Grids display records within a View.  They are designed to: 

 show key information from multiple records in a module, and  

 provide easy access to a detailed Form view of a single record. 

Administrators can use the Grid Builder to control which fields are displayed in a grid, the order in which those fields are displayed, what the grid 
is called, and which tools appear in the its toolbar. 
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HEADER INFORMATION 

Grid Name Provides a unique title for the grid. 

Grid Type Indicates which module is associated with the grid.  This field is read-only and is 
based on the program, module and component selected in the Grid Manager. 

Caption Displays the text that will appear at the top of the grid in Lucity Web. 

Page Size Indicates the number of records that will appear on a page of the grid by default. 

Description Explains the purpose of the grid. 

COLUMN EDITOR 

Available Columns Lists all columns in the module that can be added to the grid. 

  
Used to move columns back and forth between the Available Columns list and 
the Selected Columns list. 

Selected Columns Lists the columns that are included in the grid. 

  
Used to move a column up and down within the Selected Columns list.  
Columns, as listed top to bottom, appear left to right in the grid. 

Properties Lists the display properties of the selected column.  More information about 
column properties (see "Column Properties" on page 232) 

FOOTER 

Offline Mode Makes the grid available to mobile users when they are offline. 

Manage Buttons Opens the Manage Buttons pop-up, which lets administrators choose which 
buttons appear on the grid's toolbar. 

Save Saves all edits and closes the Grid Builder. 
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Cancel Closes the Grid Builder without saving edits. 

 

How to add columns 

To Add a Column 

1) In the Available Columns list (on the left), select a column to add to the grid. 

2) Click the > button to move the selected column name to the Selected Columns list. 

 

To Remove a Column 

1) In the Selected Columns list (in the middle), select a column to remove from the grid. 

2) Click the < button to move the selected column name to the Available Columns list. 
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Not : When creating or editing Work Order grids, a System ID 1 and a set of address fields appear in the 
Available Columns list.  These fields are automatically populated with the first asset ID number in the Asset grid, and first Address from the 
Location grid.  By including these fields, administrators have a way to add some asset and address information directly into the Work Order 
grid so users don't have to drill down on every record to see the location of the Work Order.  

How to change column order 

1) Select a column name in the Selected Columns grid. 

2) Click the up and down arrows to move the selected column up or down in the list.  The order of the columns, as listed top to bottom, 
indicates how they will appear in the grid from left to right. 

 

COLUMN PROPERTIES 

When a column name is highlighted in the Selected Columns list, its properties appear on the right in the Grid Builder. 

o Header - The text that will be displayed above the column in the grid. 

o Mobile Width - The width of the column in the iOS Mobile app.  If left blank the column is sized based on field type. 
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 Boolean - 75 

 Datetime - 100 

 Numeric - Max length of the number. 

 Text - Max length of the text. 

o Related Field - The database field to which the column is mapped (read-only). 

How To Change a Column Property 

1) Select a column name in the Selected Columns list.   

2) Click on a property in the Properties list to the right.  The property name will be highlighted.  The following properties are available: 

 

3) Click in the field to the right of the property name and change the value. 

4) Save changes. 
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MANAGING BUTTONS 

In Lucity Web, a toolbar appears at the top of every grid.   

By default, all toolbar buttons are enabled; however, an administrator can choose to hide a button(s) from all users using the Manage Buttons 
button in the Grid Edit screen.   

User permissions determine whether certain toolbar buttons are enabled for a particular user.   For example, if a user does not have the 
permission to add a record in a module, the Add button will not appear.   

 

How To Turn Toolbar Buttons On or Off 

1) Click the Edit button in the toolbar for the desired grid. 
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2) Click the Manage Buttons button in the bottom right corner.  The following screen appears: 

 

3) Check or uncheck the desired buttons.  Buttons that are checked will appear in Lucity Web. 

4) Click OK to save and close. 

Note: Users must leave the module and reopen it to see an administrator's toolbar changes. 

Note: The Carry Over button is a Form button; disabling it on this screen disables it on the Form attached to this grid. 
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COLUMN PROPERTIES 

When a column name is highlighted in the Selected Columns list, its properties appear on the right in the Grid Builder. 

o Header - The text that will be displayed above the column in the grid. 

o Mobile Width - The width of the column in the iOS Mobile app.  If left blank the column is sized based on field type. 

 Boolean - 75 

 Datetime - 100 

 Numeric - Max length of the number. 

 Text - Max length of the text. 

o Related Field - The database field to which the column is mapped (read-only). 

How To Change a Column Property 

1) Select a column name in the Selected Columns list.   

2) Click on a property in the Properties list to the right.  The property name will be highlighted.  The following properties are available: 

 

3) Click in the field to the right of the property name and change the value. 
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4) Save changes. 

 
 

MANAGING BUTTONS 

In Lucity Web, a toolbar appears at the top of every grid.   

By default, all toolbar buttons are enabled; however, an administrator can choose to hide a button(s) from all users using the Manage Buttons 
button in the Grid Edit screen.   

User permissions determine whether certain toolbar buttons are enabled for a particular user.   For example, if a user does not have the 
permission to add a record in a module, the Add button will not appear.   

 

How To Turn Toolbar Buttons On or Off 

1) Click the Edit button in the toolbar for the desired grid. 
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2) Click the Manage Buttons button in the bottom right corner.  The following screen appears: 

 

3) Check or uncheck the desired buttons.  Buttons that are checked will appear in Lucity Web. 

4) Click OK to save and close. 

Note: Users must leave the module and reopen it to see an administrator's toolbar changes. 

Note: The Carry Over button is a Form button; disabling it on this screen disables it on the Form attached to this grid. 
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IMPORT TEMPLATE VIEWS/FORMS 

Forms, views, and grids can be exported and imported.   

How To Import a Form, View or Grid 

1) Select Import from XML on the Forms menu.  The following window appears: 
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2) Choose one or more xml files and select Open.  A confirmation message appears to indicate that the import was successful. 
 

ASSIGN DEFAULT GROUP VIEWS 

The Assign Default Group Views feature lets administrators assign different default views for a module to different user groups.  This allows 
each user group to open a module to the view it prefers.  This is only available for the following modules. 

Supported Modules 

o Equipment Inventory 

o Facility > Building Inventory 

o Work > PM/Templates 

o Work > Requests 

o Work > Work Orders 
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The tool is accessed through the Administration Tool at Forms > Assign Default Group Views. 
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Groups Displays a list of user groups from the Security module. 

Module Selection 
Drop-downs 

Enables the administrator to control which Views/Forms are displayed in the 
Available Views/Forms grid by selecting a program, a module, and one of its 
components. 

Select default view for 
selected group 

Enables an administrator to select a view for the selected module. 

Assign default view to 
group 

Assigns the selected view as the default view for the selected group.  This 
function will only work for a user if the selected Group is set as the user's Default 
Rules Group in the Security program. 

 

How to assign a default View for a Group 

Administrators have the ability to assign a default View for each Lucity module.  In the Web application, all users who navigate to a module 
using the Modules menu will see this View by default.  However, for a select number of modules, an administrator may set a different default 
View for different Groups. 

Note: For users to see the View assigned as the default, they must have the associated Group assigned as their Default Rules Group in the 
Security program. 

 

1) Select one group in the Groups list. 

2) Use the Module Selection drop-downs to find the module you want to set a default for. 

3) Using the drop-down list, select a view in the Select default view for selected group section. 



 

244 

 

 

4) Click the Assign default view to group button. 
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GIS 

The GIS menu option allows administrators to control which maps users have access to within the Web application and set various connection 
strings for the GIS Server tasks.  Note that changes made to the system settings here will be applied to all users.  Follow the links below for 
additional information.  
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GIS CONFIG 

The GIS Config tool allows an agency to configure Lucity with the GIS data it stores in ArcGIS Online. 
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The tool is divided into three sections: 

ArcGIS Online Data (on 
page 249) 

Displays information about an agency's ArcGIS Online account. 

Current GIS Configuration 
(on page 255) 

Provides an overview of the entire configuration. 

Feature Class 
Configuration (on page 
257) 

Shows configuration information for the layer selected in the ArcGIS Online Data 
section or the Current GIS Configuration section. 

 

How to log into the GIS Config tool 

1) In the Administration Tool, select GIS > GIS Config.  The ArcGIS Online Login window appears. 
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2) Enter your ArcGIS Online Username and Password and click Sign In. 

 

The tool connects to your ArcGIS Online account and displays a list of the services available to you. 

Note: Your login must be associated with your agency inside ArcGIS Online. 
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ARCGIS ONLINE DATA 

The ArcGIS Online section of the Lucity Admin Tool displays information about an agency's ArcGIS Online account. 
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Name Identifies the ArcGIS Online organization that is logged in. 

ID Specifies the ArcGIS Online ID for the organization that is logged in. 

Grid 

The grid, illustrated above, displays a list of feature services that the organization's hosts on its ArcGIS Online account.  Expand a service to view 
the available feature class layers.  Services listed in black do not have any feature class layers linked to Lucity.  Services listed in green 
currently have feature class layers linked to Lucity.   

Click on a green feature class layer to review the configuration between the layer and Lucity. 

Right-click on a feature class to view available tools.  The tools that appear here are dictated by whether or not the layer is linked to Lucity. 

TOOL LIST 

Link Layer to Lucity (on 
page 250) 

Associates the feature class layer to a module in Lucity and allows the user to 
configure the link. 

Remove Link to Lucity (on 
page 251) 

Unlinks the layer from Lucity. 

Validate (on page 252) Checks the configuration for errors. 

 
 

LINK LAYER TO LUCITY 

The Link Layer to Lucity tool associates an ArcGIS feature class layer with a Lucity module and allows the user to configure the link. 

How To Link an ArcGIS Feature Class Layer to Lucity 

1) Select a feature class layer listed in black. 
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2) Right-click on the layer and select Link Layer to Lucity.  The following fields are displayed on the right side of the tool: 

 

3) Select whether the feature class layer should link to an Inventory or Inspection module. 

4) In the drop-down box, select the Lucity module to which the layer should link. 

5) Click OK.   

o The ArcGIS Online Services folder is added as a new GIS Connection String (see "GIS Connection Strings" on page 284, 
http://help.lucity.com/webhelp/v170/admin/index.htm#26705.htm) if it hadn't been added previously. 

o The ArcGIS Online feature service that contains the layer is added to the GIS Map Services (on page 292) list if it hadn't been added 
previously. 

o The configuration is created for the layer and feature class. 

6) Select the layer in the ArcGIS Online Data (on page 249) section or the Current GIS Configuration (on page 255) section to display the Feature 
Class Configuration (on page 257) section. 

 

REMOVE LINK TO LUCITY 

The Remove Link to Lucity tool breaks an existing link between an ArcGIS Online feature class layer and a Lucity module. 

How To Break a Link between a Feature Class and a Lucity Module 

1) Select a feature class layer listed in green in the ArcGIS Online Data section of the tool. 

http://help.lucity.com/webhelp/v170/admin/index.htm#26705.htm
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2) Right-click on the layer and select Remove Link to Lucity.   The association no longer exists. 

 
 

VALIDATE 

Once an ArcGIS feature class layer is configured, administrators should use the Validate tool to confirm that there are no errors in the link 
between the layer and the module.   

There are three steps in the validation process is to verify that the geodatabase meets Lucity requirements.  If the Validate tool encounters no 
critical errors during a step in the process, it moves to the next step in the validation process. 

 Validate Lucity Configuration - Checks the Lucity configuration to make sure all require information is filled out etc..... 

 Validate against Geodatabase - Checks the geodatabase to make sure all features and fields referenced in the configuration actually exists. 

 Validate against Services - Checks the related feature services to make sure the related feature classes exist. 

 

How To Run a Validation Check 

1) Select a feature class layer listed in green in the ArcGIS Online Data section of the tool. 
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2) Right-click on the layer and select Validate. The tool begins its three-part validation process, displaying results as it runs: 

 

a. Lucity verifies the geodatabase setup against Lucity requirements to check that the Required and Optional linking fields are completed. 
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 As the tool checks the setup, it displays results under the Lucity Module name : Feature Class Name headings.  Suggestions appear in light 
gray, warnings in orange and errors in red. 

 If the system detects an error, the validation process stalls and the system alerts the user: 

 

b. If the tool confirms that the geodatabase is set up properly, it immediately begins the second part of the validation process. 

 Results appear in the same validation window. 

c. The third part of the validation process verifies that the configuration can connect to the feature service that the module is configured to 
connect to. 

 The system checks whether the feature class layer is in the service. 

 Then, it confirms that all of the linked fields are in the service.   

 If it can't find a field, the system verifies that the field name entered in the geodatabase configuration has the same case as the actual field 
name.  If it finds a discrepancy, the following prompt appears: 
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 Click Yes to update the geodatabase configuration with the case-matching field name.  The system repeats this step for any problem fields. 

3) If the link between the feature service and the module is validated, the system displays the following message: 

 

4) After the validation process is complete, the user can review it.  Users can select and copy the results to word-processing software or use 
the File menu to Print, Save, or Email the Results to Lucity Support. 

 

CURRENT GIS CONFIGURATION 

The Current GIS Configuration section provides an overview of the entire configuration. 
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Layers Tab 

The Layers tab lists feature class layers that are configured to work with a Lucity module.  Users have three options for displaying these items: 

Layer Lists all ArcGIS Online layers that are linked to a Lucity module. 

Module Lists all ArcGIS Online layers that are linked to a Lucity module, arranging them by 
Lucity program and module. 

Service Lists all ArcGIS Online layers that are linked to a Lucity module according to which 
ArcGIS Online service the layer is in. 

Click on a feature class layer to display the configuration between the layer and Lucity. 

Other Tabs 

The Number Generators tab, GIS Tasks tab, and Spatial Relates tab are included in the software; however these tools are currently not active. 
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FEATURE CLASS CONFIGURATION 

The Feature Class Configuration section displays configuration information about the layer selected in either the ArcGIS Online Data section or 
the Current GIS Configuration section. 
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The Feature Class Configuration section contains tabs that provide settings and information related to the configuration. 

Layer Info Displays basic information about the feature class, as well as its linking fields and 
certain diagnostic fields. 

Fields Displays the feature class fields grid, which is used to link feature class layer fields 
to Lucity module fields.  

Spatial Relationships Lists the spatial relationships that are configured to update this feature class. 

Number Generators Lists the number generators that are configured to update this feature class. 

GIS Tasks Lists the GIS tasks that are configured to push edits between the layer and the 
Lucity module. 

 
 

LAYER INFO 

This Layer Info tab displays basic information about the feature class, as well as its linking fields and certain diagnostic fields. 

General Information 
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Layer Name: Identifies this particular feature class layer in the feature service. 

Lucity Module: Indicates the Lucity module with which the layer is associated.  (This field is 
read-only.) 

Lucity Table: Identifies the Lucity database table that stores information for the selected Lucity 
module. (This field is read-only.) 

Disable Feature Class: This flag disables a feature class layer that is not in use, but needs to remain in the 
setup. It is recommended to disable any feature class layers that are not being 
used; it will speed up processing time. 

Always Update 
Length/Area: 

When enabled, directs the Lucity GIS Extension to update the field in the feature 
class that is mapped to the Lucity Length/Area field when the shape of a feature 
changes.   

If disabled, the Length/Area fields are populated only when the feature is first 
created. 

 

Layer Fields (Not linked to Lucity) 

This section contains optional fields used to keep track of changes in Lucity.  The only exception is the Field for Display. 

 



 

260 

 

 

In Lucity Flag Field This field is updated by Lucity to indicate whether or not a record in the feature 
class has been synchronized with Lucity. 

 This should be a short integer field 

 should be assigned a domain that classifies 0=No or False and 1= Yes or true. 

Last Modified By This field is controlled by Lucity to indicate the last user to modify the record in 
the map. 

 This should be a Text Field 

Last Modified Date This field is controlled by Lucity to indicate the last date the record was modified 
in the map. 

 This should be a Date field 

Last Synchronized Date This field is controlled by Lucity to indicate the last date the record was 
synchronized with Lucity. 

 This should be a Date field 

Field for Display  This is the field that is displayed by various Lucity GIS tools. By default this is 
set to the Facility ID/Common ID of the feature class. 

 

Feature Class Linking Fields 

This section is a quick reference to show which fields in the feature class layer form the basis of the link between the layer and the Lucity module. 
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Common ID Field:* The unique identifier assigned by the user for this asset. The value for this 
field cannot be directly modified; it is automatically populated based on 
the field mappings on the Fields tab. Every module has at least one field 
that defines the asset as unique.  These fields are highlighted in red on 
the Fields tab. To enter a value in this field go to the Fields tab, find the 
corresponding red highlighted field, and type the field name into the 
Feature Class Field Name column. 

Note: This field should be a string field in the geodatabase, not a 
numeric field. 

Lucity AutoID Link: This field is used by Lucity to store an indexed long integer link between 
the records in the feature class and the records in the Lucity inventory 
table. This field must be long integer.  The value for this field name is not 
editable; to update this value, use the grid on the Fields tab.   

Note:  While this field is not required it is still strongly 
recommended to have it.  Not having this field will impact the 
performance of some of the Lucity GIS tools as additional resources 
will be used to determine the AutoID value based upon the Facility 
ID/Common ID. 

* Required 

Service Info 

This section displays the URL for the Feature Service that contains the Layer. 
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This path is just for information.  It is read-only. 
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FIELDS 

The Fields tab contains a grid that allows administrators to link fields in the Lucity module to feature class layer fields.   

Note: GIS fields that link to a Lucity pick-list field can only link to the Code portion of the Lucity field. 

Note: Never link ESRI's Shape.Length field to the Lucity length field.  These fields are read only and will cause the integration to fail. 

Fields 

The following images display the types of fields that can be linked. 
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COLUMN PURPOSES 

FieldName: Identifies the field in the Lucity table. 

DisplayName: Indicates the field caption for the field as it appears in Lucity. 

Field Type: Indicates the type of data stored in the field. 

MaxMask: Indicates the data format for the field.  A numeric value followed by an "x" 
indicates the number of characters allowed.  An "n" indicates a numerical digit. 

Feature Class Field Name: Identifies the corresponding field in the feature class.  (This is NOT the alias field 
name.) 

Field Lookup: Provides a button administrators can click to display a list of the feature class 

fields.  Note:  If Lucity is unable to connect to the geodatabase, no fields will 

be listed. 

Lookup Lucity ID Directs the Lucity/GIS integration to look up the Rec # for the asset based on the 
Common ID provided.  This lookup field appears when a feature class layer links 
to an asset ID in a Lucity Inspection module. 

 If the ID stored in the feature class is the asset's Rec #, link that field to the 
Rec # field and leave this box unchecked.   

 If the ID stored in the feature class is the the asset's Common ID, then link the 
field to the Common ID and check the Lookup Lucity ID field next to the Rec #.   
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Color Coding Indicates that the field has special requirements. 

 Red - Required field. 

 Orange - ID number required for related feature. 

 Yellow - ID number optional for related feature. 

 Green - Composite Address field. 

 Pink - Strongly recommended field.  (Typically, the Lucity autoID field is 
coded pink.  Although, technically, this field isn’t required, Lucity strongly 
recommends that the feature class contain a field that stores the Lucity 
autoID.  Without it, the system expends resources to identify the record 
[asset?], which can impact performance of certain Lucity GIS tools. 

 

How to Link a Feature Class Field to a Lucity Field 

1) Decide which field should be linked. 

2) Look at the field in Lucity.  Copy the field display name or CTRL + Right -click to find the field name in the field properties. 

3) In the GIS Config tool, select the feature class linked to the correct module. 

4) Search through the grid on the right for the Lucity field using its field name or display name. 

5) Enter the name of the feature class layer in the Feature Class Field Name field OR push the Field Lookup button for a list of fields from the 
associated feature class. 
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DATE FIELDS 

Users can link Lucity's Date and Time fields to GIS Composite Date/Time fields.  Note, however, that Lucity stores the Date in one field, and the 
Time in another; the GIS Composite fields, on the other hand, store this information in a single field.  To link a composite Date/Time field to 
Lucity, link that field to Lucity's Date field AND to its Time field. 
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ADDRESS FIELDS 

Address fields are made up of multiple components and can be linked using 2 different configurations 

Components 

Lucity breaks out street address information into the following fields. 

 Building Number - The address 

 Building Number 2 - Extended information about the address (1/2, A, etc...) 

 Street Direction 

 Street Prefix 

 Street Name 

 Street Suffix 

 Street Type 

Multiple field configuration 

In this configuration the feature class has all of the different building number and street name fields broken out.  This is configured by linking 
each field in the feature class to each field in Lucity 

 Building Configuration 
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 Street Name Configuration 

 

Single Field configuration 

In this configuration the feature class has the building number fields combined and the street name fields combined.  This is configured by 
linking the field in the feature class to the special composite field in the geodatabase configuration 

 Building Configuration 

 

 Street Name Configuration 
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Combined Configurations 

These configurations can be used together but both configurations for the same component cannot be used together. 

 Examples that work 

o Single Field Building Configuration + Single Field Street Name Configuration 

o Single Field Building Configuration + Multiple Field Street Name Configuration 

o Multiple Field Building Configuration + Single Field Street Name Configuration 

o Multiple Field Building Configuration + Multiple Field Street Name Configuration 

 Examples that don't work 

o Multiple Field Street Name Configuration + Single Field Street Name Configuration 

o Single Field Building Configuration + Multiple Field Building Configuration 
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SPATIAL RELATES 

Spatial relationships, also called Spatial Relates, streamline the process of adding new features by automatically updating specified fields based 
on a feature's relative location to another feature. 

The most common use of Spatial Relates is to update a child record with a parent record's ID number.  For example, an agency could use a 
Spatial Relate to automatically add the proper Park ID to a record for a piece of playground equipment within a park.  A spatial relate can 
update any feature fields, whether or not those fields are linked to Lucity.  They can also use non-Lucity feature classes to update Lucity feature 
classes. 

Triggering a Spatial Relationship update 

The GIS Task that synchronizes the GIS data in an agency's feature service into Lucity includes an option to Update spatial relationship. 

Considerations 

When creating a Spatial Relate, consider: 

 Which features require data from other features? 

 Which features would benefit from having data pulled over from other features? 

 What is the relationship between these features? 

 

How to add a new Spatial Relate 

1) Click the Add New Spatial Relate button. A new record appears in the Spatial Relates grid. 
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2) Select the new spatial relate record in the grid and complete the Spatial Relationship Info section that appears at the bottom of the grid. 

 

3) Field to Update: Enter the name of the field in the selected feature class layer that you want the system to automatically update. (Required.) 

4) Service that contains related layer: Enter the name of the feature service that contains the layer you wish to relate to the selected feature 
class layer.  (This information is required if the related layer is not in the same service.) 

5) Related Layer Name:  Enter the name of the feature class layer that you wish to relate to the selected feature class layer. (Required.) 

6) Related Layer Field : Enter the name of the field in the Related Layer with the value that the system should use to update the field you 
designated in Step 3 above. (Required.) 

7) Relationship Type:  Use the drop-down box to select from a list of predefined relationships. (Required.) 

o From Intersect: Finds any features in the Related Layer that intersect the From Point of the feature in the selected feature class layer. 
This relationship only works for Polyline, Edge or Complex Edge features. 

o To Intersect: Finds any features in the Related Layer that intersect the To Point of the feature in the selected feature class layer. This 
relationship only works for Polyline, Edge or Complex Edge features. 

o Is Contained by: Finds any features in the selected feature class layer that are contained by features in the Related Layer. The Related 
Layer must be a Polygon feature class layer. 

o Intersects: Finds the first feature in the Related Layer that intersects the feature in the selected feature class. 
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o To Intersect Distance: Finds the first feature in the Related Layer (which must be a Polyline geometry type) that intersects the feature in 
the selected feature class layer. The system then calculates the distance along the related feature between the intersection location and 
the To Point. (If the selected feature class layer is of a Polyline geometry type, the To Point of the selected feature must intersect the 
related feature.) 

o From Intersect Distance: Finds the first feature in the related feature class layer (which must be a Polyline geometry type) that intersects 
the feature in the selected feature class layer.  The system then calculates the distance along the related feature between the 
intersection location and the From Point. (If the selected feature class layer is of a Polyline geometry type, the To Point of the selected 
feature must intersect the related feature.) 

o Midpoint Intersect: Finds any feature in the Related Layer that intersects the Midpoint of the feature in the selected feature class layer. 
This relationship requires the selected feature class layer to be of Polyline, Edge or Complex Edge geometry, and the Related Layer to be 
a Polygon feature. 

o Force Feature to Self-Update: Finds any features that intersect the feature in the selected feature class layer and adds them to the edit 
cache so that they are synced to Lucity (even if the records have not changed). This relationship is used primarily for the Street Segment 
feature class, with the Street Intersection feature class as the Related Layer. The Spatial Relate forces the system to automatically 
recalculate the intersection configurations for the diagram in the desktop Intersection module when Street Segments are changed. 

o Is Within Distance of: Finds all features in the Related Layer that are within a specified distance of the feature in the selected feature 
class. 

8) Enter the Distance Value. (Required only for the Is Within Distance Of Relationship Type.) 

9) Choose whether to enable the Never Overwrite a Non-Null Value option, which prevents the data in the Field to Update from being 
overwritten if a value already exists. 

10) Choose whether to enable the Update Value to Null if No Relationship is Found option, which sets the Field to Update value to null if no 
relationship is found. 

11) To save the Spatial Relate, select another node or close the form. 



 

274 

 

 

Note: Spatial Relationships can be edited any time after they have been saved. 

How to delete a Spatial Relate 

1) Select a Spatial Relationship record in the grid. 

2) Click the Delete button.  The record will be deleted from the grid. 

 

 
 

NUMBER GENERATORS 

Number Generators streamline the process of creating a unique value for a feature class field. 

Triggering a Number Generator 

The GIS Task that synchronizes the GIS data in your feature service into Lucity also automatically triggers any existing Number Generators. 

Considerations 

When creating a Number Generator, consider: 

 Do I want this number to have a prefix? 

 If so, is the prefix set, or does it change depending on location? 

 What would the next number in the feature class be?  

 

How to add a Number Generator 

1) Click the Add New Number Generator button.  A new record appears in the grid. 
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2) Open the record and complete the Number Generator Info section at the bottom. 

 

3) In the Field to AutoNumber, enter the name of the field to which you want to apply a number generator.  (Required.) 

o This field should be a text field that is large enough to support the numbers the system will generate based on the settings on this form. 

4) Enter the number of digits desired for the Buffered Number Length. This option adds buffered zeros to the beginning of the generated 
number, which can be helpful in sorting data.   

o Example, if a user chooses a Buffered Number Length of 5, and the auto-number generated is 985, system expands the figure to five 
digits, or 00985.  

5) Choose Prefix Settings, if desired. 

o None:  Marked by default. Indicates that the user does not want a Prefix for this field. 

o Use Set Prefix: Allows the user to specify a prefix in the Generate Next Number grid, along with a separator character.  

o Use a polygon feature class to create a prefix: Generates a prefix based on a feature's spatial relationship to a Polygon feature class. 
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 Service that contains related layer: Enter the name of the feature service that contains the Polygon layer the number generator should use.  
(Only necessary if the related layer is not in the same service.) 

 Polygon Layer: Enter the name of the Polygon feature class layer on which the system should base the prefix.   

 Field that Contains prefix value: Enter the name of the field in the Polygon feature class that contains the value to be used as a prefix. 

6) In the Separator Character field, enter the character(s) you wish to appear between the Prefix and the generated number.   

7) Click the Generate Next Number button to set the correct start number. 

o If the Prefix Settings are set to None or Use Set Prefix, only one Next Number record may be generated. 

o If the Prefix Settings are set to Use a Polygon Feature Class, you can set multiple Next Numbers, one for each polygon in the feature class. 

Note: If no Next Number is set, when a new feature is created in the selected feature class, the number generator sets the new feature to 1, 
and the new Next Number to 2, and so on.  The same is true if a Polygon feature class is used. 

8) The Number Generator preferences are saved when you click on a different feature class. 

Note: A Number Generator can be edited any time after it is saved. 

How to delete a Number Generator 

1) Select a Number Generator record in the grid. 

2) Click the Delete button.  The record will be deleted from the grid. 

 
 

GIS TASKS 

GIS Tasks, also called Scheduled Tasks, are designed to push data back and forth between the feature class layer and the Lucity database. There 
are two types of tasks: 

1) Lucity to GIS- Currently only available for Inspection feature classes. 
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2) GIS to Lucity- Supported for all GIS-enabled modules (Inventory and Inspection). 
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For example, a task can push Inventory data from the feature class layer to Lucity or push Inspection data from Lucity to the feature class layer. 

GIS Tasks can be configured to run automatically.  The GIS Task Runner processes Scheduled Tasks based upon the frequency rate (and other 
criteria) established by the user.   

The GIS Task function greatly expands the ability to integrate Lucity and GIS through feature services.  Lucity can pick up edits to the feature 
service, regardless of who made them or the environment in which they were made. 

For example, a Task can detect edits made in: 

 Collector for ArcGIS (iOS & Android)- including disconnected editing, 

 Lucity Web Map, 

 ArcGIS.com map viewer, or 

 any other third-party applications that support feature-service editing.  
(http://resources.arcgis.com/en/help/main/10.2/index.html#/Using_feature_services_in_a_client_application/0154000005sq000000/) 

Notes:  

 Record merges, splits, renumbers, and deletes must still be performed an ArcMap editing environment with the Lucity extension enabled in 
order for the related Lucity Inspection, Construction, and Work history to be properly updated. 

 Features must meet the Lucity module requirements in order for the synchronization to be successful.  For example, required fields, such as 
the Lucity Common ID, must contain a unique value.  

 GIS Tasks interact with the feature class through the feature services.  Before setting up a GIS Task, make sure there is a feature service 
defined at either the feature class or geodatabase level. 

Primary Uses 

GIS Tasks are especially useful in: 

 importing Inspection records that were created in an inspection feature class layer into Lucity;  

 updating Lucity with edits made to feature classes layers in the Lucity Web Map; and 

http://resources.arcgis.com/en/help/main/10.2/index.html#/Using_feature_services_in_a_client_application/0154000005sq000000/
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 updating Lucity  with edits made to Lucity-linked feature class layers using editing environments that aren't integrated with Lucity. 

Prerequisites 

In order for the GIS Task to run properly the feature classes in the feature service must contain the all of the fields that are linked to Lucity. 

Considerations 

When creating a GIS Task, consider:  

 Which Inspections should appear in the feature class? 

 Should old records be updated with new changes? 

 

How to add a GIS Task 

1) Click the Add New GIS Task button. A new record appears in the grid. 

2) Select the record in the grid and complete the GIS Task Info section at the bottom. 
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3) Under General Info, select the desired Task Type: 

o Sync - Lucity to GIS - Pushes Inspection data from Lucity to an Inspection feature class layer. 

o Sync - GIS to Lucity - Pushes any data from the feature class layer to Lucity. 

4) Under Filter Options, select which records the Task will process when it runs: 

o None - Directs the Task to consider all records when syncing. 

o Filter Set - Directs the Task to consider only records that meet the criteria of a particular filter. 

 Select Filter - Choose an existing Lucity filter from the related module. 

5) Under Scheduling Info, indicate how often the Task should run. 

o Units - Indicate the number of minutes, hours, days, or months that will pass between runs. 

o Frequency - Select whether the units represent minutes, hours, days, or months. 

o Last Run - Displays the date on which the Task was last run.  (The system automatically completes this field.) 

o Override - Allows the user to manually modify the Last Run date. 

o Next Run - Displays the next date/time the Task will run.  (The system automatically calculates this field based on the Last Run, Units, 
and Frequency fields.) 

6) Click the Recalc button to calculate the Next Run date using the Units, Frequency and today's date. 

7) Under Options, set how the GIS Task should behave when populating the feature class: 

o Only process records modified since last run - Directs the Task to check the records' Last Modified dates.  Only records (in the filter set) 
that were modified since the Last Run date are synced. 

o Last Edited DateTime Field - Directs the Task to store the date/time that the record was last edited (typically the ESRI Editor Tracking 
field).  This option is only enabled when the Only Process records modified since last run option is checked and the Task Type is Sync- 
GIS to Lucity. 

o Insert record if it doesn't already exist - Tells the Task to add any new records to the destination. 
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o Enable number generator for imports - Directs the Task to assign numbers to assets using a Lucity GIS Number Generator related to the 
feature class. 

o Update existing record - Tells the Task to update existing records with new attribute data. 

o Delete previous inspection(s) for asset.  (Only keep most recent inspections) - Directs the Task to delete any Inspection in the feature 
class that is not the most recent Inspection for an asset.  The option is helpful if an agency wants the feature class to contain only the 
most recent Inspection for each feature.  (Enabled only when the Task Type is Sync- Lucity to GIS.)   

8) Click on a different part of the tool to save changes. 

Note: History section - This section contains information about the last time the GIS Task ran. 

How to delete a GIS Task 

1) Select a GIS Task record in the grid. 

2) Click the Delete button. The record is deleted from the grid. 
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PROCESS LOG 

The Process Log tab displays a history of previous GIS Task runs.  These log entries are automatically deleted after 30 days. 

 

TimeStamp Specifies when the entry was made in the log. 

Status Indicates the processing status of the task. 

Edit 1 = Inserts 

2 = Edits 

3 = Deletes 

Error 1 = Transactional Details 

2 = Validation Failed 

3 = Process Failed 

4 = Service Issue 

5 = Business Object Issue 

6 = Missing Data 

ErrorDescription Provides further detail regarding the edit or error. 

ErrorException Provides further detail regarding the error. 

GUID Denotes the processing batch GUID. 

ModID Indicates which Lucity module was affected. 

LucityID Indicates which Lucity record was affected. 

GISID Specifies the ObjectID of the GIS feature. 

Syntax The syntax used for either retrieving, updating, inserting or deleting. 
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AUTHENTICATION SETUP 

The Authentication Setup tool allows administrators to store credentials for web services. 

User Authentication Grid 

The User Authentication grid displays the credentials for accessing ArcGIS for Server. 

Name/Desc ** Specifies the name of this stored credential.  This term will be used when 
selecting the credentials for use in other GIS configuration tools. 

Username * Specifies the user's login ID for accessing ArcGIS for Server. 

Has Password? Indicates whether the password has been set for this login. 

Set Password Allows the administrator to set the password for the login. 

Add User Adds a new user. 

Delete User Deletes the selected user. 

* Required. 
* Must be unique. 

How to add a User Authentication 

1) Click Add User.  A new record will be added to the bottom of the grid. 

2) Enter a Name/Desc.  (Must be unique.) 

3) Enter the Username. 

4) Click somewhere else in the tool to save changes. 
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5) If this login is secured, return to the record and click the Set Password button.  The following pop-up appears: 

 

6) Enter the password and click OK.  The Has Password? box is now checked for that user. 

Note: ArcGIS Online layers require users to login every time they connect even if you have saved credentials. 

 

 
 

GIS CONNECTION STRINGS 

The GIS Connection Strings window is used to connect Lucity to ArcGIS geodatabases.  Connection strings have two purposes: 

1) They allow Lucity to connect to a geodatabase to update the attributes of feature class records that are linked to Lucity.   

2) They help the Lucity GIS tools in ArcMap to identify feature classes linked to Lucity. 
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To access the GIS Connection Strings window, in the Lucity Administration tool, go to GIS > Connection Strings.  The following window appears: 
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Name States the user-defined name of the connection string.  The first string MUST be 
called DEFAULT and should point to the geodatabase that contains the feature 
classes linked to Lucity. 

Database Type Indicates the type of geodatabase, SDE, File, Personal and ArcGISOnline, being 
connected to. 

Database SDE - Specifies the name of the SQL Server geodatabase.  The database listed 
here is not the SDE repository database.  Instead, it is the geodatabase that 
contains the infrastructure data that you want to integrate with the Desktop.  
For Oracle geodatabases, this field must be left blank. 

Personal or File - the path to the geodatabase, including the geodatabase. 
(Example - R:/GIS/Lucity/LucityGIS.gdb) 

Server SDE - Specifies the name of the server that stores the SDE database. 

Personal or File - Leave blank. 

Instance SDE - Indicates the name of the instance for the SDE database.  Supports either 
spatial or direct connections. 

 Spatial Connection: Enter the port where ArcSDE is installed. By default, this 
is typically 5151. Do not include the /tcp identifier; enter only the port 
number. 

 Direct Connection: Enter the name of the direct-connect driver and the name 
of the server instance.  

o SQL Server example: "sde:sqlserver:GIS_SERVER\DATA" 

o Oracle example: "sde:Oracle11g:GIS_SERVER\DATA" 

Personal or File - Leave blank. 

Version SDE - Designates the name of the ArcSDE version that Lucity will use when 
connecting to the geodatabase (required). For Oracle, the field is case sensitive. 

Personal or File - Leave blank. 
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Authentication Type SDE - Determines how Lucity will connect to the database. 

 DB (Database Authentication) - Complete the UserName and Password fields. 

 OSA (Operating System Authentication) - Uses the credentials from the user 
currently logged into Windows. 

Personal or File - Leave blank. 

UserName SDE - Provides the database login that Lucity will use to connect to the 
geodatabase.  The specified user must have permission to ALL feature classes 
linked to Lucity.  Only enter a value if the Authentication Type is set to DB. 

Personal or File - Leave blank. 

Password SDE - Provides the password that Lucity will use to connect to the geodatabase.  
Enter a value only if the Authentication Type is set to DB. 

Personal or File - Leave blank. 

Edit Map Service URL The feature service that is used to update the geodatabase with edits made in 
Lucity.  This service must be entered into the GIS Map Services dialog.  Once it 
is entered there it can be selected in this dialog. 

SDE  

 Stores the URL for a default map service that will be used to push Lucity 
updates to the geodatabase and vice versa.  This map service will pass 
updates for all feature classes that do not have an Alternate Feature Service 
specified on their Edit Map Service tab. 

More information on SDE Updates using ArcServer 

ArcGISOnline 

 Stores the URL that points to the ArcGISOnline directory that lists your ArcGIS 
Online services. 

 Example: http://services.arcgis.com/<code>/ArcGIS/rest/services. 
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Map Service User Indicates the User ID required to access the Edit Map service if it is a secured 
service. 

Map Service Password Specifies the password for the Map Service User. 

Last Modified By Specifies the last user to modify the connection string. 

Last Modified Date Indicates the last date the connection string was modified. 

Last Modified Time Indicates the last time the connection string was modified. 

Update GDB? Indicates that the selected geodatabase should be updated with edits made in the 
Lucity Desktop, Web, and Mobile interfaces. 

Replica GDB? Indicates that the selected geodatabase is a replica of your default geodatabase. 

Add Connection String 
button 

Adds a new connection string. 

Delete Button Deletes the selected connection string. 

Note:  An exclamation point in the left-hand margin indicates a bad connection. 
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COLLECTING SDE CONNECTION STRING INFORMATION 

The Connection String setup in the Lucity Adminstration tool must match the connection strings that ArcMap users use.   

Connection String Values 

 Database - The name of the geodatabase. 

 Server - The server that stores the database. 

 Instance - The connection instance for the geodatabase. 

 Version - The version of the database that Lucity will update. 

 Username/Password - A login and password that has access to the database/version.  This field should be completed only when the 
Authentication Type is set to DB. 

 Authentication Type - The type of authentication used to connect to the database. 

 Database Type - The type of database being connected to Lucity. 
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The following values are not covered in the example above: 

 Server - This entry is the same as the last section of the Instance. 

 Version - This field must be provided by the GIS Administrator. 

 Database Type - For this kind of connection, the Database Type should be set to SDE. 

How To Find the Connection String Information in ArcCatalog 

1) Open ArcCatalog. 

2) In the Table of Contents, expand Database Connections. 

3) Find a database connection that is used to add Lucity GIS data to ArcMap. 

4) Right-click on the connection and select Connection Properties. 

How To Find the Connection String Information in Lucity 

1) Open the Lucity Administration tool. 

2) Go to GIS > Connection strings. 
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GIS MAP SERVICES 

The GIS Map Services window enables administrators to connect Lucity to map services available on the Internet or that they have set up in Arc 
Server.  Defining map services in this dialog defines them as an available service to add to a web or viewer map.   

Note:  Map services must be added to this setup screen before they can be added to the GIS Map Setup (on page 301) dialog.   
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MAP SERVICES TAB 

The Map Services tab lists the map services used in the Lucity Web Map and the Lucity GIS configuration. 

Map Services Grid 

FIELDS 

Name Uniquely identifies the map service during setup. 

URL Specifies the URL of the map service or the path of a local map package.  A map 
service URL usually looks something like this: http://<server 
name>/ArcGIS/rest/services/<service name>/MapServer.  This must include 
/rest after ArcGIS. 

Note: In Arc 10.x, the <service name> is case-sensitive. 

More information about Bing services (see "Bing Services" on page 382) 

Order Specifies the order in which the map service will appear when implemented with 
other map services.  Lower-numbered services appear beneath 
higher-numbered services.  Basemap services always appear on the bottom. 

Opacity Controls the opacity of this service. 
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Base Map for Web? Indicates whether a layer should be used as a basemap in the Lucity Web Map.  
All layers marked as a basemap will be available to all users in the Basemap 
Selection tool in the Web Map. 

 Note: Basemaps must be either a tiled map service, an image service, or a 

Bing Map. 

 Note: Basemaps can have a different spatial reference than other layers.  

However, when the basemap is loaded in the Web Map, the map will zoom 
to its full extent and abandon the user's current location. 

 Note: This functionality [the basemap?] is not available in the Lucity GIS 

Viewer. 

Base Map for Mobile? Indicates whether a layer should be used as a basemap in the Lucity Mobile Map.  
All layers marked as a basemap will be available to all users in the Basemap 
Selection tool in the Mobile Map.   

 Note: Basemaps must be either a tiled map service, an image service, or a 

Bing Map. 

 Note: Basemaps can have a different spatial reference than other layers.  

However, when the basemap is loaded in the Web Map, the map will zoom 
to its full extent and abandon the user's current location. 

Has Feature Service? Indicates whether the map service has an associated feature service.  If a 
feature service is available, editing is enabled for related layers in the Lucity Web 
Map and the Lucity Mobile Map. 

User Auth Enables administrators to select which authentication to use for a secured 
service.  The authentication options that appear here are configured in the GIS > 
Authentication Setup (see "Authentication Setup" on page 283) tool. 

Note: If the service is secured and no User Name/Password is provided, users are 

required to log in. 
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Require Logon Provides an added layer of security by forcing users to enter their own login 
credentials when a map service is a secured service. 

 All AGOL services require login credentials and must have this box checked.. 

Mobile URL Specifies an alternative, external URL for the service if it will be accessed by Lucity 
Mobile. 

Offline Mobile Feature 
Service URL 

Specifies a URL for an alternate map service in cases in which a map is likely to be 
used in Lucity Mobile's offline mode. 

Map services that are taken offline have several ESRI-imposed restrictions.  This 
setting allows an agency to use an unrestricted map service in its Web 
Map/Mobile Map, then automatically switch to an alternative service (designed 
to be in line with ESRI's offline restrictions) when users take the map offline.  

Proxy URL Identifies the proxy address for clients using one. 

Last Modified By Identifies the last user to modify the connection string. 

Last Modified Date Indicates the date the connection string was last modified. 

Last Modified Time Indicates the time the connection string was last modified. 

Note: Multiple tiled services can be used in the map ONLY if the services have the same spatial reference.  If a tiled service is set up as the 
basemap, and another service with a different spatial reference is used as a normal map layer, the Web Map will fail to render. 

 

Grid Tools 

BUTTONS 

Add Map Service Adds a new row in which to enter map service information. 

Delete Deletes the selected map service. 
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Test Displays a pop-up that shows the map service URL and a list of layers that the 
system recognizes as connected to Lucity. 

Default Base Map for 
Web 

Specifies the name of the map service that should be used as the default basemap 
for the Lucity Web Map.  Only map services marked as a base map appear in this 
list. 

Default Base Map for 
Mobile 

Specifies the name of the map service that should be used as the default basemap 
for the Lucity Mobile Map.  Only map services marked as a base map appear in 
this list. 

Save Saves edits made in the grid. 

Cancel Closes the window without saving. 
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UTILITY SERVICES 

The Utility Services tab stores information about services that perform various functions within the Lucity Web and Lucity Mobile Maps. 

 The Admin > App Admin permissions are required to change Utility Services settings. 

Geocoding Services Grid 

Name Uniquely identifies the geocoding service; used during setup. 

URL Specifies the URL for the geocoding or parcel services used to find addresses.  To 
switch between the two types of services, check the setting "Use an address layer 
for ..."  

Note: REST/ must precede the word service in the URL.  

Note: If using a parcel service, enter the URL for the map service and add the 

layer number to the end.  For example, if the parcel layer is the 10th layer in the 
service, the end of the URL would look something like: 
...rest/services/baselayers/MapServer/10 

Service is secure? Indicates that the service requires a login and password.  The program will 
retrieve the credentials from the first record in the Map Service grid (see "Map 
Services Tab" on page 293). 

Proxy URL Identifies the proxy address for clients using one. 

Last Modified By Identifies the last user to modify the connection string. 

Last Modified Date Indicates the date the connection string was last modified. 

Last Modified Time Indicates the time the connection string was last modified. 

Grid tools 

Add Geocoding 
Service... 

Adds a new row in which to enter geocoding service information. 
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Delete... Deletes the selected geocoding service. 

Default Geocoding Service Specifies the name of the geocoding service that should be used by default for the 
Lucity Web and Lucity Mobile Map.  Only map services marked as a base map 
appear in the list. 

Save... Saves edits made in the grid. 

Cancel Closes the window without saving. 

  

Geometry Service Grid 

URL Specifies the URL for the ArcGIS Geometry service, which facilitates geometry 
operations in the map, such as buffering and reprojecting coordinates. This field is 
required for the Web Map. 

Service is secure? Indicates that the service requires a login and password.  The program will 
retrieve the credentials from the first record in the Map Service grid (see "Map 
Services Tab" on page 293). 

Proxy URL Identifies the proxy address for clients using one. 

Last Modified By Identifies the last user to modify the connection string. 

Last Modified Date Indicates the date the connection string was last modified. 

Last Modified Time Indicates the time the connection string was last modified. 

Grid tools 

Save... Saves edits made in the grid. 

Cancel Closes the window without saving. 

  

Routing Service Grid 
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URL Designates the URL to be used for a network analysis service. 

Service is secure? Indicates that the service requires a login and password.  The program will 
retrieve the credentials from the first record in the Map Service grid (see "Map 
Services Tab" on page 293). 

Proxy URL Identifies the proxy address for clients using one. 

Last Modified By Identifies the last user to modify the connection string. 

Last Modified Date Indicates the date the connection string was last modified. 

Last Modified Time Indicates the time the connection string was last modified. 

Grid tools 

Save... Saves edits made in the grid. 

Cancel Closes the window without saving. 

Default Vehicle Start 
Address for Work Routing 

Indicates the address that the Routing tool should use as the start location.  If no 
address is supplied, the first Work Order is used. 
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WORK ZONE SERVICES 

The Work Zone Services tab contains grids that store information services used to identify work zones. 

 The Admin > App Admin permissions are required to change the Work Zone Services settings. 

 

Never overwrite 
maintenance or alternate 
zone 

When enabled, prevents the system from overwriting the existing Maintenance 
Zone or Alternate Zone values when these fields are entered on a Request or 
Work Order. 

Maintenance Zone Info 

Maintenance Zone- Field 
Name 

The name of the field that contains the maintenance zone ID in the maintenance 
zone layer. 

Maintenance Zone- Layer 
Index or Alias Name 

The name of the maintenance zone layer in the map service. 

Maintenance Zone- 
Service Name 

The name of the map service that contains the maintenance zone layer.  Found 
under GIS > GIS Services > Map Services tab (on page 293). 

Alternate Zone Info 

Alternate Zone- Field 
Name 

The name of the field that contains the alternate zone ID in the alternate zone 
layer. 

Alternate Zone- Layer 
Index or Alias Name 

The name used for the alternate zone in the map service. 

Alternate Zone- Service 
Name 

The name of the map service that contains the alternate zone layer.  Found 
under GIS > GIS Services > Map Services tab (on page 293). 
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Note: You can also use the Service Lookup buttons to complete these fields.  When using this method, complete the fields in the following 
order: Service Name, Layer Index or Alias Name, Field Name. 

 
 

GIS MAP SETUP 

After map services are configured with Lucity, an agency must create a map in the Lucity Administration Tool by layering map services.   

The Map Setup tool enables administrators to define maps and assign them to different groups of users.  The process is used to create maps for 
the Lucity Web Map, Lucity GIS Viewer, and for Lucity Mobile - Map Mode. 
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Considerations 

 Which map services should be in this map? 

 For which mapping product is this map intended? 

Maps 

This section allows agencies to manage their maps. 

Shared Lists maps that are available for both the Lucity Web and Lucity Mobile 
applications. 

Web Only Lists maps that are only available for the Web application. 

Mobile Only Lists maps that are only available for the Mobile applications. 

GIS Viewer Lists maps that are available for the GIS Viewer application. 

Add Map Setup Adds a new map. 

Edit Map Setup Edits the map selected in one of the grids. 

Delete Map Deletes the map selected in one of the grids. 

Group Assignment for [...] 

This section allows agencies to manage which groups are assigned to the map selected on the left. 

Available Groups Lists user groups that could be assigned a default map.  This list is populated 
with the security groups that are assigned as a Default Rules group in the Lucity 
Security Program. 

Assign Map to Groups 
>> 

Assigns the selected map as the default map for the group(s) selected in the 
Available Groups grid. 

Un-Assign Group to 
Map << 

Removes the association between the selected map and the group(s) selected in 
the Assigned Groups grid. 
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Groups assigned to this 
map 

Lists groups assigned to the selected map. 

Default web map for 
group [...] 

Indicates the map currently set as the default web map for the group selected in 
the Available Groups grid. 

Default mobile map for 
group [...] 

Indicates the mobile map currently set as the default mobile map for the group 
selected in the Available Groups grid.  

Set this map as web 
default for group [...] 

Sets the currently selected web map as the default web map for the group 
selected in the Groups assigned to this map grid. 

Set this map as mobile 
default for group [...] 

Sets the currently selected mobile map as the default mobile map for the group 
selected in the Groups assigned to this map grid. 

System Default Extent 

This section allows admins to set the default extent of the webmap.  This can:  

 Dictate the location the map is opened to.  To force the map to open to this extent every time you must set the Admin Portal > Settings > System Settings 
> GIS Web > Force the GIS Web Map to always open to the default extent setting. 

Current Extent Displays the extent that is currently selected.  The extent can be modified using 
some of the fields below. 

Clear Extent Clears out the Current Extent field. 

Enter url to service or 
layer to calculate an 
extent 

Indicates the web address for the map service or layer (within a service) used to 
calculate the Current Extent field. The program will use the URL to copy the 
service's or layer's Full Extent/Extent and set the Current Extent field. 

Calculate Extent When enabled, calculates the Current Extent from the Enter url to service or layer 
to calculate an extent field. 

Manually Enter Extent Unlocks the Manual Entry field. 
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Manual Entry Field Indicates that the extent should be determined by the parameters provided.  
Enter the desired extent using the following format: 

Xmin, Ymin, Xmax, Ymax, wkid  

Save as new extent Saves the manually entered extent as the Current Extent. 

 

 

Help Launches the Help guide. 

Save... Saves any changes made to the map setup. 

Cancel Cancels any changes made on this screen. 

 

 

 

 

How to set up a Web Map 

How To Add or Edit a Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The map setup appears: 
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2) The left side of the dialog displays all available maps.  Click the Add Map Setup or select a map and click Edit Map Setup buttons to open 
the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 

a. Enter a unique name in the Name field. 

b. Under Lucity applications that can use this map, select Web & Mobile or Web only. 

c. Check the Use as Default Map box to make this the default map. 

d. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in the Lucity Administration Tool, under System > Settings on the GIS Web tab.   

e. Select the service that contains your Redline layers. 
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f. Use the map services listed in the Available Web Services and the Available Editable Services to populate the Services to Display in Map 
grid. 

g. Modify the service settings in the Services to Display in Map grid. 

Note: The Web Map and Mobile Map tools will recognize Lucity data in all layers as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

5) Once the maps have been defined, click Save on the Map Setup screen. 

6) Assign the map to the desired user groups (see "GIS Map Setup" on page 301). 
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How to set up a Mobile Map 

How To Add or Edit a Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The Map Setup appears: 

 

2) The left side of the dialog displays all available maps.  Click the Add Map Setup button or select a map and click the Edit Map Setup button 
to open the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 
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a. Enter a unique name in the Name field. 

b. Under Lucity applications that can use this map, select Web & Mobile, or Mobile only. 

c. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in Lucity Administration under System > Settings on the GIS Web tab.   

d. Select the Redlining layers if you use redlining in your map. 

e. Use the map services listed in the Available Web Services and the Available Editable Services to populate the Services to Display in Map 
grid. 

f. Modify the service settings in the Services to Display in Map grid. 

Note: The Mobile Map tools will recognize Lucity data in all layers as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

a. Select the map in one of the grids in the Maps section. 

b. Select one or more groups you want to access the map in the Available Groups grid.  

c. Click the Assign Groups to Map >> button.  The groups will move to the Groups assigned to this map grid and are now able to access to 
that map. 

d. If the map should be a default map for a group, select the map in the Maps section. 

e. Select the group in the Available Groups grid. 

f. Click the one of the Set the map as... buttons. 

5) Once the maps have been defined, click Save on the Map Setup screen. 

6) Assign the map to the desired user groups. 
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How to set up Viewer Map 

How To Add or Edit a Viewer Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The map setup appears: 

 

2) The left side of the dialog displays all available maps.  Click the Add Map Setup or Edit Map Setup buttons to open the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 

a. Enter a unique name in the Name field. 
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b. Under Lucity applications that can use this map, select GIS Viewer. 

c. Check the Use as Default Map box to make this the default map. 

d. There can only be one default map.  If more than one map exists, the Viewer will ask which one to use.  The default map will appear at 
the top of the list. 

e. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in Lucity Administration Tool, under System > Settings on the GIS Web tab.   

f. The Geocoding Url can be either a URL for a geocoding service OR the path to a geocoding package (.gcpk). 

g. Use the map services listed in the Available Web Services and the Available Local Services to populate the Services to Display in Map grid. 

h. Modify the service settings in the Services to Display in Map grid. 

Note: The Lucity GIS Viewer will recognize Lucity data in all layers, as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

5) Assign the map to the desired user groups. 

Note:  All maps that are marked as GIS Viewer will be visible to all Lucity GIS Viewer users. 

 

How to assign maps to groups 

To assign maps to user groups: 

a) Select a map in one of the map grids list on the left side of the dialog box. 

b) Highlight one or more groups in the Available Groups list on the right side of the dialog box. 

c) Click the Assign Group(s) to Map >> button. 

d) The groups will appear in the Groups assigned to this map grid. 
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e) When a user logs into the web map or mobile map they will be able to look at any map that is assigned to a group that they are a part of. 

Note: Groups and Users are created and associated in the Lucity Security program. 

How to set default maps for groups 

1) Select the map that you want to set as a Default map for a group. 

2) Review the groups in the Groups assigned to this map grid. 

o If the group you want to assign the map to as a default is not in this grid you need to select the group in the Available Groups grid and 
click the Assign Group(s) to Map >> button. 

3) Select the group in the Groups assigned to this map grid. 

o To set the map as the group's default web map click the Set this map as web default for group [...] button. 

o To set the map as the group's default mobile map click the Set this map as mobile default for group [...] button. 

Note: These buttons are grayed out if an incompatible map is selected. 

4) When the user opens the web map it will default to the map listed under Default web map for Group [...]. 

5) When the user opens the mobile map it will default to the map listed under Default mobile map for Group [...]. 

Note: Because each group can have a default map, and each user can have multiple groups the web and mobile maps will use the default 
map assigned to the user's Default Rules Group.  Each user can only have one Default Rules Group, which is assigned in the Lucity Security 
program. 

More information about adding and editing web maps>> (see "Map Editor" on page 312) 
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MAP EDITOR 

The Map Editor screen allows administrators to design a map using the map services they have configured. 
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Name Specifies a unique name for the map. 

Lucity application(s) that 
can use this map 

Indicates which Lucity mapping program this map is designed for.  This interface 
is used to create maps for Lucity Web, Lucity Mobile, and the GIS Viewer. 

 Web & Mobile, Web Only, Mobile Only, GIS Viewer 

Geocoding 

Specifies which geocoder the map will use. 

Default Geocoding URL This is the default geocoder that the map will use if you don't select another one.  
This is set in the URL for Geocoding Service ... setting under System > Settings > 
GIS Web tab (http://help.lucity.com/webhelpv170/web/index.htm#38257.htm). 

Geocoding URL (if 
different than default) 

Enter a URL here if the geocoding service used for this map will be different than 
the URL in the Default Geocoding Url box. 

Redlining 

Controls which redlining layers appear in the map. 

Select the feature service 
that contains the redlining 
layers 

Select the Redlining map service from the drop-down if users need to use the 
redlining tool in the map.  (This list only displays the feature services configured 
in the Map Services (see "GIS Map Services" on page 292) tool.) 

Point Index Indicates the number for the redlining point layer in the redlining map service. 

Polyline Index Specifies the number for the redlining line layer in the redlining map service. 

Polygon Index Indicates the number for the redlining polygon layer in the redlining map service. 

 

Available Services 

Available Web Services Lists all web map services (those services entered into the Map Services tool that 
are not map packages and do not have the Has Feature Service box checked). 

http://help.lucity.com/webhelpv170/web/index.htm#38257.htm
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Add >> Adds the map services selected in the Available Web Services list to the map.  
The services will appear in the Services to Display in Map list. 

Available Editable Services Lists all editable web map services (those services entered into the Map Services 
tool that are not map packages and have the Has Feature Service box checked). 

Add >> Adds the editable map services selected in the Available Editable Services list to 
the map.  The services will appear in the Services to Display in Map list. 

Available Local Services Lists all map packages [those services entered into the Map Services tool that are 
map packages (paths to .mpk files)]. 

Add >> Adds the local services selected in the Available Local Services list to the map.  
The services will appear in the Services to Display in Map list. 

Services to Display in Map 

Lists all of the map services that are in the map. 

Name Displays the name of the map service. 

URL Displays the URL/path to the map service 

Order Displays the default sequence of the layers, based on the Order entered in the 
Map Services (see "GIS Map Services" on page 292) tool. 

Order Override Allows the user to adjust the sequence of layers for this map by ordering the 
items in this column.  0 is the lowest layer in the map. 

Disable Identify Prevents users from identifying or selecting features in a map service. 

Disable Edits Prevents users from editing a specific map service in this map. 

Disable Visibility Hides the selected map service.  Services with visibility disabled are turned off 
when the map is initially accessed; however, users can turn them back on.  
Disabling  visibility of map services makes the map load faster. 
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Default Extent Marks a single layer as the default extent.  That is, the service's extent will be 
the default extent for the entire map when it is loaded. 

This function requires the Force the GIS Web Map to always open to the default 
extent setting to be enabled under System > Settings > GIS Web tab 
(http://help.lucity.com/webhelpv170/web/index.htm#38257.htm). 

 

<< Remove Removes the service selected in the Services to Display in Map list. 

Close Closes the Map Editor. 

 
 

http://help.lucity.com/webhelpv170/web/index.htm#38257.htm
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SECURITY 

The Security menu gives access to the Security program as well as the ability to grant groups access to views and forms.  This feature is used 
concurrently with the group management function available in the Security program.   

Note:  For additional information on the Security program, see the Security Help Guide included with Lucity Desktop: Program Files > 
Lucity > Admin Tools > Lucity Security Help.   

 

MENU OPTIONS 

Security 
(http://help.lucity.com
/webhelp/v750/securit
y) 

Launches the Security program from Lucity Administration for Web Apps 
Help. 

Assign Groups to 
Views/Forms (on page 
317) 

Allows administrators to grant groups access to views and forms, as well 
as set a default Work Order form for a Default Rules Group. 

 
 

http://help.lucity.com/webhelp/v750/security
http://help.lucity.com/webhelp/v750/security
http://help.lucity.com/webhelp/v750/security
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ASSIGN GROUPS TO VIEWS/FORMS 

The Assign Groups to Views/Forms feature enables administrators to assign different user groups to defined Views and Forms.  They can also 
assign default Forms to a group.   

Note: This section is disabled if the System > Settings > Website tab > Allow All Users Access to All Views setting is enabled. 

This module may be accessed through the Administration Tool at: Security > Assign Groups to Forms. 
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LEFT COLUMN 

Groups Displays a list of groups from the Security module. 

Group Properties Displays a list of Views/Forms assigned to the selected group. 

Groups Assigned to 
Views/Forms 

Displays a list of groups that are assigned to each View/Form. 

 

CENTER COLUMN 

Module Selection 
Drop-downs 

Selects a program, a module, and one of its components.  This controls which 
Views/Forms are displayed in the Available Views/Forms grid. 

Show Only Views, Not 
Forms 

Hides all Forms in the Available Views/Forms grid. 

Show All Views/Forms Overrides the module selection drop-downs and displays all Views and Forms for 
every module. 

Show Program 
Views/Forms 

Displays all the View/Forms for all modules and components underneath the 
selected program in the first drop-down. 

Show only Timesheet 
Forms 

Overrides the module selection drop-downs to only display the Timesheet Forms. 

Assign Groups Assigns the Views/Forms selected on the right to the groups selected on the left. 

 

RIGHT COLUMN 

Available Views/Forms Lists Views and Forms that can be assigned to groups. 

Refresh List Refreshes the Available Views/Forms grid. 
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How to assign Groups to Views and Forms 

1) Select one or multiple groups from the Groups box on the left side of the screen. 

2) In the center of the screen, select the Program, Module, and Section of the module.  (For example, to see the Forms for a Work Order, 
select Work Order Manager, Work Orders, Work Orders. 

o This filters down the Available Views/Forms column down to forms just for that section of the module. 

o To show all forms at once, check the Show all Views/Forms box. 

3) Select one or multiple forms from the Available Views/Forms box on the right side of the screen. 

4) Click the Assign Groups button.  All selected Groups will be associated with all selected Forms. 

Note:  If a Form will be accessed by the public, the group assigned must contain the Lucity login account that is used with the public 
application.  Refer to the System > Settings > Citizen section for the public Login ID. 

Note: This step is not necessary if the System > Settings > Website tab > Allow All Users Access to All Views setting is enabled. 

How to view Group properties 

1) Select a group in the Groups column. 

2) Click the Group Properties button in the bottom-left corner. 



 

320 

 

 

3) The Group Properties window appears, displaying the users in the group and the Forms to which the group is assigned. 

 

How to view Groups assigned to Views/Forms 

1) In the center of the screen, select the Program, Module, and Section of the module.  For example, to see the Views/Forms for a work order, 
select Work Order Manager, Work Orders, Work Orders. 

o This filters the Available Views/Forms column to display only Forms for that section of the module. 
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2) Click the Groups Assigned To Views/Forms button.  The following pop-up appears: 

 

3) Select a View or Form on the left to see a list of groups assigned to it on the right. 

4) Close the window when finished. 

How to remove access to a Form 

1) In the Assign Groups for Views/Forms window, select the Group and click the Group Properties button. 
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2) In the Group Properties window, select the Form and click Remove access to selected form(s).  The Form will be removed from the list. 
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HELP 

The Security Help menu provides links to Help documentation and resources, as well as general product information. 

 Click on Help Topics or hit F1 to launch the Lucity Administration for Web Apps Help File. 

 Click Lucity Help Portal and Search to launch the Lucity Help portal to view/search all Help Guides. 

 Select About... to view the product version information. 
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LUCITY USER IMPORT TOOL 

The Active Directory Import tool enables organizations to integrate Lucity Security with their Windows Active Directory.  This integration 
streamlines user administration by allowing Lucity Security to be partially managed via Active Directory.   

Success of the import relies on having Active Directory groups and Lucity groups with identical names.  When an administrator runs the import, 
Lucity checks the Active Directory groups to determine which users are present and performs the following actions: 

 If a user is in one of the Active Directory groups that corresponds to a Lucity group but is not in the Lucity Security program, the user is added 
to Lucity. 

 If a user is in an Active Directory group but is not in the corresponding Lucity Security group, the user is added to the the Lucity group. 

 If a user is in not in an Active Directory group but is in the corresponding Lucity Security group, the user is removed from the Lucity group. 

 Optionally, if a user is no longer in Active Directory but is found within Lucity, the user remains in Lucity,  but the account is disabled. 

 

 To run this tool, a user must have the Lucity App Admin or Lucity IT Admin permission. 
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TEMPLATE SETUP TAB 

The User Import tool's Template Setup tab lets administrators create, edit, and delete Active Directory Import templates. 
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TEMPLATE SETUP 

Select Template to Edit Displays a list of User Import templates that have been created and saved in an 
agency's system. 

Path Indicates the path to an agency's Active Directory or LDAP. 

Provider Indicates whether users should be imported from Active Directory or LDAP. 

Lucity Logon Sets the field from AD/LDAP that will be used as the Lucity login. 

First Name Sets the field from AD/LDAP that contains the users' first names. 

Last Name Sets the field from AD/LDAP that contains the users' last names. 

Email Sets the field from AD/LDAP that contains the users' email addresses. 

Windows Login* Sets the field from AD/LDAP that contains the users' Windows logins. 

Windows Domain* Identifies the domain under which users are running. 

Template Name Provides the name of the template if it is new. 

Enable Application 
Authentication 

Allow imported Lucity users to log into Lucity using a Lucity login and password. 

Disable User is Allowed Directs the import to disable users in Lucity who are no longer found in a 
corresponding AD/LDAP group.  

Permits the import to remove users from Lucity security groups if the users are no 
longer in the corresponding AD/LDAP group. 

Note: The user is not removed from Lucity.  They are just disassociated from the 

Lucity security groups. 

Delete Template Deletes the template currently selected in the Select Template to Edit field. 

Create Template Creates a new template. 
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Save Saves edits to the current template. 

* When both of these fields are completed, users are not required to enter a login and password when logging into Lucity applications.  With 
the exception of Lucity Mobile, all Lucity applications will automatically match the user logged into Windows to the correct Lucity user. 
 

IMPORT PROCESSING TAB 

The User Import tool's Import Processing tab allows administrators to select an Active Directory Import Template and process it.  The tab also 
displays a log of the import results. 
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IMPORT PROCESSING 

Choose Template to 
Process 

Provides a drop-down list of available Active Directory Import Templates.  These 
templates are created on the Template Setup tab. 

Process Runs the import using the selected template. 

 
 

HOW TOS 

The following sections discuss how to set up the Lucity User Import. 

 
 

SECURITY STRUCTURE 

How to set up Lucity Security 

1) Plan out your security groups. 

o Identify which groups you should create and what permissions each group requires. 

o Consider Lucity's Suggested Security Group Setup (http://help.lucity.com/webhelp/v170/security/index.htm#39729.htm). 

Note: You may want to add a 'Lucity_' prefix to all of the security groups.  That way, all matching groups in Active Directory/LDAP are 
grouped together. 

2) Add your Lucity Security groups. 

http://help.lucity.com/webhelp/v170/security/index.htm#39729.htm
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3) Click New Group (under the Groups grid).  The following window appears: 

 

4) Enter a Group Name and click Ok.   

5) Assign the desired permissions to the Lucity Security groups. 

Modules View Method 

1) In the Groups grid, select one or more groups to which to grant a permission. 
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2) In the Modules View tab, under Permission Controls, expand the module suite for which the permissions will be granted. 

 

3) Check the box next to the desired modules within the suite.   

Note: To grant a group all of the permissions in the Park suite, check the box next to Park.  The system will check all modules underneath 
the root. 

4) Select one or more permissions in the Permissions grid. 

Note: Hold down the Shift or Ctrl keys while clicking to select multiple items. 

5) When all desired permissions are selected, click the << Grant button.  The system grants the selected permissions to the selected group(s). 
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Permissions View Method 

1) To grant a particular permission—like the General-Edit permission—for multiple modules in the Lucity program, select a group(s) in the 
Groups grid. 

2) Open the Permissions View tab.  

3) Select the desired Permission from the grid on the left. 

s 

4) Select the Modules to which to apply the permission and click the << Grant button.  The system grants the permission(s) to the selected 
group(s). 
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Note: Hold down the Shift or Ctrl keys while clicking to select multiple items. 

 

How to set up AD/LDAP 

1) Set up Active Directory groups using the same names as the Lucity Security groups. [Add the note about adding Lucity__ in front of each name?] 

2) Add the Lucity users' Windows accounts to the appropriate Active Directory groups. 

Is this topic complete?  It was still in the Blue "Notes" release state... 
 

USER IMPORT SETUP 

How to set up an Import Template 

1) Open the Lucity User Import. 

2) Click on the Template Setup tab. 

3) Click the Create Template button. 

4) Enter the Path to the Active Directory or LDAP. 

o The first time an administrator runs the import, it will attempt to set the path based on the domain it is running under. 

o When setting up a second template or modifying the original Path, you must click Save and Close and reopen the Lucity User Import.  
Doing so allows the User Import to query the data source and return the data required for the next step. 

5) Select the Provider. 

6) Identify the fields from the source data that will supply the users': 

o Lucity Logon (Typically, the same as the Windows login.) 

o First Name 
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o Last Name 

o Email 

o Windows Logon 

7) Enter the Windows Domain. 

8) Choose whether to Enable Application Authentication for the imported users. 

9) Choose whether to enable the Disable Users Is Allowed option, which directs the import to disable Lucity users that are no longer in the 
corresponding Active Directory/LDAP groups. 

10) Click Save. 

 

 

 

 
 

RUNNING THE IMPORT 

The User Import can be run manually on a one-time basis, or it can be run on a schedule using a Windows Scheduled Task or the Lucity Services. 

How to run the Import manually 

1) Find the Lucity.ImportUsers.exe.  This file is installed automatically with Lucity Desktop and with the Lucity Services. 

o C:\Program Files (x86)\LucityServices\Lucity.ImportUsers.exe 

o C:\Program Files (x86)\Lucity\bin\Lucity.ImportUsers.exe 

2) On the Import Processing tab, select the Import Template that you would like to use. 

3) Click the Process button. The application will run using the template and log the results at the end of the process. 
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How to run the Import as part of a script 

The Lucity User Import can be run as part of a script, or as part of a Windows scheduled task.  

Use the following syntax to run the import as part of a script. 

C:\Program Files (x86)\LucityServices\Lucity.ImportUsers.exe CLINT001 "AD Template" 

  

 CLINT001 - The client identifier.  Will be like CLINT001, CLINT002, etc... 

 AD Template - The name assigned to the of the import configuration. 

How to run the Import as part of a windows scheduled task 

1) After configuring your import use the following steps to schedule the import. 

2) Access the server that is running the Lucity Services. 

3) Login as a windows users with administrative privileges.   

4) Locate and run the Lucity.ImportUsers.exe.  This is typically located in the C:\Programs FIles (x86)\Lucity Services directory. 

5) Login using a lucity login and password or windows authentication.  These credentials must be for a user that has permission to access the 
security program. 

6) Go to the computer's Control Panel and open Administrative Tools. 

7) Open the Task Scheduler. 
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o On the left side select Task Scheduler Library. 

 

o Right-click on it and select New Folder. 

o Name the new folder Lucity. 

8) Right-click on the Lucity folder and select Create Task... 

9) On the General tab... 

a. Enter the Name of the task.  It is suggested to name it the same as the Import User Configuration that the task will run. 

b. Enter a Description of the task. 

c. Select the Run whether user is logged on or not button. 

d. Check the Run with highest privileges box. 

10) Select the Triggers tab. 

a. Click the New... button. 

b. On the new trigger pop-up enter the schedule that you want the task to follow. 

c. Click OK. 

11) Select the Actions tab. 

a. Click the New... button. 

b. In the Program/script field browse to the Lucity.ImportUsers.exe. 

c. Enter the parameters in the Add arguments field.  These are listed in the previous How To. 
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d. In the Start In field enter the path to the Lucity Services folder.  C:/Program Files (x86)/Lucity Services 

e. Click OK. 

12) Click OK. 

13) The task will ask for windows credentials.  Use the credentials for a windows user that has permission to run the .exe and has a 
non-expiring password. 

 

 
 

ADD EMPLOYEES 

The User Import tool automatically adds users into the Lucity system; however it does not automatically create matching Employee records in the 
Lucity > Work Flow Setup > Employee Setup module.  To create Employee records,  an administrator must use Lucity's Import and Update 
program.   

How to automatically add employees to Lucity from Active Directory 

1) In the Import and Update program, create a new Import configuration. 

2) Enable the Allow adding new records option. 

3) Set the Work > Work Employee Setup module as the destination for the import data. 

4) Indicate that Active Directory will be the source of the import data. 

5) Map your employee data to the appropriate Lucity fields, making sure to load Lucity login IDs into the Login ID field. 

6) Run the Import and Update manually or as part of a schedule. 
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More information about configuring and running the Import and Update (http://help.lucity.com/webhelp/v170/import/#34616.htm) 

 

 

DATA QUALITY TOOL 

http://help.lucity.com/webhelp/v170/import/#34616.htm
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The Data Quality Tool enables administrators to check the quality of their data using preconfigured SQL statements.  The Data Quality tool can 
uncover issues ranging from an incomplete field to incorrect calculations. 

To launch the Data Quality tool, go to a machine that has Lucity Desktop installed and run the C:\Program Files 
(x86)\Lucity\bin\Lucity.DataQuality.exe program. 

 Requires the Lucity App Admin permission. 

 Overview Video 
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Query Selection Tools 

The Query Selection tools, which appear at the top of the program, let users choose which Data Quality query(ies) they wish to run. 

Select a Database 
Provides a list of Lucity programs.  Select the program that contains the module 
you would like to run a Data Quality query against. 

Query List Lists all available queries. 

Group 

Indicates whether the query belongs to a query group.  Queries are organized 
into groups based on how critical potential data errors might be.  Groups of 
queries can be run together. 

Count 
Indicates how many records the query identified.  The Count displays "-1" until 
the user runs the query. 

Test Name Lists the name of the test. 

Module 
Indicates the module the query applies to.  If the query does not apply to a 
specific module, the word 'None' appears. 

Description tab Provides more detailed information about the query.   

Sometimes, a stored query is not designed to be run by the Data Quality tool (e.g., 
queries that are designed to delete bad records).  In such cases, this field 
displays the query that a DBA can run against the database. 

SQL tab Displays the SQL statement that is being run for the selected query. 

Run Selected Query Runs the query selected in the Query List.  Any queries that produce results will 
open a tab in the Results grid. 

Number of Open Tabs Provides a count of the tabs that have produced results. 

Open Lucity Web Opens Lucity Web and displays the records that appeared in the selected tab of 
the Results grid. 

Select Group Queries Enables the user to select a group of queries to run. 
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Run Group Query Runs all the queries in the selected group.  Any queries that produce results will 
open a tab in the Results grid. 

Fix It This button appears for queries that require a simple fix.  Click this button to 
resolve issues discovered by the selected query. 

Reprocess Selected This button appears for the Spatial records query.  It clears errors on failed 
records which allows the Spatial Indexer to reprocess them. 

 

Results Grid 

Displays the results of the query(ies) as tabs.  Located at the bottom of the screen.   

 

STREET RENAMING TOOL 
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The Street Renaming Tool provides a way to quickly update a Street Name on every record in which it appears throughout the Lucity system.  
This feature is helpful when an agency needs to correct a misspelling or to update a street whose name has changed. 

To launch the Street Renaming Tool, go to a machine that has Lucity Desktop installed on it and run the C:\Program Files 
(x86)\Lucity\bin\Lucity.StreetRenamingTool.exe program. 

 Requires the Lucity App Admin permission. 
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OLD STREET NAME 

Select Street Allows the administrator to select the Street Name that needs to be 
changed from the Street Name List.  Type in the field to begin searching 
for a Street Name. 

Type Street Allows the administrator to type in the Street Name that needs to be 
changed. 

Select Street To change This section changes depending on whether the user chose to Select 
Street or Type Street. 

Select Street 

 

Type Street 
 

NEW STREET NAME 

Change Street to this 
name 

Allows you to select the street name from the street name list that you 
want to change the street to.  Type in the field to search for a street 
name. 

FILTERING OPTIONS 

For This City Identifies the city in which the Street is located.  If records are filtered by 
City, the system only changes the Street Name on Address records with 
the specified City. 

In This State Identifies the state in which the Street is located.  If records are filtered by State, 
the system only changes the Street Name on Address records with the specified 
State. 



 

343 

 

 

BUTTONS 

Update GIS Directs the system to update street address fields in the geodatabase that 
are linked to street address fields in Lucity. 

Close Closes the tool. 

Run Runs the tool with the current selection. 

 

 

How to change a Street Name 

1) Choose whether to select a street name from the Street Name List or to type in a street name. 

o Select Street - Begin to type in the street name.  The tool displays a list of matching Street Names.  Select one. 

 

o Type Street - Type in the complete Street Name.  The tool will only update records that match this information exactly. 

 

2) Select a Street Name to replace the one identified in Step 1.  Begin to type in the street name.  The tool will display a list of matching 
street names.  Choose one. 

 

3) Enter the City and State, if desired.  If the user provides this information, the system filters the street records to only update those with 
matching City or State values. 

4) Mark whether to update the Street Name in the GIS, as well. 
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5) Click Run.  The program indicates the number of records that were updated in each table. 

 

6) Click Close when complete. 

 

The application logs events or error 
messages to certain rolling log files, 
which may be found in the following 
locations: 

PROGRAM LOG LOCATION PURPOSE 

ERROR AND EVENT LOGS 
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Lucity 
Desktop 

rolling.log %APPDATA%\Lucity\Logs  

on the workstation 
machine for the current 
user 

Records the use of the Lucity Desktop and Lucity 
Administration Tool programs by the current 
Windows user on this machine. 

 gslog.htm %APPDATA%\Lucity 

on the workstation 
machine for the current 
user 

Tracks Lucity Desktop's attempts to communicate 
with and update the geodatabase. 

Lucity 
Administrati
on Tool 

rolling.log %APPDATA%\Lucity\Logs  

on the workstation 
machine for the current 
user 

Records the use of the Lucity Desktop and Lucity 
Administration Tool programs by the current 
Windows user on this machine. 

Lucity.User.I
mport.exe 

rolling.log %APPDATA%\Lucity\Logs 

On the workstation or 
services server for user 
running the .exe. 

Records the use and import process for the 
Lucity.User.Import.exe. 

Server Logs 

Lucity Web rolling.log inetpub\wwwroot\[Virtu
al Directory]\logs  

Logs the activities of the Lucity Web program for all 
users connected to it. 

Lucity 
Services 

rolling.log %APPDATA%\Lucity\Logs 

On the server, under the 
user set to run the 
services 

Logs the activities of the Lucity PM service. 

Upgrade Logs 
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Client 
Maintenanc
e 

ClientMaint
enanceError
.log 

%APPDATA%\Lucity 

on the workstation 
machine for the current 
user 

Records any errors that occur in client maintenance 
during configuration and the database upgrade.  
Errors are logged as part of the server/database 
upgrade, or when run manually from the desktop 
computer. 

 

Note: Error logging is enabled by default, but additional logging options can be turned on in the corresponding logging.config. 

Note: It is possible to configure the logs to write to the Event Viewer or to other places, such as a SQL database, a text file, or emails.  Using 
alternate logging destinations requires additional coding by the end-user. 
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HOW TO: SET UP LUCITY WEB 

Lucity Web applications and tools configured in Lucity Web 

The following Lucity Web applications and tools are configured in Lucity Web.  Please review the full setup instructions. 
(http://help.lucity.com/webhelp/v170/web/#35014.htm) 

 Dashboard 

 Documents 

 Links 

 Reports 

 Timesheets 

 Work Scheduler 

 

Lucity Web applications and tools configured in the Lucity Administration tool 

The following sections explain how to set up standard components of Lucity Web from start to finish. 

 Views, Grids, and Forms (see "View/Form Manager" on page 145) 

 Map Setup (see "Lucity Web Map Setup" on page 349) 

 Web attribute updates to the Geodatabase (http://help.lucity.com/webhelp/v170/gis/index.htm#34240.htm) 
 

http://help.lucity.com/webhelp/v170/web/#35014.htm
http://help.lucity.com/webhelp/v170/gis/index.htm#34240.htm
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MAP SETUP 

The Lucity mapping applications enable agencies to provide mapping information to their employees that use Lucity Web.  These sections 
explain how to set up a map for both the Lucity Web Map and the Lucity GIS Viewer.  The Lucity Mobile application uses a similar set-up 
process.   

Note: Before configuring maps, an agency must configure the geodatabase with Lucity. 

  

 
Lucity Web map (see "Lucity Web Map Setup" on page 349) 

 
Lucity GIS Viewer (see "Setup Lucity GIS Viewer" on page 426) 

 
Lucity Mobile 
(http://help.lucity.com/webhelp/mobile/android/mobile/v101/full/index.htm#271
39.htm) 

 
 

http://help.lucity.com/webhelp/mobile/android/mobile/v101/full/index.htm#27139.htm
http://help.lucity.com/webhelp/mobile/android/mobile/v101/full/index.htm#27139.htm
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LUCITY WEB MAP SETUP 

The Lucity Web Map gives users tools to interact with Lucity data.  

To create the Web Map, administrators combine map services published to the web.  These services can come from Microsoft Bing Maps, free 
online web services, or an agency's own published map services.  Administrators can also create custom maps for different parts of the 
organization. 

This section provides links to step-by-step instructions for configuring the Web Map. 
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Note: The geodatabase configuration and alias configuration must be completed before performing these steps. 

Requirements 

 Lucity Web installed 

 Lucity Web Map license 

Configuration Steps 

1) Web Server/ArcGIS server configuration (see "Web Server/Arc Server Configuration" on page 352) 

2) Configure users and permissions (see "Configuring Users" on page 356) 

3) Building map services (on page 363) 

o Alias configuration (on page 365) 

4) Map service configuration (see "Map Services Configuration" on page 376) 

o Bing maps 

5) Base maps 

6) Red-lining (see "Red-Line Configuration" on page 384) 

7) Map setup (see "Map Setup for Web Map" on page 425) 
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WEB SERVER/ARC SERVER CONFIGURATION 

When deploying the Lucity Web Map, the web server that hosts Lucity Web must be able to talk to the web server that hosts ArcGIS Server.  If 
both of these applications are on the same server, no further setup is required.  However, when Lucity Web and Arc Server are hosted on 
separate servers (which is common), administrators must create either a ClientAccessPolicy.xml or a CrossDomainPolicy.xml.  Silverlight will 
always first attempt to check for and download a ClientAccessPolicy.xml file.  If it cannot find a client access policy, Silverlight will look for a 
CrossDomain.xml file.   

Automatic Configuration 

ArcGIS Server 10.1 and higher can configure this relationship automatically using the ArcGIS Web Adapter 
(http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000005m8000000). 

 

Manual Configuration 

One or both of these XML files MUST be placed on the ArcGIS Server in the root folder in which ArcGIS is installed.   

For example: 

o ArcGIS Server is installed to C:\inetpub\wwwroot\ArcGIS\Manager -  Place these files in C:\inetpub\wwwroot. 

o ArcGIS Server is installed to C:\inetpub\gisroot\ArcGIS\Manager -  Place these files in C:\inetpub\gisroot. 

The presence of the ClientAccessPolicy.xml and CrossDomainPolicy.xml files opens a hole in the ArcGIS Server machine's security that allows 
Silverlight applications on other servers to communicate with ArcGIS Server.  The type of policy an agency applies dictates which types of 
machines allowed to communicate with ArcGIS Server. 

Policy examples are provided below.  Feel free to copy, paste, and modify these examples. 

ClientAccessPolicy.xml 

Allows traffic from any domain/site 

http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000005m8000000
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EXAMPLE COPYABLE CODE 

 

<?xml version="1.0" encoding="utf-8"?> 

<access-policy> 

    <cross-domain-access> 

        <policy> 

            <allow-from http-request-headers="*"> 

                <domain uri="*"/> 

            </allow-from> 

            <grant-to> 

                <resource path="/" 
include-subpaths="true"/> 

            </grant-to> 

        </policy> 

    </cross-domain-access> 

</access-policy> 

 

 

 

Allows traffic from a specific site (http://www.mysite.com) 
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EXAMPLE COPYABLE CODE 

 

<?xml version="1.0" encoding="utf-8"?> 

<access-policy> 

    <cross-domain-access> 

        <policy> 

            <allow-from http-request-headers="*"> 

                <domain uri="http://www.mysite.com"/> 

            </allow-from> 

            <grant-to> 

                <resource path="/" include-subpaths="true"/> 

            </grant-to> 

        </policy> 

    </cross-domain-access> 

</access-policy> 

 

Allows traffic from an intranet web server (Norway) 
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EXAMPLE COPYABLE CODE 

 

<?xml version="1.0" encoding="utf-8"?> 

<access-policy> 

    <cross-domain-access> 

        <policy> 

            <allow-from http-request-headers="*"> 

                <domain uri="http://NORWAY"/> 

            </allow-from> 

            <grant-to> 

                <resource path="/" include-subpaths="true"/> 

            </grant-to> 

        </policy> 

    </cross-domain-access> 

</access-policy> 
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CrossDomainPolicy.xml 

Allows Adobe or Silverlight traffic from any web site (or web server) to access resources on the web site 

EXAMPLE COPYABLE CODE 

 

<?xml version="1.0"?> 

<!DOCTYPE cross-domain-policy SYSTEM "http://www.macromedia.com/xml/dtds/cross-domain-policy.dtd"> 

<cross-domain-policy> 

    <allow-http-request-headers-from domain="*" headers="*"/> 

</cross-domain-policy> 

 

 

 

 
 

CONFIGURING USERS 

Two items must be configured in the Lucity Security program in order for a user to access the Lucity Web Map:  

1) The user needs permission to access the Web Map.   

2) The user must be assigned to a Default Rules Group.   The Default Rules Group controls which Web Map that user sees.  This setting is also 
used elsewhere in the Web Map setup. 
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Considerations 

 Which users should have access to the Web Map? 

 Which group's Web Map should each user see? 

 

How to give users permissions to view the Web Map 

1) In the Lucity Security program go to Security > Permission Setup  

2) On the left select the group(s) or user(s) that should have access to the Lucity Mobile app 

3) On the right in the Modules View expand the GIS node and check the GIS Web Map box. 

4) In the Permissions list select the Run permission 

5) Click the Grant Button 
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Note: The Permissions Screen may look different depending on settings under the View menu. 

 

How to assign a user to a default Group 

1) In the Lucity Security program go to Security > User/Group Setup.  The following screen will appear. 
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2) Select a user from the list and click Edit User(s). 

 

3) Select a group out of the Default Rules Group and click OK 

 

-OR- 
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1) In the Lucity Security program go to Security > User/Group Setup.  The following screen will appear. 
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2) Select the record or records in the grid to assign one default group to.  Click in the Default Rules Group field and select the group to apply 
to those users. 
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BUILDING MAP SERVICES 

In order for Lucity Maps to interact with Lucity data, GIS administrators must create maps containing Lucity features in ArcMap and publish them 
to ArcGIS Server.   

Consider these factors when publishing map services: 

Requirements 

Each feature class in a map that links to Lucity must have the following fields visible when the service is published: 

 Lucity Common ID - The field that links to the related Lucity module's user-defined ID for the asset. 

 Shape - The Esri field that controls geometry.  This field should also be the last field in the list of fields. 

Optimization 

 Include the Lucity Auto ID field.  This field links to the related Lucity module's system-defined ID for the asset.  While this field is not 
required by the Web Map, some functions will perform better with the Auto ID present.  

 Use scale-dependent rendering wherever possible.  Scale-dependent rendering speeds up the map display and reduces server load, which 
makes for a better end-user experience. 

 Use MSD-based map services.  MSD (map service definition) services are optimized for faster rendering and provide other advantages, as 
well. 

 Take advantage of ArcGIS's Analyze Map tool.  The Analyze Map tool verifies the integrity of the map and suggests methods for optimizing  
it for web use.  See the ESRI documentation on the tools, available in ArcMap under Customize > Toolbars > Map Service Publishing, for 
more information. 

 Cache certain services to save download and server time.  Lucity recommends caching map services for base-layer data that does not 
change; however, caching is a time- and server-intensive process.  It's important to fully understand the implications of the caching 
process before establishing one.  Map-caching is documented in the ArcGIS Server help documentation installed with the ArcGIS Server 
product. 

Secured Map Services 
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 The Webmap supports secured map services. 

 An authorized login and password can be included in the setup for the configuration or users can be required to enter a username and 
password when they launch the webmap. 

 When secured services are loaded in the Web Map, the data will not appear until a authorized username and password have been entered. 

 Lucity currently only supports securing services using ArcGIS Token Authentication.  We do NOT support Web Tier Authentication. 

Multiple-Layer Caches 

 The Webmap does not support multi-layer caches.  

Notes 

 The background color for dynamic services is always transparent. 

 Map services must be deployed as pooled services.  ESRI's Silverlight components do not support services that are not pooled. 

Resetting the REST Cache 

Caching with ESRI’s REST API improves performance and reduces server load.  Any time services are added, removed, updated, or upgraded to a 
new version, the REST cache may need to be reset.  See the ESRI help article 
(http://resources.esri.com/help/9.3/arcgisserver/apis/rest/index.html) for instructions. 
 

http://resources.esri.com/help/9.3/arcgisserver/apis/rest/index.html
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ALIAS CONFIGURATION 

An alias is an alternate name for a feature class that gives the feature class a unique identity.  The Lucity mapping applications (Web Map, GIS 
Viewer, and Mobile) check the feature classes that are loaded into them and their display names against the aliases listed in the geodatabase 
configuration to determine which feature class links to which module. 

Note: The geodatabase configuration must be complete before an administrator can configure Lucity to recognize aliases. 

Note: An administrator must establish and import aliases to the geodatabase configuration in order for the Lucity mapping applications to 
work. 

  

Setting an Alias 

An administrator can either set an alias for a feature class within ArcCatalog or set aliases on a per-map basis in ArcMap.  Feature class aliases 
are tied to the feature class in ArcCatalog.  Per-map aliases are set in ArcMap and are only saved for that .mxd, or for any map services or map 
packages generated from that .mxd. 

Note: Aliases must be completely unique throughout the geodatabase configuration.  For example, a Sewer Pipe feature class and a Water 
Pipe feature class cannot both have a "Pipes" alias. 

Note: Aliases should not start with a number. 

How to set a feature class alias in ArcCatalog 

1) In ArcCatalog, navigate to the desired feature class. 

2) Right click on it and select Properties.... 

3) On the General Tab there are Name and Alias fields.  Set the Alias to the desired value.  Do NOT change the name. 
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Note: By default, the Alias is the same as the Name. 
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4) Click OK.  The alias is now set for the feature class. 

How to set a map-specific alias in ArcMap 

1) In ArcMap, click on a feature class in the table of contents and rename it.  

OR  

Right-click on the feature class and select Properties. 
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2) On the General Tab, change the name in the Layer Name field. 
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3) Click OK.  The new alias is now set for that feature class.   

4) Repeat for other desired feature classes. 

 

  

 

Import Aliases 

Aliases can be imported into the Lucity geodatabase configuration in two ways: 1) by importing the feature class alias or 2) by importing the 
per-map aliases.   

How to import the feature class alias(es) in ArcCatalog 

1) In the Geodatabase Configuration tool, select the geodatabase connection or the feature class for which you wish to import an alias. 

2) Right-click on the selected geodatabase or feature class and select the Import tool. 

o If it is a geodatabase, the tool is Import Feature Class Alias Names. 

o If it is a feature class, the tool is Import Feature Class Alias Name. 

The system immediately begins importing aliases from the feature class aliases set in ArcCatalog.  A log screen appears to provide 
information about the import. 

3) Review and close the log screen when the process is complete. 
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How to import per-map aliases in ArcMap 

1) On the Lucity Edit toolbar, click the Alias Import button.  The following message appears: 

 

2) Click Yes to continue.  The process log displays the results: 
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Importing aliases using this method directly links them to the feature classes' Alias Names tab in the geodatabase configuration. 

Note: This import enables users to load their feature classes into a map.  Change the names of the layers, and then quickly import them 
before publishing the .mxd as a map service or map package. 

  

 

Manage Aliases 

Aliases can be added manually for each feature class and managed in the Geodatabase Configuration tool. 

How to manage aliases 

1) In the Geodatabase Configuration tool, select a feature class.  A window with several tabs appears in the center of the screen. 

2) Select the Alias Names tab.  This tab has two grids: 
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 The Associated Aliases grid lists all aliases assigned to the feature class.   

o Right-click on an existing record for options to Add, Edit, Delete, or Disassociate. 

o Disassociating a record in this grid detaches it from the selected feature class and moves 
it to the Available Aliases grid. 

o Whenever a feature class with a name from this list appears in the Lucity Viewer, the 
Web Map, or the Mobile Map Mode, Lucity connects the feature class to the associated 
module. 
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 The Available Aliases grid lists aliases set up by the user that aren't associated with any 
feature classes.  The grid is shared among all feature classes.  Aliases in the grid can later 
be associated with or re-associated with any feature class. 

o Right-click on an existing record for options to Add, Edit, Delete, or Associate. 

o Associating a record in this grid attaches it to the selected feature class, removes it from 
the Available Aliases grid, and adds it to the Associated Aliases grid for the selected 
feature class. 

How To Add an Alias in a Grid 

1) Right-click in the desired grid and select Add.  The following pop-up appears: 

 

2) Enter the Alias Name and click OK. 

3)   

Note: Aliases apply to the feature class and any replica feature classes. 
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MAP SERVICES CONFIGURATION 

Once feature class aliases are established and imported into the geodatabase configuration, an agency must publish the maps it wishes to use.  
The Lucity Web Map and the Lucity Mobile application support both .mxd, and .msp map services.  After the services are published, an 
administrator must configure Lucity to use the services. 

How To Configure a Map Service 

1) Collect map service information. 

For Arc 10.x 



 

377 

 

 

a. Log into Arc Server Manager and click on Services > Manage Services. 
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b. Locate the service you wish to use and click on it to view its properties. 

c. Click the Capabilities button. 

d. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

e. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

f. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 

Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

2) Open the Lucity Administration Tool.  

3) If the map services are secured, go to GIS > Authentication Setup. 

o Add the required Username/Login combinations. 

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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4) Navigate to GIS > GIS Services. 

 

a. On the Map Services tab, click Add Map Service...  

b. Enter the Name of the map service.  This name is used to identify the service when it is added to a Lucity map or viewed in one of the 
Lucity mapping products. 

c. In the URL field, enter the REST URL for the map service. 

 More information about using Bing Maps (see "Bing Services" on page 382)  

d. In the Order field, enter a value to indicate the order in which the service should appear in relation to other layers.  (Map services are 
layered based on this field.  A lower number represents a lower layer.  Zero is the bottom layer.) 
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Note: Lucity Mobile and Mobile Work Maps only query data out of the top-most layer.  Therefore, make sure that the layer that contains 
Lucity assets has the highest number in the Order field. 

e. Check the Base Map for Web? box if this layer is used as a basemap. 

 More information about configuring basemaps (see "Base Map Configuration" on page 384)  

f. If the service is secured, use the User Auth drop-down box to select one of the authentications you created in Step 3. 

g. Complete other fields as desired. 

h. Click Save. 

i. Click Test if the map service contains Lucity features.  The system displays a list of all feature classes that the map recognizes as being 
connected to Lucity. 

5) After Steps 1 - 4 have been completed for all map services, go to Lucity Web, and navigate to Admin Portal > Settings > System Settings > 
GIS Web section. 

a. In the Operational Data Spatial Reference WKID field, enter the Spatial Reference number.  [This topic was covered in Step 1.g.] 

 The WKID that is used here must be the the WKID that the operational data is referenced against.  Lucity uses this spatial reference to 
record x-y coordinates and any other spatial data. 
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BING SERVICES 

The Lucity Web Map supports the use of Bing map services as basemaps.   

Note: To use Bing services for FREE, the Lucity Web application must have a public URL. 

Bing maps are subject to a license agreement with Microsoft and require a key that is available to clients on ArcGIS 10 with a support and 
maintenance contract.  Review ESRI documentation to determine whether your agency qualifies to use Bing services. Lucity does not provide a 
Bing authorization key.   

How To Setup a Bing Map 

1) Get a Bing key. How to obtain a Bing authorization key 
(http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server_dotnet_help/index.html#//00930000008m000000.htm) 

2) In the Lucity Administration Tool, go to GIS > GIS Services. 

3) On the Map Services tab, click Add Map Service...  

4) Enter the Name of the map service.  This name is used to identify the service when it is added to a Lucity map or viewed in one of the Lucity 
mapping products. 

5) Enter the URL, which is broken down into three parts: 

http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server_dotnet_help/index.html#//00930000008m000000.htm
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Bing Key 

Bing:Key=<Bing Key from step 1> 

Layer Style - The options are AerialWithLabels, Aerial, and Road.  If no layer style is set, the style defaults to Road.  (These options are 
case-sensitive.)   

&LayerStyle=AerialWithLabels 

Extent - Optional.  This value defines the default opening extent for the map. 

&Extent=1,3,2,3 

The resulting URL looks something like this: 

Bing:Key=INeFTNEsdIDINDdldisDINi2DInin9IDNin&LayerStyle=AerialWithLabels&Extent=1,3,2,3 

6) Check the Base Map for Web? box. 

7) Save changes and close the window. 
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BASE MAP CONFIGURATION 

The Lucity Web map allows administrators set up multiple basemaps that users can then switch between.  The map services that are used as 
basemaps are specified in the Administration Tool under GIS > GIS services, by checking the Base Map for Web? box. 

Note: Basemaps must be either a tiled-map service, an image service, or a Bing map. 

A Base Map button is available on the Web Map toolbar.  Click this button, and a drop-down list of all available basemaps appears, with a 
thumbnail of each. 

Thumbnails are automatically provided when using Bing maps.  If an agency is using locally created map services, the thumbnails must be set up 
by the administrator. 

How To Add a Thumbnail 

1) Create a thumbnail.   

o The recommended size is 200 (width) by 133 (height). 

o Save the image as a PNG file. 

2) Name the file using the same name used for the map service (defined in GIS > Map Services, in the Name column). 

3) Place the image in the inetpub\wwwroot\LucityWeb\ClientBin\GIS\BaseMapThumbnails folder and ensure the file can be accessed to READ 
by the relevant IIS process (I_IUSRS or IIS_WPG, depending on OS). 

 

RED-LINE CONFIGURATION 

The Red-lining tool lets users draw reference information directly on the map and add notes.  For example: 

 A supervisor could create a Work Order and then use the Red-lining tool to indicate an area where he would like his workers to check for 
potholes.  

OR 
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 A worker could use use the Red-lining tool to notify a supervisor that a street sign has been installed in the wrong location. 

 
 

Creating Red-Line feature classes 

Using the Red-line tool requires administrators to create feature classes in which to store the red-line data.   

 Feature classes.  

o The tool supports Points, Lines and Polygons. 

o There is no requirement that each of these types has to exist. 

o While there is no limit to the number of red-line feature classes an administrator can create, only one of each type can be added to a 
map. 

For example, an administrator could create a set of red-line layers for each department.  
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 Fields 

o There are no required fields. 

o It's a good idea to include a text field with a large mask so that users can add comments. 

How to build the Red-Line map service 

1) Create a map in ArcMap. 

2) Add the red-line feature classes you created.  

o This map should ONLY contain the red-line feature classes.  Do not add operational data to the map. 

o This map can contain more than one set of red-line data.  However, only one layer of each type (point, line, polygon) can be added to 
each Web Map. 

3) Set the symbology as desired.  The default editing template for the feature class will be used in the Web Map. 

4) Save the map in preparation for publishing. 
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How to publish the service 

When publishing the map to a map service, several special options must be enabled: 

1) On the Capabilities tab, check the Feature Access option. 
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2) Then, open the Feature Access tab.  Under Operations allowed, check all of the boxes.  Note: the Create option is required.  The other 
options are not required, but some of the red-line tools will not work if the options are not enabled. 
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3) The Red-line tool also enables administrators to control how users interact with the red-lines that other users add.  Check the Enable 
ownership-based access control on features option and choose whether to allow users to Query, Update or Delete others' red-lines. 

o The feature is only available in Arc 10.x. 

More information from ESRI about this option (http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000004n9000000) 

How to configure Red-Line map services 

1) Collect the URL for the feature service and the number for each layer. 

For Arc 10.x 

http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000004n9000000
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a. Log into Arc Server Manager and click on Services > Manage Services. 



 

392 
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b. Locate the map service you wish to use. 

c. Click on the map service to see its properties. 

d. Click the Capabilities button. 

e. Copy down the REST URL, which should have a path similar to this: http://<server name>/ArcGIS/rest/services/<service 
name>/FeatureServer. 

f. Click on the REST URL.  A page listing the properties of the map service appears. 

g. The Layers section lists all the service's layers.  The number behind the layer name is the layer order number. 

 

h. Collect both the URL for the feature service and the number for each layer. 



 

394 

 

 

2) Launch the Lucity Administration Tool and select GIS > GIS Services. 

 

3) On the Map Services tab, click Add Map Service... 

4) Enter the REST URL for the feature.  This will end in /FeatureServer. 

5) Click Save.... 
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6) Go to GIS > Map Setup. 
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7) In the Available Maps grid, select the map to add the red-line service to and click Edit Map Setup. 

 

8) In the Redlining section, select the red-lining map from the drop-down.  This list displays only the feature services configured in the Map 
Services (see "GIS Map Services" on page 292) tool. 

9) Also in that section, enter the layer number within the feature service that corresponds to each type of redlining layer: Point, Polyline, and 
Polygon.   

10) Close the window and click Save on the Map Setup window.  These layers now appear in the map. 
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EDITING SERVICE CONFIGURATION 

The Editing tools allow users to add new features to the map, edit existing features, and delete features.  These tools use feature services to 
push the edits back to the geodatabase. 

 

How to build an editable map service 

1) In ArcMap, create a map. 

o You could also edit a map currently published as a map service. 

2) Add the feature classes you would like to edit.  

3) Set the symbology as desired.  The editing templates designed for the feature class will be used in the Web Map. 

4) Save the map in preparation for publishing. 
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How to publish an editable map service 

When publishing the map to a map service, several special options must be enabled: 

1) On the Capabilities tab, check the Feature Access option. 
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2) Then, open the Feature Access tab.  Under Operations allowed, check all of the boxes.   
Note: the Create option is required.  The other options are not required, but some of the editing tools will not work if the options are not 
enabled. 
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3) The Editing tools also let administrators control how users interact with the features that other users add.  Check the Enable 
ownership-based access control on features option and choose whether to allow users to Query, Update or Delete others' features.   
 
This option allows users to create features without disturbing other features.  However, they may not be able to update existing features. 

o The feature is only available in Arc 10.x. 

More information from ESRI about this option (http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000004n9000000) 

 

How to add an editable map service to the map 

1) Collect the REST URL for the map service. 

For Arc 10.x 

http://resources.arcgis.com/en/help/main/10.1/index.html#//0154000004n9000000
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a. Log into Arc Server Manager and click on Services > Manage Services. 
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b. Locate the service you wish to use and click on it to view its properties. 

c. Click the Capabilities button. 

d. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

e. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

f. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 
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Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

2) Launch the Lucity Administration Tool and select GIS > GIS Services (see "GIS Map Services" on page 292). 

 

a. On the Map Services tab, click the Add Map Service button. 

b. Enter a Name and the REST URL of the map service. 

Note: This URL should end in /MapServer. 

c. Check the Has Feature Service? box.  This tells the map that the layer has an attached feature service. 

d. Complete other fields as desired. 

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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e. Click the Save button. 

Note: If you are modifying an existing map service to include editing capabilities, simply mark Has Feature Service? box for the existing 
record in the Map Service setup. 

f. Close the GIS Services tool. 

3) Open the GIS > Map Setup. 
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a. In the Available Maps grid, select the map to which to add the editable service and click Edit Map Setup. 

 

b. If the Map Service record is not in the Services to Display in Map grid, locate it in the Available Editable Services grid. 

c. Select the map service in the Available Editable Services grid and click the corresponding Add >> button. 
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Note: All editable layers that are added to the map are used to display features in the map and then edit features when the edit tools are 
enabled.  To add an editable layer to a map for display purposes only and disable users' ability to edit it, simply add the service to the 
Services to Display in Map grid.  Then, check the Disable Edits box next to the layer in the grid.  This option allows you to reuse the 
same services in different maps while preventing everyone from editing them. 

4) Close the window and click Save on the Map Setup window.  The layers now appear in the map. 

  
 

ROUTING CONFIGURATION 

The Work Order Routing tool allows users to select a group of Work Orders and identify the most efficient route between the Locations and 
Assets in those Work Orders.   

The tool requires a routing service in order to work.  The routing service can be either a third-party service (like ESRI's) or a routing service the 
agency owns and maintains. 

How To Configure the Map To Use a Routing Service 

1) Collect the REST URL for the routing service 

For Arc 10.x 
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a. Log into Arc Server Manager and click on Services > Manage Services. 
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b. Locate the service you wish to use and click on it to view its properties. 

c. Click the Capabilities button. 

d. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

e. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

f. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 

Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

2) In the Lucity Administration Tool, go to GIS > GIS Services. 

3) Go to the Utility Services tab.  In the Routing Service grid, select the existing record.  (Only one service is needed.)   

4) Provide the REST URL for the routing service. 

5) Complete the other fields as desired. 

6) If you prefer that the route always starts at a specific address, enter that address into the Default Vehicle Start Address for Work Routing. 

7) Click the Save... button below the grid. 
 

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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GEOCODING CONFIGURATION 

The Lucity Web Map can locate addresses two ways:  1) using a geocoding service, and 2) using a parcel layer. 

Locating Addresses Using a Geocoding Service 

Geocoding services can be used to locate and identify addresses in the map.  An agency may use its own geocoding service or one provided by 
ESRI. 

How To Configure the Map To Use a Geocoding Service 

1) Collect the REST URL for the geocoding service. 

For Arc 10.x 
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a. Log into Arc Server Manager and click on Services > Manage Services. 
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b. Locate the service you wish to use and click on it to view its properties. 

c. Click the Capabilities button. 

d. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

e. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

f. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 

Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

2) In the Lucity Administration Tool, go to GIS > GIS Services and select the Utility Services tab . 

3) In the Geocoding Services grid, click Add Geocoding Service...  A new record appears in the grid.   

4) Enter a unique Name for the geocoding service. 

5) Provide the REST URL for the geocoding service. 

6) Complete other fields as desired. 

7) In the Default Geocoding Service drop-down box below the grid, select which service the Lucity Web and Lucity Mobile maps should use by 
default.   

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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Note: You can select a different default service for every map during the map setup. 

8) Click the Save... button below the grid. 

 

Locating Addresses Using a Parcel Layer 

Parcel services store the address in the layer, and the map identifies which parcel intersects with a given location. 

How To Configure the Map To Use a Parcel Layer 

1) Tell the Web Map that it going to use a parcel service, rather than a geocoding service. 

a. In Lucity Web, go to the Admin Portal > Settings > System Settings > GIS Web tab 
(http://help.lucity.com/webhelpv170/web/index.htm#38257.htm). 

b. Set the Use an address layer for address queries instead of geocoding service option to TRUE. 

2) Specify a Parcel Layer. 

a. Collect the rest url for the service that contains the parcel layer. 

For Arc 10.x 

http://help.lucity.com/webhelpv170/web/index.htm#38257.htm
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b. Log into Arc Server Manager and click on Services > Manage Services. 
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c. Locate the service you wish to use and click on it to view its properties. 

d. Click the Capabilities button. 

e. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

f. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

g. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 

Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

h. Open the service and copy the Layer Index Number for the parcel layer. 

i. In the Lucity Administration Tool, go to GIS > GIS Services and select the Utility Services tab. 

j. In the Geocoding Services grid, click Add Geocoding Service...  A new record appears in the grid.   

k. Enter a unique Name for the map service. 

l. Provide the REST URL for the map service. 

m. Add the layer index number to the end of the map service URL.  It should look something like this: 
...rest/services/baselayers/MapServer/10. 

3) Specify a query template for the application to use when querying: 

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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a. In Lucity Web, go to the Admin Portal > Settings > System Settings > GIS Web tab. 

b. See the Help Guide entry for the Comma separated criteria to use for... field 
(http://help.lucity.com/webhelpv170/web/index.htm#38257.htm). 

 

GEOMETRY SERVICE SETUP 

Lucity uses geometry services to perform geospatial calculations when rendering the Lucity Web Map.  Although a geometry service is not 
required, Lucity strongly suggests that agencies use one. 

How To Configure a Geometry Service 

1) Collect REST URL for the geometry service. 

For Arc 10.x 

http://help.lucity.com/webhelpv170/web/index.htm#38257.htm


 

422 

 

 

a. Log into Arc Server Manager and click on Services > Manage Services. 
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b. Locate the service you wish to use and click on it to view its properties. 

c. Click the Capabilities button. 

d. Copy down the REST URL, which should have a path similar to: 

 Map Service: http://<server name>/ArcGIS/rest/services/<service name>/MapServer 

 Feature Service: http://<server name>/ArcGIS/rest/services/<service name>/FeatureServer 

 Geocoding Service: http://<server name>/ArcGIS/rest/services/<service name>/GeocodeServer 

 Geometry Service: http://<server name>/ArcGIS/rest/services/<service name>/GeometryServer 

 Routing Service: http://<server name>/ArcGIS/rest/services/<service name>/RoutingServer 

e. If collecting information for the map service that contains your operational data, click on the REST URL.  A page containing the 
properties of the map service appears. 

f. Scroll down and copy down the Spatial Reference Number. (Do this only for the layer that contains Lucity data.) 

Note: If text appears in the Spatial Reference field, rather than numerals, use the closest matching Spatial Reference Number from the 
following lists:  Projected Coordinate Systems (http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML)  Geographic 
Coordinate Systems  (http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html) 

2) In the Lucity Administration Tool, go to GIS > GIS Services and click the Utility Services tab. 

3) In the Geometry Service grid, select the existing record.  (Only one service is needed.)   

4) Provide the REST URL for the geometry service. 

5) Cpmplete other fields as desired. 

6) Click the Save... button below the grid. 
 

http://help.arcgis.com/EN/ARCGISSERVER/10.0/APIS/REST/GCS.HTML
http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/gcs.html
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MAP SETUP FOR WEB MAP 

How To Add or Edit a Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The map setup appears: 

 

2) The left side of the dialog displays all available maps.  Click the Add Map Setup or select a map and click Edit Map Setup buttons to open 
the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 

a. Enter a unique name in the Name field. 

b. Under Lucity applications that can use this map, select Web & Mobile or Web only. 
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c. Check the Use as Default Map box to make this the default map. 

d. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in the Lucity Administration Tool, under System > Settings on the GIS Web tab.   

e. Select the service that contains your Redline layers. 

f. Use the map services listed in the Available Web Services and the Available Editable Services to populate the Services to Display in Map 
grid. 

g. Modify the service settings in the Services to Display in Map grid. 

Note: The Web Map and Mobile Map tools will recognize Lucity data in all layers as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

5) Once the maps have been defined, click Save on the Map Setup screen. 

6) Assign the map to the desired user groups (see "GIS Map Setup" on page 301). 

 
 

SETUP LUCITY GIS VIEWER 

The Lucity GIS Viewer enables agencies to give their employees a desktop GIS viewer that works with Lucity, without giving them access to 
ArcMap.  The viewer can use both map services published over the web and map packages created through ArcMap. 

Setup Steps 

1) Security Setup (on page 429) 

2) Creating Map Services or Packages (see "Creating Map Packages" on page 433) 

o Alias Configuration (on page 365) 

3) Map Service/Package Configuration (see "Map Service Configuration" on page 444) 
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4) Map Setup 

How To Add or Edit a Viewer Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The map setup appears: 

 

2) The left side of the dialog displays all available maps.  Click the Add Map Setup or Edit Map Setup buttons to open the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 

a. Enter a unique name in the Name field. 

b. Under Lucity applications that can use this map, select GIS Viewer. 

c. Check the Use as Default Map box to make this the default map. 
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d. There can only be one default map.  If more than one map exists, the Viewer will ask which one to use.  The default map will appear at 
the top of the list. 

e. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in Lucity Administration Tool, under System > Settings on the GIS Web tab.   

f. The Geocoding Url can be either a URL for a geocoding service OR the path to a geocoding package (.gcpk). 

g. Use the map services listed in the Available Web Services and the Available Local Services to populate the Services to Display in Map grid. 

h. Modify the service settings in the Services to Display in Map grid. 

Note: The Lucity GIS Viewer will recognize Lucity data in all layers, as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

5) Assign the map to the desired user groups. 

Note:  All maps that are marked as GIS Viewer will be visible to all Lucity GIS Viewer users. 

 

1) Install the Viewer (see "Installing the Viewer" on page 459) 

2) Activating the Viewer and Managing Activations (see "Activation and Activation Management" on page 462) 

3) Using the Lucity GIS Viewer (http://help.lucity.com/webhelp/v170/gis/#24116.htm) 

http://help.lucity.com/webhelp/v170/gis/#24116.htm
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Requirements 

 Lucity GIS Viewer 

 ArcMap 10.x or above*   

* ArcMap is only required for the single machine used to create map packages for setup.  If map packages are created by an outside source, 
ArcMap is not required. 

 

SECURITY SETUP 

Two actions must be performed within the Security program before using the Lucity GIS Viewer: 1) Establishing user permissions for the Viewer, 
and 2) establishing administrator permissions for those who will manage activations. 

Note: All desktop permissions apply to the Lucity GIS Viewer.  If a user cannot create a Work Order in Lucity Desktop, he or she will not be 
able to create one in the Viewer. 

Considerations 

 Which users should have access to use the Lucity GIS Viewer? 

 Which users should be able to manage viewer activations? 

 

How to give users permission to use the Lucity GIS Viewer 

1) In the Lucity Security program, go to Security > Permission Setup. 

2) On the left, select the Group(s) or User(s) who should have access to the Lucity GIS Viewer. 
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3) In the middle, in the Modules tree, expand the GIS node and check the GIS Viewer box. 

4) In the Permissions list on the right, select the Run permission. 

 

5) Click the Grant button. 
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Note: An agency's Permissions screen may look different, depending on settings made in the View menu. 

How to give admins permission to manage viewer activations 

1) In the Lucity Security program, go to Security > Permission Setup.  

2) On the left, select the Group(s) or User(s) who should be able to manage activation codes. 

3) In the middle, in the Modules tree, expand the Admin node and check the Activations box. 

4) In the Permissions list on the right, select the desired permission(s): 

o The Run permission allows users to view activations and activation codes in the Lucity Admin tool. 

o The General - Edit permission allow users to delete or modify activation records in the Lucity Admin tool. 
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Note: Users do NOT need the Activations > Run permission to activate a product.  Only admins need this permission to view activation 
codes. 

5) Click the Grant button. 

 

Note: An agency's Permissions screen may look different, depending on settings made in the View menu. 
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CREATING MAP PACKAGES 

The Lucity GIS Viewer supports either map packages, online services, or ArcGIS Server services.  Most agencies likely use local map packages 
with the GIS Viewer.  This section explains how to create a local map package. 

How To Enable ArcGIS Runtime Tools 

One ArcMap option must be changed before you can create a map package that will work with the Viewer. 

1) In ArcMap, go to Customize > ArcMap Options. 
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2) On the Sharing tab, check the Enable ArcGIS Runtime Tools box. 
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3) Click OK. 

 

Publish a Map Package 

1) In ArcMap, create a map that has the features desired for the map package. 

Note: The data in this map must come from your geodatabase. 

2) Adjust symbology and labeling as desired.  (These features will carry over into the map package and be displayed in the Viewer.) 

o If a layer can't be selected in the map, when the map package is created the layer won't be selectable by default in the Viewer.  
However, users do have control over layer selectability in the Viewer.  

3) Import the feature class aliases, especially if any of them were changed in the map. 

a. On the Lucity Editor toolbar, click the Alias Import button to update Lucity with any name changes made to the feature classes. The 
following message appears: 

Note: This step does not require ArcMap to be in an edit session. 
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b. Click Yes.  The process log appears.  Review the results to make sure that all the Aliases were imported properly. 

 

More information on configuring/importing aliases (see "Alias Configuration" on page 365) 

4) To create the map package, click File > Share as > Map Package.  The following window appears: 
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Note: If this package is supposed to be a tiled image or layer, choose File > Share as > Tiled Package. 
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5) On the Map Package page, choose the location in which the map package will be saved.  The best location is on a local network that all GIS 
Viewer users can access. 

6) Check the Support ArcGIS Runtime box. 

7) Choose how the map package will handle the data by checking the Reference all data box or leaving it blank.  Normally, the package 
includes a copy of all of the data from the geodatabase.  Marking the Reference all data box causes the map package to point to the 
geodatabase and read the data from there, instead.  If you choose to check this box, the geodatabase must be accessible over the network. 

8) On the Item Description page, enter the Summary, Tags, and Description fields. 
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f  
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9) At the top-right of the window, click the Analyze button. 

 

10) The Prepare window appears.  It lists any errors or warnings related to the map package you are about to publish. 

 

11) After correcting any errors and addressing any warnings or messages, return to the Map Package window and click the Share button. 
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12) If the following pop-up appears, click Yes. 

 

13) When the process is complete, the following message appears: 
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MAP SERVICE CONFIGURATION 

After an administrator has created map packages (or online services), Lucity must be configured to recognize them.  This section explains how 
to add a local map package to the GIS Map Services form.   

More detailed instructions for adding an online service (see "Map Services Configuration" on page 376) 

How To Configure a Map Package 

1) Open the Lucity Administration tool and go to GIS > Map Services. 

 

a. Click Add Map Service...  

b. Fill in the Name field. This name will identify the map service when it is added to a Lucity map, or viewed in one of the Lucity mapping 
products. 

c. In the URL field, enter the path to the map package. 
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 The map package should be stored on a network that users of the Viewer have access to. 

 The map packages have file names ending in .mpk or .tpk. 

d. Enter a value in the Order field.  (Map services are layered based on this field.  A lower number represents a lower layer.  0 is the 
bottom layer.) 

e. Ignore the Base Map field.  The Viewer does not use it. 

f. If the file is a tiled map package (.tpk), check the Tiled? box to indicate the layer is a tiled service. 

g. Click Save. 

2) After all map packages have been added, go to the System > Settings > GIS Web tab in the Lucity Administration tool. 

a. In the URL for Geocoding Service... field, enter the path to a geocoding package (.gcpk) or the URL to a geocoding service.  This will be 
the default geocoding service for all of the Lucity mapping applications. 

b. Click Save. 
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ALIAS CONFIGURATION 

An alias is an alternate name for a feature class that gives the feature class a unique identity.  The Lucity mapping applications (Web Map, GIS 
Viewer, and Mobile) check the feature classes that are loaded into them and their display names against the aliases listed in the geodatabase 
configuration to determine which feature class links to which module. 

Note: The geodatabase configuration must be complete before an administrator can configure Lucity to recognize aliases. 

Note: An administrator must establish and import aliases to the geodatabase configuration in order for the Lucity mapping applications to 
work. 

  

Setting an Alias 

An administrator can either set an alias for a feature class within ArcCatalog or set aliases on a per-map basis in ArcMap.  Feature class aliases 
are tied to the feature class in ArcCatalog.  Per-map aliases are set in ArcMap and are only saved for that .mxd, or for any map services or map 
packages generated from that .mxd. 

Note: Aliases must be completely unique throughout the geodatabase configuration.  For example, a Sewer Pipe feature class and a Water 
Pipe feature class cannot both have a "Pipes" alias. 

Note: Aliases should not start with a number. 

How to set a feature class alias in ArcCatalog 

1) In ArcCatalog, navigate to the desired feature class. 

2) Right click on it and select Properties.... 

3) On the General Tab there are Name and Alias fields.  Set the Alias to the desired value.  Do NOT change the name. 
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Note: By default, the Alias is the same as the Name. 
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4) Click OK.  The alias is now set for the feature class. 

How to set a map-specific alias in ArcMap 

1) In ArcMap, click on a feature class in the table of contents and rename it.  

OR  

Right-click on the feature class and select Properties. 
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2) On the General Tab, change the name in the Layer Name field. 
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3) Click OK.  The new alias is now set for that feature class.   

4) Repeat for other desired feature classes. 

 

  

 

Import Aliases 

Aliases can be imported into the Lucity geodatabase configuration in two ways: 1) by importing the feature class alias or 2) by importing the 
per-map aliases.   

How to import the feature class alias(es) in ArcCatalog 

1) In the Geodatabase Configuration tool, select the geodatabase connection or the feature class for which you wish to import an alias. 

2) Right-click on the selected geodatabase or feature class and select the Import tool. 

o If it is a geodatabase, the tool is Import Feature Class Alias Names. 

o If it is a feature class, the tool is Import Feature Class Alias Name. 

The system immediately begins importing aliases from the feature class aliases set in ArcCatalog.  A log screen appears to provide 
information about the import. 

3) Review and close the log screen when the process is complete. 
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How to import per-map aliases in ArcMap 

1) On the Lucity Edit toolbar, click the Alias Import button.  The following message appears: 

 

2) Click Yes to continue.  The process log displays the results: 
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Importing aliases using this method directly links them to the feature classes' Alias Names tab in the geodatabase configuration. 

Note: This import enables users to load their feature classes into a map.  Change the names of the layers, and then quickly import them 
before publishing the .mxd as a map service or map package. 

  

 

Manage Aliases 

Aliases can be added manually for each feature class and managed in the Geodatabase Configuration tool. 

How to manage aliases 

1) In the Geodatabase Configuration tool, select a feature class.  A window with several tabs appears in the center of the screen. 

2) Select the Alias Names tab.  This tab has two grids: 
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 The Associated Aliases grid lists all aliases assigned to the feature class.   

o Right-click on an existing record for options to Add, Edit, Delete, or Disassociate. 

o Disassociating a record in this grid detaches it from the selected feature class and moves 
it to the Available Aliases grid. 

o Whenever a feature class with a name from this list appears in the Lucity Viewer, the 
Web Map, or the Mobile Map Mode, Lucity connects the feature class to the associated 
module. 
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 The Available Aliases grid lists aliases set up by the user that aren't associated with any 
feature classes.  The grid is shared among all feature classes.  Aliases in the grid can later 
be associated with or re-associated with any feature class. 

o Right-click on an existing record for options to Add, Edit, Delete, or Associate. 

o Associating a record in this grid attaches it to the selected feature class, removes it from 
the Available Aliases grid, and adds it to the Associated Aliases grid for the selected 
feature class. 

How To Add an Alias in a Grid 

1) Right-click in the desired grid and select Add.  The following pop-up appears: 

 

2) Enter the Alias Name and click OK. 

3)   

Note: Aliases apply to the feature class and any replica feature classes. 
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MAP SETUP FOR A VIEWER MAP 

How To Add or Edit a Viewer Map 

1) In the Lucity Administration Tool, select GIS > Map Setup from the main menu.  The map setup appears: 

 

2) The left side of the dialog displays all available maps.  Click the Add Map Setup or Edit Map Setup buttons to open the GIS Map Edit screen. 

3) The Map Editing tool (see "Map Editor" on page 312) opens. 

a. Enter a unique name in the Name field. 

b. Under Lucity applications that can use this map, select GIS Viewer. 
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c. Check the Use as Default Map box to make this the default map. 

d. There can only be one default map.  If more than one map exists, the Viewer will ask which one to use.  The default map will appear at 
the top of the list. 

e. Set the Geocoding Url.  Enter a URL or path here if the geocoding service used for this map will be different than the one entered in the 
Default Geocoding Url field.  The Default Url is set in Lucity Administration Tool, under System > Settings on the GIS Web tab.   

f. The Geocoding Url can be either a URL for a geocoding service OR the path to a geocoding package (.gcpk). 

g. Use the map services listed in the Available Web Services and the Available Local Services to populate the Services to Display in Map grid. 

h. Modify the service settings in the Services to Display in Map grid. 

Note: The Lucity GIS Viewer will recognize Lucity data in all layers, as long as the aliases are set up correctly. 

4) Click Close to return to the Map Setup screen. 

5) Assign the map to the desired user groups. 

Note:  All maps that are marked as GIS Viewer will be visible to all Lucity GIS Viewer users. 
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INSTALLING THE VIEWER 

The Lucity GIS Viewer must be installed on the machine on which it will be used before the user can access it.  The GIS Viewer is part of the 
Lucity Desktop install; however, it is not installed automatically.  The Viewer can either be installed during Lucity Desktop installation or by 
modifying the Lucity Desktop installation.   

Note: If installing the Viewer during the normal Lucity Desktop installation, choose the Custom install option.  Then proceed to Step 6 
below. 

How To Modify the Desktop Installation 

1) On the machine, open the Control Panel. 

2) Run Add or Remove Programs, or Programs and Features. 

3) Find and select Lucity Desktop. 
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4) Click Change.  A screen similar to the one below appears: 
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5) Select Modify, and click Next >.  The next screen displays components that the user has the option to install. 

 

6) Click the Lucity GIS Viewer drop-down and select Will be installed on local hard drive. 

7) Click Next >.   

8) Once the program has completed the installation, click Finish. 
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ACTIVATION AND ACTIVATION MANAGEMENT 

Although the Lucity GIS Viewer may be installed on a machine, the feature cannot be used until it is activated.  Activation codes are unique for 
each computer.  Permissions established in the Lucity Security TOOL control which users can use the Viewer and which users can activate it. 

FAQ 

What is the relationship between activation codes, users, and available licenses? 

Lucity GIS Viewer activation codes are each tied to a separate license and machine.  Therefore, when the Viewer is activated on a machine, a 
license is used.  That license is now tied to the machine that is activated and cannot be used by any other user, even if that machine isn't 
actively using the Viewer.   

The only way to release that license for use by another user would be to deactivate the machine. 

How does a user get the activation code? 

Unlike the activation process for Lucity Mobile products, users of the GIS Viewer do not receive, or even see, the Activation Code.   Instead, the 
code is applied automatically when the user tells the program to activate. 

How do you deactivate the Lucity GIS Viewer on a machine? 

If the Lucity GIS Viewer needs to be deactivated on a machine, an administrator must: 

1) Launch the Lucity Administration Tool and go to System > Activations Manager.   

2) Select the user's activation record on that machine. 

3) Click the Deactivate license button. 
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How To Activate the Viewer 

1) The first time a user runs the Lucity GIS Viewer, the following prompt will appear if there are licenses available to activate their copy of the 
viewer: 

 

2) Click Yes.  The program is immediately activated and assigned a license. 

Note: You will receive an alert if there are no available licenses. 

  

How To Limit How Long a Device Activation Remains Valid (when not in use) 

1) In the Lucity Administration Tool, go to System > Settings > Mobile tab.   

2) Enter a number in the Mobile activation timeout in days field.   

If someone tries to activate another device and the system is out of licenses, the Activation Manager will review current activations for any 
"inactive" devices.  If a user hasn't used a device for the specified number of days, the Activation Manager will drop that activation and 
activate the next device. 
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How To Use the Activations Manager 

 In the Lucity Administration Tool, go to System > Activations Manager.  The following screen appears. 

o Fields 

 Name - The device's name (i.e., the phone number). 

 Secret - The Activation Code for this device/user record. 

 User Name - The user's Lucity login. 

 Last Activated on - The date on which this device was last activated. 

 License - The type of license this device is using. 

o Buttons 
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 Deactivate license - Deactivates the selected activation record and removes it from the Active list. 

 View Log - Displays each time the selected activation record has been activated or deactivated. 

 Send Email With Code - This function is not used for Lucity GIS Viewer activations because the activation occurs automatically, without 
entering the code. 
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Note: The Activations Manager is used for the Lucity GIS Viewer and Lucity Mobile applications. 

How to get permissions to use the Activations Manager (see "Security setup" on page 429) 

  
 

ADVANCED 

The following sections discuss advanced operations related to Lucity Web: 
 

Linking To Lucity Web How to create a URL link that opens Lucity Web to a specific record. 

Linking to the Lucity Web 
Map 

How to create a URL link that opens the Lucity Web Map to view a specific record. 

Customizing the 
Dashboard Background 

How to change the background image for the Lucity Dashboard. 

Disabling HTML Reports How to remove the ability to run HTML reports for browsers that don't support 
this functionality. 
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LINKING TO LUCITY WEB 

At times, an agency might find it useful to create a URL that links directly to Lucity Web to view a particular asset, without navigating through the 
Lucity Web interface.  For example, an agency may want to to embed such a URL into a Crystal report.   

 

Use the following URL as a template for jumping directly into the Lucity Web to view an Asset: 

 

http://[myserver]/[virtualdirectory]/Public/Routing.aspx?RouteTarget=Internal&RouteSubTarget=Views&RouteAction=OpenDefault&RoutePara
m1=[moduleid]&RouteParam2=[viewname]&RouteParam3=[Filter[tablename]+WHERE+[autoNumberField]=[autoNumber]] 

 

Six parts of the template must be specified: 

[myserver] The name of the server hosting Lucity Web. 

[virtualdirectory] The virtual directory in which Lucity Web is installed.  By default: 
LucityWeb. 

[moduleid] The identifying number for the module you wish to open.  To zoom to a 
specific Sewer Pipe record, use the module ID for the Sewer Pipes module.  
To zoom to a specific Work Order, insert the ID for the Work Order 
module.  All module IDs are stored as KeyIDs in the 
GBAUser.dbo.Modules table.  

[viewname] The name you wish to appear at the top of the View when it is loaded. 

 Use + or %20 to represent spaces. 
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[Filter......] The remaining parameters fall within this section of the URL.  These 
parameters are provided as an example; however, the intent is to enter a 
filter that starts with the table found in the From clause of a SQL 
statement in order to filter the records that are displayed in the View. 

 Use %3D to replace an = sign. 

[tablename] The name of the table in which the feature or record is stored. 

[autoNumberField] The name of the field in which the autonumber is stored. 

[autoNumber] The database record number that the program assigned to identify the 
desired feature.  For the GBASewer.dbo.SWNET table, the [autoNumber] 
would be NT_ID. 

 

Examples 

The following URL will open Lucity Web and display the Work Order with WO_ID = 33945: 

 

http://ExampleServer/LucityWeb/Public/Routing.aspx?RouteTarget=Internal&RouteSubTarget=Views&RouteAction=OpenDefault&RouteParam1
=48&RouteParam2=WO%20%2312-2343&RouteParam3=WKORDER+WHERE+WO_ID+%3D+33945 
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LINKING TO LUCITY WEBMAP 

An agency may have a need to create a URL that directly launches the Lucity Web Map to display an asset, without having to navigate through 
the Lucity Web interface.  For example, a Sewer department supervisor might want to embed a link to a mapped sewer line into a Crystal 
report. 

 

Use the following URL as a template for jumping directly into the Lucity Web Map to view a feature: 

 

http://[myserver]/LucityWeb/Public/Routing.aspx?RouteTarget=Internal&RouteSubTarget=MapWindows&RouteAction=ShowInMap&RoutePara
m1=[moduleid]&RouteParam2=0&RouteParam3=[{id:autoNumber}] 

 

Three parts of the template must be specified: 

[myserver] The name of the server that hosts Lucity Web. 

[moduleid] The identifying number of the Module in which the Asset is stored.  To 
zoom to a specific Sewer Pipe, the module ID should be that of the Sewer 
Pipes module.  To zoom to a Work Order, this value should be the 
module ID for the Work Order module.  All module IDs are stored in the 
GBAUser.dbo.Modules table as KeyIDs.  The module ID is used in the 
WKWOASSET table to specify which Module the Asset comes from. 

[{id:autoNumber}] This is a json list of feature IDs to select in the Web Map.  This ID 
represents the module's database record number.  For the 
GBASewer.dbo.SWNET table, the ID would be NT_ID. 

 To specify more than one map feature, use the following syntax:  
[{id:autoNumber},{id:autoNumber},{id:autoNumber}] 

 



 

470 

 

 

Examples 

The following URL will open the Web Map and select the sewer pipe with the ID 33293. 

http://EXAMPLESERVER/LucityWeb/Public/Routing.aspx?RouteTarget=Internal&RouteSubTarget=MapWindows&RouteAction=ShowInMap&Rou
teParam1=2&RouteParam2=0&RouteParam3=[{id:33293}] 

 

 

This URL will open the Web Map without selecting a feature: 

http://EXAMPLESERVER/LucityWeb/Public/Routing.aspx?RouteTarget=Internal&RouteSubTarget=MapWindows&RouteAction=ShowInMap&Rou
teParam1=0&RouteParam2=0&RouteParam3=[] 

 

 
 

CUSTOMIZING THE DASHBOARD BACKGROUND IMAGE 

You can change the background image in Lucity Web to match your agency's style or color scheme. 

How To Change the Background 

1) Create a .png file and name it Background.png. 

2) Copy your background to the LucityWeb\ClientBin\images folder and overwrite the existing Background.png. 

3) It will be applied per Web application installation, not per user. 
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ADMINISTRATIVE FAQ 

The following responses to frequently asked questions (FAQs) are geared toward system administrators. 

Installation 

Q: How do I configure the Lucity Web application to use TLS? 

A: During the Lucity Web install, there is a screen that asks if the application should be installed normally or under TLS. 

Q: What if I have already installed Lucity Web and want to switch to using TLS? 

A: To make the switch, you must uninstall Lucity Web and reinstall it using the TLS option.  Don't worry!  You won't lose any Dashboard 
settings or configurations that you have made. 

DOS Attacks 

Question:  Do you have any techniques for stopping denial-of-service (DOS) attacks from the Internet? 

Answer:  A DOS attack occurs when someone attempts to crash a web site by bombarding it with multiple requests.  Lucity has implemented 
one technique for stopping DOS attacks in the Citizen Portal application.   
 
By default, if the Citizen application receives more than 1000 requests within 10 minutes from a single IP address, it will stop accepting requests 
from that IP address for the duration of the 10 minutes.  The maximum number of requests and the time period values can be configured by an 
administrator.  The default values are hard-coded in the program; they are not found in the appsettings file.  However, adding entries in 
appsettings.config file can override the defaults. 

 You can change the denial-of-service configuration by entering the following code strings in the appsettings.config file: 

<add key="DOSREQUESTS" value="1000" /> (The value represents the number of hits allowed to occur within the period before blocking the 
IP address.) 

<add key="DOSPERIOD" value="10" /> (This value represents the number of minutes in a single period.) 
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 1000 attempts within 10 minutes is the default setting.  Lucity tracks the time of the first attempt from each IP address; if more than 1000 
requests occur within the next 10 minutes, the system blocks requests from that IP address for the remainder of the 10 minute period. 

Note:  This technique only works for short periods and only against a single IP address.  It is intened to protect against localized DOS attacks.  
Mitigation of large-scale, distributed denial of service attacks (DDOS) should be handled by routers and networks.  
 

WEB DIAGNOSTICS 

Lucity Web contains a special page that provides information about Lucity Web and its interaction with the web browser.  This page is not 
accessible from within the Lucity Web interface and must be opened manually by typing in the following URL: 

http://<servername>/LucityWeb/Public/Diag.html 

The web diagnostics this page provides are primarily used in trouble-shooting. 

Note: Server information will be displayed as part of this page unless the Enable diag.html Server Information for debugging setting is set to 
FALSE. 
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HOW TO: SETUP CITIZEN PORTAL 

The Citizen Portal portal gives an agency's clients a way to fill out requests for work and submit them over the Internet.  This section serves as a 
step-by-step guide for setting up Citizen Portal. 

 

Installation 

 For information about installing the Citizen Portal application, read the Citizen Portal section of the Install.chm help file that is included with 
the Lucity installation media. 

Security (on page 474) 

 User and groups 

 Permissions 

 Assigning the user to the Citizen Portal 

Create Request Forms (on page 478) 

 Citizen Request Form 

 Form code 

 Assigning a group to the Form 

Form Display and application settings 

 In Lucity Web > Admin Portal > Settings > System Settings > Web Site, there are several options that affect how the Citizen Portal 
application runs and how the Form displays.  Follow the link for more information about these settings. 

Updating the Customer Database from Requests (see "Updating Customer Database from Requests" on page 487) 
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Advanced Configurations 

Customizing the Lucity Citizen Portal page (on page 490) 

Customizing the Citizen Request email (on page 495) 

 

SECURITY 

Before a agency can launch the Citizen Portal application, an administrator must designate a user through whom the Citizen Portal application 
will access the Lucity databases.  That user must also have permissions to create Work Requests.  These steps are performed within the 
Security program. 

Default Setup 

Several Groups and Users are pre-established when Lucity is installed.  One of these default groups is the PublicWebGroup.  That group, by 
default, includes a user called PublicWebUser.   

The PublicWebUser is automatically designated as the login that the Citizen Portal application will use to log into Lucity.   

 If this Group and User have not been altered in the Lucity Security program, and both still have permissions, then the rest of these 
instructions are unnecessary.  Proceed by creating the Request form.   

 If the User or Group has been deleted, follow the instructions in the links below. 

Note: Technically, another group and username could be used.  However, it is highly suggested that you use the default group and 
username. 

 

How to add a user for Citizen Portal 

1) In the Lucity Security program, go to Security > User/Groups Setup. 
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2) On the left side, under Users, check for the PublicWebUser. 

3) If this user does not exist, click New User.   

4) In the User: field, enter PublicWebUser and click OK. 

5) On the right side, under Groups, check for the PublicWebGroup. 

6) If this group does not exist, click New Group. 

7) Enter PublicWebGroup as the Group Name and click OK. 

8) Select the PublicWebUser on the left and the PublicWebGroup on the right and click Associate. 

 

How to give permissions to create Work Requests 

1) In the Lucity Security program, go to Security > Permission Setup.  

2) On the left, under Groups, select the PublicWebGroup. 

3) On the right, in the Modules tree, expand the Work node and check the Work Requests box. 
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4) In the Permissions list, select the General - Add and Run permissions. 

 

5) Click the Grant button. 
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Note: The Permissions screen may look different, depending on settings under the View menu. 

 

How to assigning the user to the Citizen Portal 

After installing Web Citizen and setting up the PublicWebUser, the PublicWebUser login must be associated with the Lucity Web Citizen 
application.  This tells Web Citizen to use this user login to access Lucity to create Requests.   

This relationship should already be established by default; however, an administrator can verify the link through the following steps: 

 

1) In the Lucity Administration tool, go to Lucity Web > Admin Portal > Settings > System Settings > Citizen. 

2) In the Login ID use for Citizen Website field, verify or enter PublicWebUser. 

3) Click Save. 
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CREATE REQUEST FORMS 

Once the Citizen Portal application is configured, an agency must create a Request Form that citizens will use to enter their Requests.  The form 
must then be assigned an ID that will identify it within the Citizen Portal application.  Finally, the form must be assigned to the Group that 
includes the Citizen Portal user. 

Note: These steps can be followed multiple times to create several Citizen Portal Forms.   

 

How to create a Request Form 

1) In the Lucity Admin tool, go to Forms > View/Forms Manager. 
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2) Select Request Manager for STEP 1: Select Program. 
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3) Select Work Requests for STEP 2: Select Module. 

4) Select Work Requests for STEP 3: Select Module Component. 
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More information about creating a new Form, or editing an existing Form (see "Form Editor" on page 168) 

More information about adding a File Upload field to a Form 

How to assign a Citizen ID 

1) In the Form Editor, go to Form > Options. 

 

2) In the Citizen ID field, enter a unique ID for this Form.  This ID must be all capital letters and numbers.  (ex. RQF124) 
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3) Click OK. 
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Note: The Form options also give an agency the ability to hide the Submit button on the Form by unchecking the Show Submit Button box.  
This feature is helpful if a Form is designed to provide information, rather than serve as a means for submitting Requests. 

How to assign the Request Form to a group 

1) In the Lucity Admin tool, go to Security > Assign Groups to Forms. 
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2) On the left, under Groups, select the PublicWebGroup. 

3) In the middle, select Request Manager, Work Requests, and Work Requests in the three drop-down boxes. 

4) On the right, under Available Views/Forms, select any Request forms that have a Citizen ID set. 
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5) Click Assign Groups. 
 

MAKING THE FORMS ACCESSIBLE 

After the initial setup is complete, and the Request Forms have been created, the forms must be made accessible to citizens or internal users.  If 
a Form will be used with external clients, a link to it must be added to the agency's web site.  If a Form will be used internally, it can be added to 
a menu within Lucity Web. 

 

How to provide the Forms to citizens 

1) In  Lucity Web tool, go to Admin Portal > Settings > System Settings > Web Site section. 

2) Copy down the URL in the Comma delimited list of servers running WebCitizen field.  It will look something like this: 

http://www.example.com/lucitycitizenportal 

3) Add the following to the end of the URL: 

/default.aspx?fui= 

It will look similar to this: 

http://www.example.com/lucitycitizenportal/default.aspx?fui= 

This is the URL that should be used to access any Web Citizen Form.   

4) To specify a particular Form, add its Citizen ID (see "Create Request Forms" on page 478) to the end of the URL.  The URL will look similar to 
this: 

http://www.example.com/lucitycitizenportal/default.aspx?fui=RQF124 

5) Provide a link to that URL in an appropriate place on the agency's web site.  Clicking the link will open the Form. 
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How to provide the Forms internally 

1) In the Lucity Administration tool, go to Navigation > Menus. 
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2) At the bottom, click Start Edit. 

3) On the left, under Menus, choose a menu. 

4) In the middle, choose Request Manager, Work Requests, Work Requests from the drop-down boxes. 

5) On the right side, under Views/Forms not assigned to menus, choose the Citizen form . 

6) Click the left-arrow button to assign the selected Form to the selected menu. 
 

UPDATING CUSTOMER DATABASE FROM REQUESTS 

Citizen Portal can add information to the Lucity Customer module when a new customer enters a Request.  If Citizen Portal is properly 
configured, the following functions will occur behind the scenes: 

1) If the customer location in the Request includes a Street Name, the system searches for a matching record in the Customer Address module.  
If a match is not found, the system creates a new Customer Address record. 

o If the customer location already exists in the Customer database, and the Request includes a Sewer Pipe, Street Segment, or Water Pipe, 
the system will check whether the Asset IDs in the Request match those in the Customer Address record.  If they don't match, the 
Customer Address record will be updated with the IDs from the Request. 

2) If the Request includes a customer's Name and Street in the requester's address, the system will try to find a matching record in the 
Customer Address module.  If no matching record is found, a new Customer Address record will be created.   

o If a matching record is found, the Address 2, Business Name, and Building Type fields in the Customer Address record will be updated with 
information from the Request. 

3) If there is a matching Customer Address record, the system will look for an associated Customer Contact record.   If one is found, the 
Contact data will be updated with any new information.  If a Contact record is not found, the system will create a new Customer Contact 
record. 
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How To Enable This Function 

1) In Lucity Desktop, go to Work > Administration > Work Options. 

 

2) At the top, switch the drop-down to Work Request Number. 
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3) On the General Options tab, make sure the Update Customers from Requests? option is set to Y. 

4) Open the Lucity Web. 

5) Open the Admin Portal > Settings > System Settings > Website, make sure the Add new addresses from Citizen Web App to Customers if the 
Work Option "Update Customers from Requests?" is Yes option is set to TRUE. 

 

DOCUMENT UPLOAD SETUP 

The Document Upload feature in Lucity Web, Citizen Portal, and Lucity Mobile lets users upload documents to the Lucity Web Server and attach 
them to a Lucity record.  This topic explains how to configure the Document Upload  feature for different parts of the Lucity application. 

Document Processing and Storage 

Uploaded documents are added to and processed by the Lucity Document Server.  The files are loaded to the locations specified on the Admin 
Portal > Settings > System Settings > Documents (see "Documents" on page 23) section.  

 The documents then are then stored in the following file structure, 

[Set Web Server Location]\[Program Name (i.e. work)]\[Module (i.e. work orders)]\[Record Number] 

which looks something like this: 

[\\YourWebServer\LucityDocuments]\[work]\[workorders]\[356] 

\\YourWebServer\LucityDocuments\work\workorders\356 

 Therefore, all documents uploaded for Work Order 356 are stored in this folder. 

How To Configure Citizen Portal for Document Upload  

1) Install the Document Server (http://help.lucity.com/webhelp/v170/install/29056.htm). 

2) In the Admin Portal > Settings > System Settings > Documents (see "Documents" on page 23) section, complete the following fields: 

o Error to Display if a file upload fails in the Citizen app 

http://help.lucity.com/webhelp/v170/install/29056.htm
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o List of document types that are allowed to be uploaded by citizens 

o Maximum size for uploaded document in mb (Citizen) 

o Path where uploaded documents are stored (Citizen) 

3) Locate and edit a Citizen Request Form and use the File Upload tool (see "Form Editor Toolbar" on page 172) to add the File Upload button. 
 

CUSTOMIZING THE LUCITY CITIZEN PORTAL PAGE 

This page explains some advanced steps to customizing the look of the Citizen Portal page. 

How To Customize the Citizen Portal Page 

1) Create your own master file using Notepad or another text-editing program.  You'll use this file to customize the fonts and colors of the 
citizen app.   

o Start with one of the examples provided by Lucity.  We've created examples for both the Master File (StateOfNE.master) and CS File 
(StateOfNE.master.cs).   
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using System; 

 

public partial class MasterPage : System.Web.UI.MasterPage 

{ 

} 

 

<%@ Master Language="C#" AutoEventWireup="true" CodeFile="StateOfNE.master.cs" Inherits="MasterPage" %> 

 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

 

<html xmlns="http://www.w3.org/1999/xhtml"> 

<head runat="server"> 

    <title>State of Nebraska</title> 

 <meta http-equiv="X-UA-Compatible" content="IE=EmulateIE7" /> 

    <link href="..\StyleSheet.css" rel="stylesheet" type="text/css" /> 

    <asp:ContentPlaceHolder ID="HeadContentPlaceHolder" runat="server" /> 

</head> 

<body bgcolor="#3BBDC2" text="#0B251F"> 

    <form id="form1" runat="server"> 

    <div> 

        <asp:ContentPlaceHolder id="phContent" runat="server" > 
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        </asp:ContentPlaceHolder> 

    </div> 

    </form> 

</body> 

</html> 

o Please note that the reference to the stylesheet.css file in the master file is necessary for the Citizen Portal code to function.  You can 
copy the stylesheet distributed with our application or create your own (such as StateOfNE.css).  Then, reference the customized 
stylesheet in the master file and place it in the root folder: 

<link href="..\StateOfNE.css" rel="stylesheet" type="text/css" /> 

o The cascading style sheet gives an agency much more control over the appearance of the web page.  One property in particular that you 
may wish to manipulate is "ProcessInputLabel".  This is the class that controls the appearance of the labels on most of the controls. 

1) Update the appsettings.config file to use the master file: 

<appSettings> 

  <add key="MasterPage" value="SampleMasters/StateofNE.master"/> 

</appSettings> 
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Sample Master File   

<%@ Master Language="C#" AutoEventWireup="true" CodeFile="StateOfNE.master.cs" Inherits="MasterPage" %> 

 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

 

<html xmlns="http://www.w3.org/1999/xhtml"> 

<head runat="server"> 

    <title>State of Nebraska</title> 

 <meta http-equiv="X-UA-Compatible" content="IE=EmulateIE7" /> 

    <link href="..\StyleSheet.css" rel="stylesheet" type="text/css" /> 

    <asp:ContentPlaceHolder ID="HeadContentPlaceHolder" runat="server" /> 

</head> 

<body bgcolor="#3BBDC2" text="#0B251F"> 

    <form id="form1" runat="server"> 

    <div> 

        <asp:ContentPlaceHolder id="phContent" runat="server" > 

        </asp:ContentPlaceHolder> 

    </div> 

    </form> 

</body> 
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</html> 

Sample CS File 

using System; 

 

public partial class MasterPage : System.Web.UI.MasterPage 

{ 

} 

 
 

CUSTOMIZING THE CITIZEN THANK YOU PAGE 

After a user submits a Request through Citizen Portal, a screen appears to thank the customer and provide a summary of the submission.  This 
screen also includes a Send Email button that, when clicked, sends the summary to the user via email.  The feature can even send the email 
summary to multiple addresses. 

The captions for the Send Email button and the Additional Emails section can be customized through Lucity Web > Admin Portal > Settings > 
System Settings > Citizen section. 
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CUSTOMIZING THE CITIZEN REQUEST EMAIL 

Citizen Portal automatically sends a preformatted email to users to thank them for their Request.  The message summarizes the content of the 
request, thanks the customer for their submission, and provides a link that allows the customer to view the current status of the request.   

Lucity provides the file (citizenmail.html) that serves as the template for this message.  It can be customized if desired.   

The default citizenmail.html file renders as: 
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How To Alter the citizenmail.html 

1) To alter this HTML file, type the following four phrases, exactly as they appear below. (The locations of these phrases are identified in red in 
the image below.) 

%CitizenRequestEmailHeader% 

%number% 

%properties% 

%CitizenRequestEmailFooter% 

2) Place these four phrases in any order, at any location in the HTML file.  The Lucity code will then substitute those phrases as it generates 
the email with the following data: 

o For the %CitizenRequestEmailHeader%, it uses the data from the System Settings> Email 
(http://help.lucity.com/webhelp/v170/admin/index.htm#26025.htm) tab (the first line of the email body sent to citizens). 

o For the %number%, it uses the automatically generated Lucity Request number. 

o For the %properties%, it supplies the fields included on the Request Submittal Form.  These fields are customized when creating the 
Form. 

http://help.lucity.com/webhelp/v170/admin/index.htm#26025.htm
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o For the %CitizenRequestEmailFooter%, it uses the data from the System Settings> Email 
(http://help.lucity.com/webhelp/v170/admin/index.htm#26025.htm) tab (the last line of the email body sent to citizens). 

 

Note:  Lucity also sends a text version of the email that is not as customizable.  The only way that it can be customized is to remove the 
link to 'view the status of your request.'  This is controlled by an option in the Lucity Web > Settings > System Settings > Citizen: Citizen 
Email - Include link to request lookup option. 

 
 

http://help.lucity.com/webhelp/v170/admin/index.htm#26025.htm
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DOS ATTACKS 

Question:  Do you have any techniques for stopping denial-of-service (DOS) attacks from the Internet? 

Answer:  A DOS attack occurs when someone attempts to crash a web site by bombarding it with multiple requests.  Lucity has implemented 
one technique for stopping DOS attacks in the Citizen Portal application.   
 
By default, if the Citizen application receives more than 1000 requests within 10 minutes from a single IP address, it will stop accepting requests 
from that IP address for the duration of the 10 minutes.  The maximum number of requests and the time period values can be configured by an 
administrator.  The default values are hard-coded in the program; they are not found in the appsettings file.  However, adding entries in 
appsettings.config file can override the defaults. 

 You can change the denial-of-service configuration by entering the following code strings in the appsettings.config file: 

<add key="DOSREQUESTS" value="1000" /> (The value represents the number of hits allowed to occur within the period before blocking the 
IP address.) 

<add key="DOSPERIOD" value="10" /> (This value represents the number of minutes in a single period.) 

 1000 attempts within 10 minutes is the default setting.  Lucity tracks the time of the first attempt from each IP address; if more than 1000 
requests occur within the next 10 minutes, the system blocks requests from that IP address for the remainder of the 10 minute period. 

Note:  This technique only works for short periods and only against a single IP address.  It is intened to protect against localized DOS 
attacks.  Mitigation of large-scale, distributed denial of service attacks (DDOS) should be handled by routers and networks.  
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